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Server Operation/Configuration

You are reading DX8100 Series hybrid video recorder (HVR) version 2.0 documentation. The information in this manual describes how to configure 
and use the DX8100 system in your security application.

For a brief description of the DX8100 server and client applications, refer to Welcome to the DX8100 Series HVR.

Welcome to the DX8100 Series HVR
The DX8100 Series HVR features IP camera recording, external JBOD (just a bunch of disks) storage, remote client connectivity to as many as 
200 HVR/DVR servers, dual monitor display, multimode recording for up to 16 ATM/POS devices or single mode recording for up to 4 ATM/POS 
devices, system health status and configuration, multi-event recording, continuous motion detection, alarm, and scheduled recording. The 
DX8100 is a high-performance, computer-based, easy-to-operate HVR and client application system. Models range from an 8-channel, single 
250 GB hard disk drive (HDD) unit to a 32-channel unit with up to 6 TB of internal storage. An external JBOD unit adds as much as 6 TB, 
increasing DX8100 storage capacity up to 12 TB.

DX8100 software runs on two platforms:

• The DX8100 HVR server software runs on the DX8100 Series HVR.

• The DX8100 Client Application software runs on a personal computer and allows you to log on and operate the DX8100 HVR server system 
from your local computer. 

Fully implemented networking capabilities allow remote administration, playback, and export using the accompanying client application. Live 
viewing is supported on a variety of client platforms, including Internet browsers and pocket PC-compatible hand-held devices. Versatile 
high-speed search operations include time and date, event list, thumbnail, and intelligent pixel searching. Extensive scheduling features allow 
customizing of weekday, weekend, and special event recording.

The DX8100 provides a graphical user interface (GUI), allowing you quick and efficient access to all setup and operations functions. Scheduled or 
manual backup can be performed using a number of optical, external, and mapped network drive options.

An online Help system allows you quick access to information about how to configure and operate the DX8100 server and DX8100 client 
application. 

The DX8100 also supports the following computer-based applications:

• DX8100 Client Emergency Agent

• DX8100 Viewer on page 13

• DX8100 Mobile Client on page 13

• DX8100 Web Client on page 14

DX8100 CLIENT EMERGENCY AGENT
The DX8100 Client Emergency Agent works with networked DX8000 Series HVRs to alert users when one or more particular channels detect a 
motion and/or alarm event. The Emergency Agent runs on a networked client computer. 

DX8100 VIEWER
The DX8100 Viewer is capable of playing back a variety of video, still image, and audio media formats. It is designed to recognize and verify the 
digital watermark that is embedded in DX8000 Series HVR native video. Watermarking is used to authenticate the originality of a video file and 
to alert users of possible image tampering. The viewer application runs automatically each time a CD or DVD created by the DX8100’s export 
feature is inserted into a Windows®-based computer. The software can also be installed on a computer and opened independently when 
necessary.

DX8100 MOBILE CLIENT
The DX8100 Mobile Client allows you to view live video remotely from multiple cameras and sites. Networking capabilities include local 
connection using wire-bound or wireless local area network (LAN) technologies or remote connection using the Internet. The DX8100 Mobile 
Client software runs on a standard pocket PC-based personal digital assistant (PDA), and it can display a single channel of real-time video from 
any camera attached to any DX8100 HVR on the network. Features include hierarchical organization of multiple sites, built-in security through 
password protection, and an adjustable viewing area, including full-screen view.
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DX8100 WEB CLIENT
The DX8100 Web Client allows you to view live video and operate pan, tilt, and zoom (PTZ) features of cameras attached to DX8100 HVRs. Using 
a standard Web browser, you can remotely monitor up to 16 cameras from up to five DX8100 HVR servers simultaneously. Each DX8100 HVR can 
support up to 100 Web clients either internally within an organization or externally through the Internet.

DX8100 FEATURES
The DX8100 version 2.0 release includes new features: IP camera recording, external JBOD, and remote client connection to as many as 200 
DX8100 servers. Refer to the following list for additional features.

*Pre-alarm time estimate is based on 16-channel recording at a resolution of 320 x 240 (CIF) and a frame rate of 5 ips.

• Up to 480/400 images per second (ips) Recording Rate at CIF • Local and remote administration, live, search, and playback 
viewing

• Dynamically adjustable frame rate and image quality for motion, 
alarm, and pre-alarm recording

• Scheduled backup 

• Pre- and post- alarm recording up to 60 seconds (up to 15 minutes 
with optional 512 mb ram upgrade)*

• Export and import system configurations 

• 2 Standard audio channels with live audio over the network • Multilevel password and user configuration

• 8/16/24/32 alarm inputs and 8/16/24 relay outputs • Automatic image watermarking

• User-definable PTZ presets, patterns, and preset tours • Multilingual support (English, French, German, Italian, Polish, 
Portuguese, Russian, and Spanish)

• Online help • Standard DVD-R burner writes to CD-R and DVD-R media 

• Thumbnail, pixel (smart search), ATM/POS search modes • External storage RAID 5 option 

• Instant playback • NTP time server compatible 

• Network up to five DX8100/DX8000s server • Optional KBD300A keyboard support for camera selection and 
PTZ control 

• 5 Simultaneous connections per server

• Unlimited licenses for remote computer, Web, and handheld client
14 C2630M-C (7/09)



Getting Started with DX8100 HVR Software
This section provides information to help you get started using the DX8100 HVR server software. You must install your DX8100 Series HVR before 
using this guide. In order for your system to operate properly, you must also perform the following tasks:

• Read the Important Security Information for System Administrators manual and configure the DX8100 to ensure maximum DX8100 server 
operation security. 

• Change the default language (if other than English). For more information, refer to Selecting the Language on page 224.

• Set the system clock. For more information, refer to Setting the System Time on page 224.

• Identify network parameters. For more information, refer to Setting Up Network Properties on page 168.

• Add a printer (if you want to print still video images). For more information, refer to Printing Images on page 68.

If the above steps have not been completed, refer to the installation manual supplied with the unit for instructions on installing and configuring 
your DX8100. 

NOTE: System administrators are recommended to read the Important Security Information for System Administrators manual and configure the 
DX8100 to ensure maximum DX8100 server operation security.

This section includes the following topics:

• Upgrade Policy

• Starting and Shutting Down the DX8100 on page 16 

UPGRADE POLICY
Pelco’s representations regarding product features and performance are limited to those made in the specification sheet and installation/
operation manual at the time the product was manufactured. Pelco does not represent or warrant that any upgrades to product hardware or 
software will be made available in the future. When possible, Pelco will offer product upgrades to purchasers of its products. 

The upgrade policy is described in the following sections:

• Software Upgrades

• Hardware Upgrades

SOFTWARE UPGRADES
1. All upgrades for Pelco software shall be free to the customer for the duration of the warranty period. This offer does not apply to software 

that may be installed in a Pelco product that is licensed from another supplier. All other software, such as operating systems, drivers for 
accessory devices, and so forth, shall be governed by the software manufacturer’s upgrade policy, even when said upgrades are necessary 
to implement an upgraded version of Pelco software.

2. Whenever possible, software upgrades with detailed instructions shall be provided to the customer through Web site download. Pelco will 
not be responsible for loss of data, losses due to down time, or damage to product as a result of a customer attempting to perform an 
upgrade.

3. Hard copies on appropriate medium (CD/DVD, ZIP, or floppy disk) shall be sent to the customer at no charge upon request.

4. It shall be the customer’s responsibility to procure necessary hardware to perform upgrades if required (necessary drives, such as CD-R, 
DVD-R, or ZIP).

5. Pelco cannot guarantee that all future software versions will be backward compatible with earlier hardware platforms.
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HARDWARE UPGRADES
Pelco provides hardware options for upgrading the DX8100 memory, channel input, analog video output, audio input capacity, and hard disk 
storage. For information about DX8100 upgrade options, refer to the DX8100 product specification sheet. Hard disk upgrades are available as 
follows:

1. Additional hard drive space cannot be installed in some models. To determine if your model can be upgraded, refer to the DX8100 
Installation manual or contact Pelco’s technical support.

2. Hard disk upgrades are available through Pelco at established prices and are subject to the usual 24-hour turnaround for service.

When a larger hard drive is being substituted for a smaller one, the smaller drive will be returned to the customer along with the upgraded unit.

While Pelco will perform all upgrades with the utmost consideration and care, Pelco cannot guarantee that any of the data and/or video stored 
on the existing hard drives will not be lost or damaged. Pelco is not responsible for damage or loss of data.

STARTING AND SHUTTING DOWN THE DX8100
This section describes how to start and shut down the DX8100 and includes the following topics:

• Starting the DX8100

• Shutting Down the DX8100

For information about logging in to the DX8100, refer to Logging In to the DX8100 Application on page 18.

STARTING THE DX8100
To start the DX8100: 

1. Once the system is installed, open the front panel of the HVR and press the power switch.

Figure 1. Front Panel and Power Switch

2. Wait while the unit starts (this may take several minutes). 

SHUTTING DOWN THE DX8100
You must have Power User or Administrator access to shut down. For information about users’ security levels, refer to Definition of User Access 
Levels on page 210.

To shut down:

1. From the DX8100 menu bar, choose File > Exit. The Shut Down dialog box opens.

2. Select Shut down.

3. Click OK.

POWER HDD

USB

�
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DX8100 DOCUMENTATION
You can print selected technical documentation free, directly from the Internet. 

To access technical documentation:

1. Go to www.pelco.com/products/. The Pelco Products Web page is displayed.

2. Scroll to the Control Site Equipment section and click Video Recorders. The HVR Web page is displayed.

3. Scroll to the DX8100 and locate the specific document you want to view or print. You will need Adobe® Acrobat Reader® to open, search, 
and/or print the document. (Go to www.adobe.com to download a free copy of Acrobat Reader.)
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Logging In to the DX8100 Application
To access the features of the DX8100 Series HVR, you must log in with a valid user name and password. The DX8100 comes equipped with a 
built-in user account named “Guest.” Each time the unit is turned on, the Guest account is automatically activated. In addition to the Guest 
account, there are four other user access levels, or groups, that can be configured on the DX8100. The Guest user is granted only limited access 
to the system. The other four access levels range from the Administrator group, with the most rights and privileges, to the Restricted group, with 
the least rights and privileges. 

To operate and configure all but the most basic features of the DX8100, you must be assigned a user account other than Guest. If you have not 
been assigned a user account, contact your system administrator before proceeding.

For information about the rights and permissions of the user groups, refer to Definition of User Access Levels on page 210. 

NOTE: The Guest user account does not have access to the setup features of the DX8100. Only users with Administrator and Power User 
accounts are allowed access to setup functions.

This section includes the following topics:

• Local DX8100 Login

• Remote DX8100 Login on page 19

LOCAL DX8100 LOGIN
If you are logging into the DX8100 for the first time, refer to the first-time login instructions in the DX8100 Installation manual. 

This section includes the following topics:

• Logging in to a Local DX8100 

• Logging Out of the Local DX8100 

• Exiting to the Windows Operating System

LOGGING IN TO A LOCAL DX8100
You must have a valid user name and password to log in to the DX8100. The user name and password are case sensitive.

To log in with a user name other than Guest: 

1. From the DX8100 main menu, go to File > User Log-in. The User Log-in dialog box opens.

2. Enter a valid user name in the User Name field and a valid password in the Password field.

3. Click OK.

LOGGING OUT OF THE LOCAL DX8100
Logging out of the local or a remote HVR does not disconnect you from that system. Logging out will return you to the Guest account. 
To disconnect from a remote server, refer to Disconnecting from a Remote Site on page 19.

To log the current user out of the system and return to the Guest account: 
• Click File > User Log-out.

You can also log out of a local or remote HVR by right-clicking its site name from the Site Tree and then selecting User Log-Out from the 
shortcut menu.
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EXITING TO THE WINDOWS OPERATING SYSTEM
You must have DX8100 Administrator user access and a Windows password to exit to the Windows operating system. Refer to Definition of User 
Access Levels on page 210 for information about users’ security levels. For information about the Windows default password, refer to the 
Important Security Information for System Administrators guide.

To exit the DX8100 application and log into the Windows operating system:

1. From the DX8100 menu bar, choose File > Exit. The Shut down dialog box opens.

2. Click Exit to Windows. 

3. Click OK.

The Log On to Windows dialog box opens.

4. Enter the Windows password and then click OK. The system logs you into the Windows operating system.

REMOTE DX8100 LOGIN
You can view live and playback video from up to five DX8100 Series HVRs simultaneously. To access the features of a remote DX8100, a link must 
be established between the local and remote HVRs. Refer to Adding a Remote Site on page 214 for instructions on establishing a network 
connection with a remote HVR. After establishing an active connection, refer to Logging in to a Remote Site on page 19 for instructions.

This section includes the following topics:

• Connecting to a Remote Site 

• Disconnecting from a Remote Site 

• Logging in to a Remote Site 

• Logging Out of a Remote Site 

CONNECTING TO A REMOTE SITE
To connect to an active DX8100 server on the network:

1. In the DX8100 main window, right-click the remote site name from the Site Tree. The shortcut menu is displayed.

2. Select Connect from the shortcut menu.

DISCONNECTING FROM A REMOTE SITE
To terminate a connection with a remote DX8100 server: 

1. In the DX8100 main window, right-click the remote site name from the Site Tree. The shortcut menu is displayed.

2. Select Disconnect from the shortcut menu.

LOGGING IN TO A REMOTE SITE
After a connection to a remote site has been established, log in with a valid user name and password for that site. 

To log in to a remote site:

1. In the DX8100 main window, select a remote DX8100 Series HVR site from the Site Tree.

2. From the DX8100 menu bar, choose File > User Log-in.

You can also log in to a remote site by right-clicking its site name and then selecting User Log-In from the shortcut menu.

3. Enter a user name and password for the remote site.
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LOGGING OUT OF A REMOTE SITE
Logging out of the local or a remote HVR does not disconnect you from that system. Logging out will return you to the Guest account. 
To disconnect from a remote server, refer to Disconnecting from a Remote Site on page 19. You can only log out of one server at a time. If you are 
logged into multiple servers, you must log out of each server individually. You can also log out of a local or remote HVR by right-clicking its site 
name in the Site Tree, and then selecting User Log-out from the shortcut menu.

To log out of a local or remote HVR site: 

• From the DX8100 menu bar, choose File > User Log-out.

Working with an External JBOD Device

For information about configuring and connecting an external JBOD device to the DX8100, refer to the DX8100 Installation manual. 

VERIFYING AVAILABLE JBOD DRIVES

1. Click the Search button . The HVR switches to the Search mode. 

2. Click the Export Button . The Export Video dialog box opens (refer to Figure 2). 

3. Verify that the JBOD drive is displayed in the Device list.

Figure 2. Export Video Dialog Box

WARNING: The DX8100 includes the external JBOD drives as part of the Pelco database (PDB). If you manually back up video data to the 
JBOD device, the backed up data will be overwritten.
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Working with Dual Monitors
DX8100 version 1.2 and later units include a standard dual display card that provides additional viewing of up to 72 video channels 
simultaneously.

• VGA output: This feature allows you to display video from selected cameras on the extended monitor, while at the same time displaying 
video from selected cameras on the primary monitor. The primary monitor remains available for other tasks, such as viewing and controlling 
PTZ cameras and monitoring video from cameras displayed on the extended monitor. Up to 36 cameras can be displayed on each monitor. 
Video from any connected server can be displayed on the monitors.

• Composite output: The dual display card provides a composite video BNC output that allows video to be displayed on a composite 
monitor. The monitor can be located up to 1,500 feet (457 meters) away from the server.

NOTE: If you upgraded your DX8100 from version 1.1 to 1.2, the dual display feature is supported; the dual display card is supported for DX8100 
version 1.2 and later. 

INSTALLING THE DUAL DISPLAY CARD
1. Install the dual display card. For information about installing the card, refer to the DX8100 dual display card Installation manual.

2. Once the display card is installed, refer to Configuring the Dual Display Card. 

CONFIGURING THE DUAL DISPLAY CARD
To configure the DX8100 to display video on the extended monitor:

NOTE: After you enable the extended monitor for use with the dual display card, you must restart the DX8100 to enable the overlay feature on 
both monitors. 

1. From the DX8100 menu bar, choose File > Exit. The “Shut down” dialog box opens.

2. Click “Exit to Windows.” 

3. Click OK.

The “Log On to Windows” dialog box opens.

4. Enter the Windows password and then click OK. The system logs you into the operating system.

5. Go to Start > Settings > Control Panel, and then double-click the Display icon. The Display Properties dialog box opens.

6. Click the Settings tab. 

7. To enable the extended monitor, do the following:

a. On the Settings tab, click the monitor icon that represents the extended monitor you want to use in addition to your primary monitor. 

b. Click “Extend my Windows desktop onto this monitor.” 

c. In the “Color quality” area, select Highest (32 bit). 

NOTE: If the color mode is set to Medium (16 bit), video will not be displayed on the extended monitor.

d. In the Screen resolution area, set the resolution to match the resolution set for the primary monitor.

e. By default, the extended monitor’s icon is located to the right of the primary monitor’s icon. Do nothing to accept the default location 
or left-click and drag the icon to the desired location. 

8. Click OK.

9. Restart the DX8100. The Pelco slash screen is displayed on the extended monitor.

For information about mapping channels, refer to Mapping Channels on the Extended Monitor on page 34.
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Understanding the DX8100 Application Window
This section describes the DX8100 application window and its operation. The application window is the central control center where you can 
access to the DX8100 features and functions.

• View both live and recorded video

• Exit to the Windows environment

• Access DX8100 setup features

• Control camera PTZ functions

• Select cameras for viewing and recording

• Specify playback date and time

• Access playback controls

This section includes the following topics:

• Description of the DX8100 Main Window

• Switching Between Standard and Extended Panel Views on page 30

• Working with the Site tree on page 37

DESCRIPTION OF THE DX8100 MAIN WINDOW
The application window is displayed after the DX8100 starts. The main window provides access to both live and recorded video. The DX8100 
displays an hour glass when a task requires a longer time to complete.

This section describes the DX8100 main window and includes the following topics:

• DX8100 Menu Bar on page 25 

• DX8100 Toolbar on page 28

• Displaying the DX8100 Window from a Page on page 29

• Description of Operating Modes on page 29 

• Switching Between Standard and Extended Panel Views on page 30
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Figure 3 shows the parts of the DX8100 main window.

Figure 3. DX8100 HVR Main Window
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Table A describes the parts of the DX8100 application window. 

Table A.  Parts of the DX8100 Application Window

Item Part Description

Title Bar Displays the DX8100 application title.

Menu Bar Provides access to drop-down menus.

Toolbar Provides access to display, setup, export, and search tools.

Site Tree Displays top-down, hierarchical management of DX8100 resources, such as servers, cameras, alarms, and relays.

View Panels Display live and playback video from attached cameras. A view panel consists of view panes.

• View pane: A view pane is a division of a view panel. Each view pane contains only a single camera channel. 
Up to 36 view panes can fit in a single view panel.

• View panel: A view panel is made up of the entire DX8100 viewing area. View panels are divided into 
multiple panes. A panel can display from one to 36 individual cameras.

For additional information about view panels and panes, refer to Switching Between Standard and Extended 
Panel Views on page 30.

PTZ Control Panel Allows users with access rights to operate camera lens control features and to program PTZ presets, patterns, 
auxiliary outputs, and tours. This panel is hidden in the extended view mode. In this case, select the standard 
view mode to display the PTZ control panel. For information about how to select view modes, refer to Switching 
Between Standard and Extended Panel Views on page 30.

Index View Panel Allows users with access rights to search motion and alarm events within a 24-hour period specified in the 
playback timeline. By default, this panel is not displayed.

Playback Timeline Displays a 24-hour timeline marked with color-coded video events. Allows users with Standard User access rights 
to select a date and time for playback. This panel is hidden in the extended view mode. In this case, select the 
standard view mode to display the playback timeline. For information about how to select view modes, refer to 
Switching Between Standard and Extended Panel Views on page 30.

Playback Control 
Panel 

Provides buttons for users with access rights to control video playback. Includes forward and reverse playback 
and still image. It also provides controls for playback speed and volume. This panel is hidden in the extended 
view mode. In this case, select the standard view mode to display the playback timeline control panel. For 
information about how to select view modes, refer to Switching Between Standard and Extended Panel Views 
on page 30.

PTZ OSD Menu or 
Digital Zoom 
Control 

This control provides two functions depending on whether the DX8100 is operating in Live view or playback 
mode:

• Live view mode: Provides whether the DX8100 is operating in Live view or playback mode: users with 
access rights to operate PTZ OSD features. For information about using the PTZ OSD menu controls, refer to 
Using the PTZ OSD Menu Control on page 58.This panel is hidden in the extended view mode. In this case, 
select the standard view mode to display the playback zoom control. For information about how to select view 
modes, refer to Switching Between Standard and Extended Panel Views on page 30.

• Playback mode: Provides users with access rights to operate digital zoom features. This panel is hidden in 
the extended view mode. In this case, select the standard view mode to display the playback zoom control. For 
information about how to select view modes, refer to Switching Between Standard and Extended Panel 
Views on page 30.

Status Bar Displays the current date and time, recorder processing status, disk status indicator, user name (of the current 
logged in user), and total amount of recorded video. 

NOTE: As the storage array of the DX8100 fills beyond its capacity, video is deleted in a first-in, first-out (FIFO) 
fashion. The disk status indicator on the status bar shows the amount of disk space used by recorded video. The 
red indicator marks the current recording position of the disk array, blue indicators mark parts of the array that are 
storing previously recorded video, and clear indicates that no video has been recorded in that area of the array.
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DX8100 MENU BAR
This section describes the DX8100 menu bar commands and includes the following topics:

• File Menu on page 25

• Edit Menu on page 25

• View Menu on page 26

• Export Menu on page 27 

• Favorite Menu on page 27

• Help Menu on page 28

File Menu
Table B describes the DX8100 File menu commands.

Edit Menu
Table C describes the DX8100 Edit menu commands.

Table B.  File Menu Commands

Command Description

User Log-in Opens the User Log-In dialog box for entering the user name and password to log in to the DX8100.

User Log-out Immediately logs the current user out of the DX8100. The system returns to the default mode.

Software Upgrade Opens the Select Upgrade Package dialog box for selecting the source from which to access files to upgrade 
the DX8100 software. This command is available only when you log in to the DX81000 as Administrator. 

Password Recovery Opens the Password Recovery dialog box for entering the password provided by Pelco Product Support. For 
more information, refer to Recovering a Password on page 252. For information about recovering a 
password, contact Pelco Product Support include contact information or a link to the contact information 
elsewhere in the document.

Unplug/Eject Hardware Opens the Unplug or Eject Hardware dialog box for a specific device.

Multiple Configuration Upload Opens the Multi-configuration Upload dialog, displaying a list of DX8100 sites and groups. Use this dialog 
box to select specific DX8100 sites, to configure the file to upload to those sites, and to initiate the upload 
process.

Exit Opens the Shut down dialog box for selecting one of the following actions (requires a specific level of user 
permission):

• Shut down: Shuts down the DX8100 machine. You must have Power User or Administrator access to 
shut down the DX8100 machine. For more information, refer to Shutting Down the DX8100 on page 16.

• Restart: Restarts the DX8100 application. You must have Administrator or Power user access to restart 
the DX8100 application. For more information, refer to User Setup on page 208.

• Exit to Windows mode: You must have Administrator user access to exit the DX8100 application to the 
Windows operating system. For more information, refer to Exiting to the Windows Operating System on 
page 19.

Table C.  Edit Menu Commands

Command Description

Export Setup Opens the DX8100 Setup File Export dialog box for exporting the DX8100 system configuration settings to a specific 
file name and location. The Export feature also allows you to export the DX8100 settings to a specified location for 
later retrieval. For more information, refer to Using the Edit Menu to Perform an Export on page 220. 

Import Setup Opens the DX8100 Setup File Import dialog box for importing a DX8100 system configuration file. For more information, 
refer to Using the Edit Menu to Perform an Export on page 220.
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View Menu
Table D describes the DX8100 View menu commands.

Table D.  View Menu Commands (1 of 2)

Command Description

OSD Opens a submenu with the following choices:

• Site name: A global setting that, when selected, displays a site’s name in the respective view pane.

• Camera name: A global setting that, when selected, displays a camera’s name in the respective view pane.

• Video recording: A global setting that, when selected, displays an icon in the upper right corner of the pane, and 
enables video recording for the cameras assigned to a view pane. 

• Audio recording: A global setting that, when selected, enables audio recording for the cameras assigned to a 
view pane. The DX8100 compresses audio data to save space. In this case, recorded audio may not be of the 
same quality as live audio. 

• PTZ: A global setting that, when selected, displays PTZ (if active) for the cameras assigned to a view pane.

• Instant recording: A global setting that, when selected, displays the instant recording icon for the cameras 
assigned to a view pane.

• POS: A global setting that, when selected, displays POS (if active) for the cameras assigned to a view pane.

• Select all: Selects all of the OSD options.

• Background color: Opens a submenu with the following choices:

– Set color: Opens the Colors palette for selecting or creating a background color.
– Disable background: Disables a background color from being shown.

Log Opens a submenu with the following choices: 

• System On/Off

• System failure

• Export

• Backup

• Network connection 

• Login ID list with time

• Video loss

Resolution Opens a submenu with the following choices:

• 1024 x 768

• 1280 x 1024

Cycle Views Setup Opens a submenu with the following choices:

• Dwell time change: Opens a submenu with the following choices for assigning permission to a user group, 
allowing the selected user group to change the dwell time:

– Restricted User Group
– Standard User Group
– Power User Group

• Dwell time: Opens a submenu of dwell times with the following choices:

– 2 Sec.
– 5 Sec.
– 10 Sec.
– 30 Sec.
– 60 Sec.

Extended View Enlarges the video image displayed in the view pane.

Index View Opens the Event Index pane.
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Export Menu
Table E describes the DX8100 Export menu commands.

Favorite Menu
Table F describes the DX8100 Menu commands.

System Health View Opens a submenu with the following choices:

• Status View

• Log View

Display Deinterlaced 
Image

Selects the deinterlace mode for enhancing the display of video images. 

Table E.  Export Menu Commands

Command Description

Interrupt Export Immediately concludes an export process. If the Interrupt Export command is executed before the scheduled 
backup time, the system will save the backed up data until the time the Interrupt Export command is executed. 

Cancel Export Immediately cancels the export process and no backed data is retained.

Table F.  Favorite Menu Commands

Command Description

Add to Favorites Opens the Add to Favorites dialog box, where you can create and store a favorite to a specified folder.

Organize Favorites Opens the Organize Favorites dialog box, where you can do the following:

• Create a new folder.

• Rename the folders.

• Move favorites to a specific folder.

• Delete a favorite or favorite folder.

Table D.  View Menu Commands (2 of 2)

Command Description
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Help Menu
Table G describes the DX8100 Help menu commands.

DX8100 TOOLBAR
This section describes the DX8100 toolbar. Table H describes the DX8100 toolbar buttons.

Table G.  DX8100 Help Menu Commands

Command Description

DX8100 Help Opens the DX8100 Help system.

About Provides model and version information for the DX8100 application.

Table H.  DX8100 Toolbar Buttons (1 of 2)

Button Name Description

Live Enters the display mode and opens the DX8100 main window, where live and playback video is 
displayed:

• Live mode: Allows all users to view live video.

• Playback mode: Allows users with playback access rights (Standard User by default) and higher 
to play back recorded video.

Search Enters the search mode and opens the Search window, providing access to search features. Users with 
Standard User access and higher are allowed to search video data using specific criteria.

Setup Enters the setup mode and opens the Setup dialog box to the Camera page (default view), and allows 
access to the other pages. Users with Power User access and higher are allowed to set up the features 
and options for the HVR.

Export Enters the export mode, where you configure the export options and parameters.

Print Enters the print mode, where you print the selected video image.

Single Division Displays one camera.

4 Division Displays four cameras simultaneously (quad display).

9 Division Displays nine cameras simultaneously.

16 Division Displays 16 cameras simultaneously.

25 Division Displays 25 images. Each HVR accommodates up to 32 cameras. You can display images from the local 
and remote DX8100 HVRs. Use the expansion unit to increase DX8108 from 8 to 24 camera inputs or 
the DX8116 from 16 to 32 camera inputs. 

36 Division Displays 36 images. Each HVR accommodates up to 32 cameras. You can display images from the local 
and remote DX8100 HVRs.

6, 10, 13 Division Displays images as follows: 

• 6 Division (1+5): One larger and five smaller images

• 10 Division (2+8): Two larger and eight smaller images

• 13 Division (1+12): One larger and 12 smaller images
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DISPLAYING THE DX8100 WINDOW FROM A PAGE
To display the DX8100 main window from a Setup dialog page:

• On the DX8100 toolbar, click the Live button .

DESCRIPTION OF OPERATING MODES
The DX8100 Series HVR has four primary operating modes: Live, Playback, Search, and Setup. Each operating mode is accessed by clicking its 
corresponding button on the toolbar. 

Table I describes the DX8100 operating modes.
 

DISPLAYING VIDEO IN FULL SCREEN VIEW
The DX8100 allows full screen viewing of video data in the live, playback, and index search mode, providing more screen area to display video. 

Displaying Live Video in Full Screen View
To display live video in full window view:

1. Select the live video mode. For information about working in the playback mode, refer to Working in Live View Mode on page 42.

2. Select a window division.

3. On the DX8100 toolbar, click the Full Screen button . Live video is displayed in full screen view.

To display the DX8100 main window from the full screen view:

• Right click in the DX8100 window.

Cycle Views Turns window cycling on and off. Automatically cycles through each view panel ensuring all cameras 
get displayed. Group permission to change the dwell time is assigned by the Administrator to the 
following groups: Restricted User Group, Standard User Group, and Power User Group. For information 
about cycle views setup, refer to Automatically Cycling Through View Panels on page 33.

Full Screen Selects a full screen view. The application window is expanded to occupy the entire monitor screen. 
Click the right mouse button to exit full-screen view. The full screen view is not available in the 
Thumbnail, POS, and Pixel search mode.

External Monitor Opens the external monitor drop-down menu. For more information, refer to External Monitor Setup on 
page 228.

Table I.  Operating Modes

Icon Mode Description

Live Enters the display mode and opens the DX8100 main window, where live and playback video is displayed:

• Live mode: Allows all users to view live video.

• Playback mode: Allows users with playback access rights to play back recorded video.

Search Enters the search mode and opens the Search window, providing access to search features. Allows users with playback 
access rights to search video data using specific criteria.

Setup Enters the setup mode and opens the Setup dialog box to the Camera setup page (default view), and allows access to the 
other setup pages. Users with Power User access and higher are allowed to set up the features and options for the HVR.

Table H.  DX8100 Toolbar Buttons (2 of 2)

Button Name Description
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Displaying Playback Video in Full Screen View
To display playback video in full screen view:

1. Select the playback mode. For information about working in the playback mode, refer to Working in Playback Mode on page 68.

2. Select a window division.

3. On the DX8100 toolbar, click the Full Screen button . Playback video is displayed in full screen view.

To display the DX8100 main window from the full screen view:

• Right click in the DX8100 window.

Displaying Index Search Video in Full Screen View
To display index search video in full screen view:

1. Select the index search mode. For information about working in the index search mode, refer to Working in Playback Mode on page 68.

2. Click the Reverse playback button  to begin viewing video.

3. On the DX8100 toolbar, click the Full Screen button . Index search video is displayed in full screen view.

To display the DX8100 main window from the full screen view:

• Right click in the DX8100 window.

SWITCHING BETWEEN STANDARD AND EXTENDED PANEL VIEWS
The DX8100 features a viewing area that can be expanded to fill a larger portion of the main window. Extended view expands the viewable panel 
containing camera panes but hides the timeline, PTZ, digital zoom, and playback controls. To use the timeline, PTZ, digital zoom, and playback 
controls, you must take the DX8100 out of extended view.

To switch back and forth between standard and extended view: 

• From the DX8100 menu bar, choose View > Extended View.

UNDERSTANDING VIEW PANES AND PANELS
This section describes the DX8100 viewing area. The viewing area is organized into panes and panels, much like a window contains panes. 
Video from each camera is displayed in its own viewing pane. 

This section includes the following topics:

• Working with View Panes and Panels 

• Configuring View Panels on page 31 

• Navigating View Panels on page 31 

WORKING WITH VIEW PANES AND PANELS
The DX8100 displays video from each camera in its own viewing pane. 

• View pane: A view pane is a division of a view panel. Each view pane contains only a single camera channel. Up to 36 view panes can fit 
in a single view panel.

• View panel: A view panel is made up of the entire DX8100 viewing area. View panels are divided into multiple panes. Each panel can 
display from one to 36 individual cameras.
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Figure 4 shows how the DX8100 viewing area is structured.

Figure 4. View Panes and Panel for 4-Division Display

Table J describes the view pane and panel as shown in Figure 4.

CONFIGURING VIEW PANELS
The DX8100 can display up to 36 cameras simultaneously in a single panel.

To select a view panel division:

1. On the DX8100 toolbar, click the Live button .

2. On the DX8100 toolbar, click a view panel division button. 

For information about the view division buttons, refer to DX8100 Toolbar on page 28.

NAVIGATING VIEW PANELS
This section describes how to move between the DX8100 view panes and panels. This section includes the following topics:

• Navigating Between View Panels on page 32 

• Expanding and Collapsing View Panes on page 33 

• Manually Cycling Through Hidden View Panels on page 33 

• Automatically Cycling Through View Panels on page 33

Table J.  View Panes Panel

Item Description

Shows a view pane for a four division display.

Shows the view panel, which contains view panes.

�

�
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Navigating Between View Panels
The DX8100 allows you to monitor up to 36 channels: each channel is assigned to one pane within the view panel. If the 36-division display 
format is selected, all 36 panes occupy one panel. However, for single, 4-division, 9-division, 16-division, and 25-division display formats, the 
DX8100 displays the panes in multiple panels. In this case, to view all of the panes, you must cycle through multiple panels to display hidden 
panels. 

• Channel: As pertains to video, one DX8100 camera port (input). The term channel is sometimes used interchangeably with camera.

• Camera: One external video device, such as a Spectra III™, that provides input video to the DX8100 HVR.

For example, if you select the single-division display format, one channel (video pane) fills the entire panel. 

• The pane and panel represent the same amount of viewing area. 

• In this case, there will be an additional 31 hidden panels (one pane equals one panel) through which to cycle. 

Similarly, if you select the 4-division display format:

• Four panes (one camera/channel per pane) are displayed in the panel.

• In this case, 7 hidden panels (four cameras/channels per panel, or 4 x 7 = 28 panels), remain to be displayed. 

Figure 5 shows how the DX8100 cycles through view panels, depending on the display format.

Figure 5. Example of Single, 4, 9, and 16 Division View Panels

Table K describes how the DX8100 view panes and panels are organized.

Table K.  How View Panels are Organized

Display Type Grouping Number of 
View Panes

Number of 
View Panels

Single 1/32 1 32

4 Division 1/8 4 8

9 Division 1/4 9 4

16 Division 1/2 16 2

25 Division 1/2 25 2

36 Division 1/1 36 1

6, 10, 13 Division:

• 1+5 Division

• 2+8 Division

• 1+12 Division

1/6

1/4

1/4

6

10

13

6

4

4

17 18 19 20
21 22 23 24
25 26 28
29

27
30 3231

1 2 3 4
5 6 7 8
9 10 12

13
11

14 1615
32

1

1
32    31    32

28    29    30

25    26    27

23    24     25

17    18     19

20    21     228      9     10

11    12    13

14    15    16

1      2      3

7      8      9

4      5      6

29 30

31 3225 26

27 2821 22

23 2417 18

19 20
13 14

15 16
9 10

11 12
5 6

7 8
1 2

3 4
1 - 4

5 - 8
9 - 12

13 - 16
17 - 20

21 - 24
26 - 28

29 - 32

1 - 9
8 - 16

17 - 25
25 - 32

1 - 16
17 - 32
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Pressing one of the view panel division buttons sets the number of visible channels displayed in the panel. Figure 6 shows the view panel 
identifier.

Figure 6. View Panel Identifier

Table L describes how the DX8100 view panes and panels shown in Figure 6 are organized. 

Expanding and Collapsing View Panes
To expand a view pane to fill the entire panel:

• Double-click a view pane.

The view fills the entire view panel. 

To collapse a view pane:

• Double-click the expanded view pane.

The view pane returns to its default size.

Manually Cycling Through Hidden View Panels
To manually cycle through hidden view panels:

• On the DX8100 toolbar, click one of the panel division buttons.

The view sequences through the view panels.

For example, when you repeatedly click a 4 Division display format button , the DX8100 cycles through each of the eight available view 
panels. 

Automatically Cycling Through View Panels
The DX8100 provides an automatic cycle feature that (when selected) automatically cycles through each view panel, ensuring all cameras get 
displayed. Group permission to change the dwell time is assigned by the Administrator to the following groups: Restricted User Group, Standard 
User Group, and Power User Group. 

This section describes how to configure the DX8100 to automatically cycle through camera views and includes the following sections:

• Starting an Automatic Cycle View Mode on page 34

• Stopping an Automatic Cycle View Sequence on page 34

• Selecting User Groups to Set the Cycle View Dwell Time on page 34

• Selecting the Cycle View Dwell Time on page 34

Table L.  View Panes and Panel

Item Description

Indicates the panel number being viewed.

Indicates the total number of panel pages available.

� �
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Starting an Automatic Cycle View Mode

To start the automatic cycle view mode:

• On the DX8100 toolbar, click the Cycle Views button . 

The Cycle Views icon turns blue, indicating that the DX8100 is in the automatic cycle view mode. The system will cycle through each panel, 
displaying each panel for the configured cycle view dwell time. 

Stopping an Automatic Cycle View Sequence

To stop the automatic cycle view mode:

• On the DX8100 toolbar, click the Cycle Views button . 

The DX8100 stops the automatic cycle view mode.

Selecting User Groups to Set the Cycle View Dwell Time

The DX8100 allows the Administrator to control which user group can change the cycle view dwell time. In this case, anyone that belongs to a 
selected user group can change the cycle view dwell time. 

To select a user group to have permission to change the cycle view dwell time:

1. On the DX8100 toolbar, click the Live button .

2. From the DX8100 menu bar, choose View > Cycle Views Setup > Dwell time change.

3. From the Dwell time change submenu, choose a user group.

Selecting the Cycle View Dwell Time

To configure the cycle period:

1. On the DX8100 toolbar, click the Live button .

2. From the DX8100 menu bar, choose View > Cycle Views Setup > Dwell time.

3. From the Dwell time submenu, choose a time period.

MAPPING CHANNELS ON THE EXTENDED MONITOR
The DX8100 HVR version 1.2 and later units include a standard dual display card. By default, the DX8100 is set up to display video on the 
extended monitor connected to the VGA connector on the dual display card. Alternately, you can configure the dual display card to display video 
on a composite monitor connected to the BNC connector on the dual display card. For information about how to reconfigure the dual display card, 
refer to the dual display card installation manual. 

The dual display card must be installed in the DX8100 and you must be logged on to the DX8100 application for the Channel Mapping icon  
to be available. 

The DX8100 division buttons allow you to configure multiple extended monitor views. Figure 7 shows the 9-Division view. The DX8100 supports 
up to nine different channel mapping views. Selected cameras from the Site Tree can be displayed on the extended monitor and can be assigned 
to multiple views. Each view is set up independently; removing a camera from one view does not remove it from another. 

To set up channel mapping for the extended monitor (VGA or composite):
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1. On the DX8100 toolbar, click the Channel Mapping button . The setup page opens to the “Channel Mapping for Extended Monitor” 
tab. You can also access this page from the Setup dialog box by clicking the Ext. Monitor icon.

Figure 7. Channel Mapping for Extended Monitor Page

2. To assign a camera to a pane, click and drag the camera from the Site Tree onto a pane. 

Figure 8. Assigning a Camera to a Pane

3. Repeat step 2 to assign other cameras to the view.

4. To move a camera from one pane to another pane, right-click and drag the camera to the new pane. If the new pane was empty, the N/A 
moves from the new pane to the old pane. If a camera was already assigned to the new pane, the two cameras switch places.

5. To remove a camera entirely from a view, right-click the camera and drag it outside of the view area. 

6. Click Apply to save the channel mapping.
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VIEWING VIDEO ON THE EXTENDED MONITOR
To display video on the extended monitor:

1. After you have mapped the channels, move the cursor to the extended monitor.

2. Click in the top-middle area of the extended monitor’s display. The division buttons appear.

Figure 9. Displaying the Extended Monitor Division Buttons

3. Click the specific division button for which a view is configured. Video is displayed on the extended monitor. 

At the extended monitor, video is only displayed if a view is already configured for the division button you selected. Otherwise, the Pelco 
blue logo appears.

4. Click a division button to display a different view.

MODIFYING AN EXTENDED MONITOR VIEW
To modify a display while viewing video on the extended monitor:

1. On the DX8100 toolbar, click the Channel Mapping button . 

2. Click the division button for the current view displayed on the extended monitor.

3. Modify the view: add, move, and remove cameras.

4. Click Apply. The change is displayed on the extended monitor.
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WORKING WITH THE SITE TREE
The Site Tree provides access to DX8100 resources, such as cameras, alarm inputs, and relay outputs. Objects can be selected by clicking the left 
mouse button once, and then linked by dragging and dropping the icon into a view pane or another Site Tree item. The Site Tree information 
reflects the current DX8100 server configuration.

Figure 10 shows the Site Tree.

Figure 10. Site Tree Parts
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Table M describes the Site Tree parts.

This section describes how to work with the Site Tree and includes the following topics:

• Assigning Cameras to View Panes on page 39

• Setting Up Links on page 39

• Removing Links on page 40

Table M.  Site Tree Parts

Item Part Description

Name Site: Expands and collapses the DX8100 site. Right-clicking the site name opens a shortcut menu that provides the 
following commands:

• User Log-In: opens the User Log-In dialog box, where you enter your user name and password to log into the 
DX8100 site.

• User Log-Out: Logs you out of the DX8100 site.

• Connect

• Disconnect

Camera: Expands and collapses the Camera tree.

Channel information: Displays icons that represent the configuration of the camera:

• Recording mode

• Recording resolution

• Recording frame rate

• Recording image quality

Alarm: Expands and collapses the Alarm tree.

ATM/POS: Expands and collapses the ATM/POS tree.

Relay: Expands and collapses the Relay tree. Right-clicking a relay opens a shortcut menu that provides the 
following commands:

• ON: Allows you to turn on the relay.

• OFF: Allows you to turn off the relay.

Remote site: Expands and collapses the remote DX8100 site. Right-clicking the remote site name opens a shortcut 
menu that provides the following commands: 

• User Log-In: Opens the User Log-In dialog box, where you enter your user name and password to log into the 
remote DX8100 site.

• User Log-Out: Logs you out of the remote DX8100 site.

• Connect: Allows you to connect to the remote site.

• Disconnect: Allows you to disconnect from the remote site.
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ASSIGNING CAMERAS TO VIEW PANES
The DX8100 provides view panes that are organized into view panels. The DX8100 includes 36 view panels that can display cameras from up to 
five connected HVR sites. For information about view panels, refer to Working with View Panes and Panels on page 30.

The DX8100 Series HVR supports triplex operation. Triplex operation means that the DX8100 will continuously record, even while users view 
simultaneous live and playback video or modify the system setup.

To assign a single camera to a view pane:

1. On the DX8100 toolbar, click the Live button .

2. In the Site Tree, click the plus sign (+) next to to expand the tree (if necessary).

3. Do one of the following:

• To assign a single camera to a view pane, drag the camera from the Site Tree onto a view pane. 

• To assign all cameras from a single site to the view panes, drag  onto a single view pane. (The default arrangement of cameras 

is Camera1, Camera2, Camera3; from left to right, top to bottom.)

4. Repeat the process in step 3 for up to 36 cameras and up to five HVR sites.

SETTING UP LINKS
The DX8100 allows you to set up links in various configurations:

• You can link multiple alarms and relays to a single camera. 

• You can link a single alarm or relay to multiple cameras. 

• You can link alarms and relays to cameras by dragging them onto individual camera view panes.

• You can also manually turn a relay on and off from the Site Tree.

This section describes how to set up links and includes the following sections:

• Manually Turning On and Off a Relay on page 39

• Linking Alarm Inputs to a Camera on page 39

• Linking a Relay Output to a Camera on page 40

• Linking Relay Outputs to Alarm Inputs on page 40

Manually Turning On and Off a Relay
To manually turn on and off a relay:

1. Right click a relay. The shortcut menu opens.

2. Click ON to turn on the relay; click OFF to turn off the relay.

Linking Alarm Inputs to a Camera
The DX8100 allows you to link alarm inputs to a camera.

• You can link multiple alarm inputs to a single camera. 

• You can also link a single alarm input to multiple cameras. 

The DX8100 allows you to link alarms to cameras by dragging them onto individual camera view panes or onto cameras listed in the Site Tree.

To link an alarm input to a camera:

1. On the DX8100 toolbar, click the Live button .

2. In the Site Tree, click the plus sign (+) next to the camera to which you want to link alarms.

3. Click the plus sign (+) next to the  to see the list of alarm inputs.

4. Drag an alarm input onto a camera pane or a camera listed in the Site Tree.
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Linking a Relay Output to a Camera
The DX8100 allows you to link relays to a camera.

• You can link multiple relays a single camera. 

• You can also link a single relay to multiple cameras. 

The DX8100 allows you to link relays to cameras by dragging them onto individual camera view panes or onto cameras listed in the Site Tree.

To link a relay output to a camera:

1. On the DX8100 toolbar, click the Live button .

2. In the Site Tree, click the plus sign (+) next to the camera to which you want to link relays.

3. Click the plus sign (+) next to  to see the list of relay outputs.

4. Drag a relay onto a camera pane or a camera listed in the Site Tree. 

Linking Relay Outputs to Alarm Inputs
To link a relay output to an alarm input: 

1. On the DX8100 toolbar, click the Live button . 

2. In the Site Tree, click the plus sign (+) next to  to expand the Alarm tree if needed.

Relays can also be linked to cameras and alarms on the Link settings page. For more information, refer to Configuring Basic Relay and 
Alarm Settings on page 132.

3. Click the plus sign (+) next to  to expand the Relay tree if needed.

4. Drag a relay output onto an alarm input in the Site Tree.

REMOVING LINKS
This section describes how to remove links and includes the following sections:

• Removing a Linked Alarm Input from a Camera on page 40

• Removing a Linked Relay Output from a Camera on page 40

• Removing a Linked Relay Output from an Alarm Input on page 41

Removing a Linked Alarm Input from a Camera
To remove an alarm link from a camera:

1. On the DX8100 toolbar, click the Live button .

2. In the Site Tree, click the plus sign (+) next to the camera from which you want to remove an alarm input.

3. Left click and drag the alarm outside the Site Tree panel, and then release the mouse button. 

4. Repeat the above process for each alarm you want to remove.

Removing a Linked Relay Output from a Camera
To remove a relay link from a camera:

1. On the DX8100 toolbar, click the Live button .

2. In the Site Tree, click the plus sign (+) next to the camera from which you want to remove the relay output.

3. Left click and drag the relay outside the Site Tree panel to the DX8100 toolbar or panel (above or below the Site Tree panel), and then 
release the mouse button. 

4. Repeat the above process for each relay you want to remove.
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Removing a Linked Relay Output from an Alarm Input
To unlink a relay from an alarm:

1. On the DX8100 toolbar, click the Live button .

2. In the Site Tree, click the plus sign (+) next to the alarm input from which you want to remove the relay output.

3. Left click and drag the relay outside the Site Tree panel, and then release the mouse button.

Repeat the above process for each relay you want to remove.
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Working in Live View Mode
This section describes how to use the DX8100 to view and record live video. All users can view live video from the main window. Users with PTZ 
access rights (Standard User by default) and higher can operate the on-screen PTZ controls. Live video can also be displayed in full screen view. 
For information about displaying playback video in full screen view, refer to Displaying Live Video in Full Screen View on page 29.

The DX8100 displays live video based on one of the following scenarios:

• Capture card displays live video: The capture card is used to display live video on the main VGA monitor. For each channel, live video is 
displayed on the VGA monitor at the maximum recording rate. For example, channel 1 is set to 2CIF recording resolution and the actual 
record rate is 1 image per second (ips). In this case, live video for channel 1 is displayed at 15 ips. Additionally, the capture card provides a 
BNC analog output of the live video image. The analog image is the same as the image displayed on the VGA monitor. The DX8100 External 
Monitor option allows you to configure how analog video is displayed on an external monitor connected to the capture card. For information 
about the External Monitor feature, refer to External Monitor Setup on page 228.

• MUX card displays real-time video: If the DX8100 is equipped with the MUX option, real-time video from the MUX card(s) is displayed 
on the main VGA monitor at 30 ips. Real-time video is displayed for all the channels regardless of the recording resolution. 
– Additionally, the MUX Card provides a BNC analog output of the real-time video image. The analog image is the same as the image 

displayed on the VGA monitor. The analog output does not contain any display icons, labels, or text, but video is displayed on the analog 
monitor in the same division mode as is displayed on the VGA monitor. 

– One operational difference is that the MUX stops the display of real-time video if the search mode is active for one channel. In this 
case, the capture card(s) are used to display the video. 

When installing the MUX card option, ensure that the MUX Card matches the capture card channel capacity as follows:

• If an 8-channel capture card is installed, the DX8108-MUX option is required. The DX8124 model HVR has two capture cards installed: an 
8-channel and a 16-channel capture card. In this case, the DX8108-MUX and DX8116-MUX option are required.

• If a 16-channel capture card is installed, the DX8116-MUX option is required. The DX8132 model HVR has two 16-channel capture cards 
installed. In this case, two DX8116-MUX options are required.

To view live video in the DX8100 main window:

• On the DX8100 toolbar, click Live.

This section includes the following topics:

• Assigning and Removing Cameras from View Panes

• Live View On-Screen Display (OSD) on page 46 

• Customizing the On-Screen Display (OSD) on page 47 

ASSIGNING AND REMOVING CAMERAS FROM VIEW PANES
The DX8100 allows you to quickly move cameras to and remove cameras from a view pane.

To assign a camera to the view pane:

1. Drag a camera from the Site Tree onto a view pane. 

2. Repeat the process in step 1 for up to 36 cameras and up to five different DX8100 sites.

To remove a camera from a view pane:

• Right click in the view pane and drag the camera to the Site Tree pane.

For information about the DX8100 view pane and panels, refer to the following topics:

• Working with View Panes and Panels on page 30 

• Configuring View Panels on page 31 

• Navigating View Panels on page 31
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SETTING UP FAVORITES
The DX8100 Favorites menu allows you to organize and save camera views. For example, you might want to display camera views that show the 
delivery gate entrance for buildings 1, 4, 7, and 12 during the hours of 06:00 to 07:30 and another camera view that displays the front lobby of 
buildings 1 through 16 at 08:00. 

This section describes the following topics:

• Adding a Camera View to Favorites 

• Organizing Favorites in Folders 

ADDING A CAMERA VIEW TO FAVORITES
You can create multiple camera views to monitor various site locations. For example, you could create a folder named Day Shift for displaying 
camera views during normal working hours and Night Shift for displaying various camera views after work and during the night hours. For 
information about organizing favorites into folders, refer to Organizing Favorites in Folders.

To add a camera view to favorites:

1. From the DX8100 menu bar, click Favorite > Add to Favorites. 

The Add to Favorites dialog box opens.

2. Enter the camera view name in the Name box.

3. Click OK. The camera view is added to the favorites, and the Add to Favorites dialog box closes.

4. To view the new entry, from the DX8100 menu bar, click Favorites. The new entry appears in the Favorites list.

Figure 11. Favorites Menu List
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ORGANIZING FAVORITES IN FOLDERS
As your list of favorites grows, you can keep them organized by creating folders. You can organize your camera views by site name, user name, 
and so forth. For example, you could create a folder named Day Shift for displaying camera views for the day shift.

Creating a Favorites Folder
To create a favorites folder:

1. From the DX8100 menu bar, click Favorite > Organize Favorites. 

The Organize Favorites dialog box opens.

Figure 12. Organize Favorites Dialog Box

2. Click Create Folder. A new folder is added to the favorites area.

3. To name the folder, do one of the following:

a. If the new folder name is already selected, type the name of the folder.

or

b. If the new folder name is not selected:

(1) Click the new folder.

(2) Type the name of the folder.

The new folder is listed in the Favorites area of the Organize Favorites dialog box and in the Favorites menu.
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Moving Existing Favorites to a Folder
To move an existing favorite to a folder:

1. Create a favorites folder (refer to Creating a Favorites Folder on page 44). 

2. From the DX8100 menu bar, click Favorite > Organize Favorites. 

The Organize Favorites dialog box opens. A list of the current favorites and folders is displayed in the favorites area.

Figure 13. Organize Favorites Dialog Box and List of Favorites/Folders

3. In the favorites area, click a favorite.

4. Click Move to Folder.

The Move to Folder dialog box opens.

Figure 14. Move to Folders Dialog Box

5. Select a destination folder.

6. Click OK.

The favorite is moved under the destination folder.
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LIVE VIEW ON-SCREEN DISPLAY (OSD)
The DX8100’s OSD consists of camera and site information that is superimposed on each view pane. Each display item in the OSD can be 
customized for both live and playback viewing.

Figure 15 shows the parts of the Live View OSD pane.

Figure 15. Live View OSD Pane

Table N describes the parts of the Live View OSD pane.

Table N.  Parts of the Live View OSD Pane

Item Part Description

PTZ Indicates that the PTZ control is enabled.

Indicates that audio recording is enabled. The DX8100 compresses audio data to save space. In this case, 
recorded audio may not be of the same quality as live audio.

REC Indicates camera recording mode and status. A blinking REC indicator signifies event recording.

• Green indicates normal recording.

• Blue indicates motion recording.

• Red indicates alarm recording.

• Yellow indicates ATM/POS recording.

• Purple indicates video loss recording.

• Black on white background indicates instant recording.

Site Designator Lists the number and name of the current site.

Camera Designator Lists the number and name of the current camera.

On-Screen PTZ Control Facilitates mouse control of PTZ functions. Refer to Operating the On-Screen PTZ Controls on page 50. 

Instant Recording Starts/stops instant recording if enabled.

�
�
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CUSTOMIZING THE ON-SCREEN DISPLAY (OSD)
Users with Guest User access and higher can add and delete on-screen display items. 

To customize the on-screen display:

1. From the DX8100 menu bar, choose View > OSD and then select the items you want to add to or delete from the OSD. Items include

• Site Name
• Camera Name
• Video Recording
• Audio Recording
• PTZ
• Instant Recording
• POS
• Select All (displays all items in each pane)
• Background Color

 

Figure 16. HVR OSD Menu Options

2. Do one of the following:

• From the DX8100 menu bar, choose View > OSD > Background Color > Set Color to add a contrasting background field behind each 
OSD display item.

• From the DX8100 menu bar, choose View > OSD > Background Color > Disable Background to remove background field.

INSTANT RECORDING
This section describes the instant recording mode. Users with Power User access and higher can configure the DX8100 for recording video both 
instantly and in accordance with a preset schedule. The Instant Recording mode is enabled from the Schedule page. Instant recording is 
activated from the main window by double-clicking the Instant Recording icon. 

If the HVR is not in the normal recording mode, you can use the instant recording mode to manually start and stop a video recording session 
instantly. For information about adding the Instant Recording icon to the OSD, refer to Adding Instant Recording to OSD on page 48.

This section includes the following topics:

• Enabling and Disabling Instant Recording 

• Adding Instant Recording to OSD on page 48 

• Starting and Stopping Instant Recording on page 48

ENABLING AND DISABLING INSTANT RECORDING
This section describes how to enable and disable the instant recording mode and includes the following topics:

• Enabling Instant Recording 

• Disabling Instant Recording

For more information about instant recording, refer to Instant Recording on page 47.
C2630M-C (7/09) 47



Enabling Instant Recording
To enable the Instant Recording mode: 

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page. 

2. In the Setup dialog box, click the Schedule button . 

3. In the Camera Settings Panel, from the Instant Recording drop-down box, select Enable. 

Disabling Instant Recording
To disable the Instant Recording mode: 

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page. 

2. In the Setup dialog box, click the Schedule button . 

3. In the Camera Settings Panel, from the Instant Recording drop-down box, select Disable. 

ADDING INSTANT RECORDING TO OSD
To add the Instant Recording icon to the OSD:

• From the DX8100 menu bar, choose View > OSD > Instant Recording.

The Instant Record icon is displayed in the lower-right corner of the view pane.

STARTING AND STOPPING INSTANT RECORDING
The Instant Recording mode must first be enabled from the Schedule page and the Instant Recording icon must be visible in the lower-right 
corner of the view pane. For more information about DX8100 instant recording, refer to Instant Recording on page 47. For information about OSD, 
refer to Live View On-Screen Display (OSD) on page 46.

Figure 17 shows the Record and Instant Record icons.

Figure 17. Activating Instant Recording

�

�
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Table O describes the recording indicators.

This section describes how to start and stop instant recording and includes the following topics:

• Starting Instant Recording

• Stopping Instant Recording

Starting Instant Recording
To start instant recording:

• Double-click the Instant Recording icon located in the lower-right corner of the view pane.
– The Instant Recording icon changes from silver to blue, indicating that instant recording is activated.
– If video recording is enabled, verify that REC is black and highlighted white. If video recording is not enabled, REC is not displayed or 

will show another recording mode color. 

Stopping Instant Recording
To deactivate instant recording:

• In the view pane, double-click the Instant Recording icon.

The instant recording icon changes from blue to silver, indicating that instant recording is de-activated.

LISTENING TO LIVE AUDIO AT THE SERVER

1. On the DX8100 toolbar, click the Live button . 

2. Drag a camera that is configured to record live audio from the Site Tree onto a view pane. 

NOTE: Live audio recording is not supported for IP cameras.  

3. On the playback control, click the Mute on/off button . The sound feature is enabled.

4. Verify that you can hear live audio from an audio monitoring device connected to the DX8100 server’s audio output.

Table O.  Recording Indicators

Item Icon Description

REC Indicates camera recording mode and status. A blinking REC indicator signifies event recording.

• Green indicates normal recording.

• Blue indicates motion recording.

• Red indicates alarm recording.

• Yellow indicates ATM/POS recording.

• Purple indicates video loss recording.

• Black on white background indicates instant recording.

Instant Recording Starts/stops instant recording if enabled. Changes from silver to blue to indicate that instant recording is activated.
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OPERATING THE ON-SCREEN PTZ CONTROLS
Users with PTZ access rights (Standard User by default) and higher can operate PTZ lens functions of cameras that support such features. PTZ 
functions can be controlled on the screen in Live mode using the mouse. 

PTZ control is available for cameras that support PTZ functions using Pelco’s P, D, or Coaxitron® protocols. It is also available for supported 
third-party dome cameras. For more information about configuring PTZ ports, refer to Setting Up COM1 Port Properties on page 179 and Setting 
Up RS-422/RS-485 Communication Port Properties on page 180.

In addition, the PTZ option must be enabled and a protocol must be assigned to the camera channel. For more information, refer to Camera Setup 
on page 116.

This section describes how to use the PTZ controls and includes the following topics:

• Operating the PTZ Controls 

• Adjusting the Camera Lens on page 51

• Adjusting the Camera Lens on page 51 

• Adjusting the Camera Zoom on page 51 

• Using Keyboard Shortcuts to Operate PTZ and Lens Functions on page 52

OPERATING THE PTZ CONTROLS
To operate the on-screen PTZ controls:

1. On the DX8100 toolbar, click the Live button . 

2. Select a PTZ-enabled camera from the Site Tree.

3. Place the mouse pointer in the middle of the camera’s view pane. The mouse pointer will change to a black cross when on-screen PTZ 
control is available.

Figure 18. On-Screen PTZ Control

4. Click and hold the left mouse button, and then drag the mouse pointer in the direction you want to move the camera. The display changes 
to an arrow, indicating the direction of the mouse.

Figure 19. On-Screen PTZ Movement

5. Release the mouse button when you have repositioned the camera to the desired location.

�
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ADJUSTING THE CAMERA LENS
The keypad is hidden in the extended view mode. In this case, select the standard view mode to display the keypad. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

For information about changing view modes, refer to Switching Between Standard and Extended Panel Views on page 30.

To adjust camera lens features:

• Click the plus (+) or minus (-) button next to the zoom, focus, and iris function on the keypad.

Figure 20. PTZ Keypad with Camera Lens Controls

ADJUSTING THE CAMERA ZOOM
To adjust camera zoom using the mouse:

• Rotate the mouse wheel forward to zoom in and backward to zoom out.

Figure 21 shows how to operate the mouse to zoom in and out. You can also use keyboard shortcuts to operate the lens features of cameras such 
as Pelco’s Spectra III. For more information about using keyboard shortcuts, refer to Using Keyboard Shortcuts to Operate PTZ and Lens Functions 
on page 52.

Figure 21. Mouse Wheel Zoom
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USING KEYBOARD SHORTCUTS TO OPERATE PTZ AND LENS FUNCTIONS
Users with PTZ access rights (Standard User by default) and higher can use a computer keyboard to operate PTZ and lens functions of cameras 
that support such features. PTZ and lens functions can be controlled in Live mode using the keyboard. 

Table P describes the keyboard buttons that you use to control PTZ and lens functions.

To use the keyboard (+) and (-) keys to control camera pan/tilt speed:

1. On the DX8100 toolbar, click the Live button .

2. Select a PTZ-enabled camera from the Site Tree.

3. Click the mouse pointer in the camera’s view panel.

4. Press and hold the up/down and left/right arrows to pan/tilt the camera.

5. Press the plus (+) key one or more times to increase the pan/tilt speed. Press the minus (-) key one or more times to decrease the pan/tilt 
speed. 

Table P.  Standard Keyboard Functions for Controlling PTZ and Lens Functions

Key Description

Insert and Delete These keys provide the following functionality:

• On-screen display, preset and pattern modes: Insert increases focus and Delete decreases focus, 
performing the same actions as the focus control on the PTZ keypad. 

• Remote camera programming mode: Insert and Delete perform the same actions as the PTZ keypad focus 
(+) and (-) buttons, navigating up and down the camera menu choices.

Home and End These keys provide the following functionality:

• On-screen display, preset and pattern modes: The Home key opens the iris and the End key closes the 
iris, performing the same actions as the PTZ keypad iris (+) and (-) buttons. 

• Remote camera programming mode: The Home key selects an option from the camera’s on-screen menu. 
The End key cancels an option or exit a menu. These keys perform the same actions as the PTZ keypad iris (+) 
and (-) buttons.

Page Up and Page Down These keys provide the same functionality in the on-screen display and the preset and pattern modes as the PTZ 
keypad zoom (+) and (-) buttons. Page Up zooms in; Page Down zooms out.

Up and Down Arrows These keys provide the following functionality:

• On-screen display, preset and pattern modes: The up arrow key raises the camera and the down arrow 
key lowers the camera. The keys perform the same actions as the mouse to move the camera. 

• Remote camera programming mode: The arrow keys navigate up and down the camera menu choices. 
The keys perform the same actions as the PTZ keypad focus (+) and (-) buttons.

Left and Right Arrows These keys provide the same actions as the mouse for moving the camera. The left arrow key pans the camera to 
the left and the right arrow key pans the camera to the right.

+ and - These keys perform similar actions as using the mouse to change the speed of camera movement. When pressed 
once, the plus (+) key increases the camera's pan/tilt speed; when pressed once, the minus (-) key decreases the 
pan/tilt speed. Each time the plus (+) key is pressed the pan/tilt speed is increased toward maximum speed; each 
time the minus (-) key is pressed, the pan/tilt speed is decreased toward minimum speed. 
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PTZ PRESETS
A preset is a user-defined camera position using PTZ and focus commands the (camera’s auto focus option must be turned off). Only cameras that 
support positioning and programming using D, P, Coaxitron, or supported third-party protocols can use this feature. The DX8100 Series HVR can 
address up to 150 PTZ presets (1-150). Preset 95 is reserved for remote camera setup, and preset 99 is reserved for camera autoscan mode.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

For information about changing view modes, refer to Switching Between Standard and Extended Panel Views on page 30.

The following PTZ operating guidelines must be observed:

• To program or clear presets, preset tours, and patterns, the  button must be engaged. 

• To activate presets, tours, and patterns, the  button must be disengaged. 

This section describes how to program, activate, and clear presets and includes the following topics:

• Programming a Preset 

• Activating a Preset on page 54 

• Clearing a Preset on page 55 

PROGRAMMING A PRESET
This section describes how to program a preset. The following PTZ operating guidelines apply:

• Clicking the  button places DX8100 in PTZ programming mode. 

• While in PTZ programming mode, multiple presets can be programmed until the  button is pressed again. 

To program a PTZ preset:

1. On the DX8100 toolbar, click the Live button . 

2. Drag a camera from the Site Tree onto a view panel. 

3. On the PTZ keypad, click the Set button . 

4. Using the on-screen PTZ controls and PTZ keypad, move the camera to the desired position and adjust the zoom setting.

Figure 22. Creating a Preset

EXIT
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5. Using the PTZ keypad, select a number for the new preset (for example, select 1).

6. Click the Preset button  to store the preset in the selected memory location. 

7. Repeat steps 4-6 for each preset you want to program.

8. Click the Set button  again to exit programming mode. 

Figure 23. Programming a Preset

ACTIVATING A PRESET
Double- and triple-digit presets can be set or activated by pressing the first digit and then the second digit sequentially. For example, preset 20 
can be selected by clicking the number 2 and then the 0 (zero) on the PTZ keypad.

To activate a preset:

1. On the PTZ keypad, click a preset number (1-150) on the keypad.

2. Click the Preset button  to activate preset. The camera repositions to the new preset. 

Figure 24. Activating a Preset
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CLEARING A PRESET
To clear a preset:

1. On the PTZ keypad, click the Set button  to enter programming mode.

2. Click the number of the preset you want to clear from the PTZ keypad.

3. Click the Clr button .

4. Repeat steps 2 and 3 to clear multiple presets.

5. Click the Set button  to exit programming mode.

Figure 25. Clearing a Preset

PTZ PATTERNS
A pattern is a user-defined, viewable camera path with a definite beginning and end. Patterns are made up of a sequence of standard pan, tilt 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra® dome, that is connected to the DX8100. 
The Spectra III supports one pattern and the Spectra III SE supports up to four unique PTZ patterns. Depending on the type and configuration of 
the PTZ device, the DX8100 can address up to four unique PTZ patterns. Once defined, a pattern can be activated with a series of on-screen 
commands. A pattern will run continuously until it is deactivated. 

Only PTZ-enabled cameras that support pattern programming through D, P, Coaxitron, or supported third-party protocols can use this feature.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

This section describes how to program, activate, and clear patterns, and access the programming features of remote cameras. This section 
includes the following topics:

• Programming a Pattern 

• Activating a Pattern on page 57

• Clearing a Pattern on page 57 

• Accessing Programming Features of Remote Cameras on page 58

�
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�
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PROGRAMMING A PATTERN
This section describes how to program a pattern. Certain PTZ devices, such as Pelco’s Spectra series domes, will display an on-screen message 
stating the amount of remaining memory available for pattern programming.

Start Programming a Pattern

To program a pattern:

1. On the PTZ keypad toolbar, click the Live button .

2. Drag a camera from the Site Tree onto a view panel.

3. On the PTZ keypad, click the Set button  to enter programming mode.

4. Using the PTZ keypad, select a number for the pattern (1-4).

5. Click the Pattern button .

6. Move the camera through a series of movements using the on-screen PTZ and focus controls.

Figure 26. Programming a Pattern

Stop Programming a Pattern

To stop programming a pattern:

1. On the PTZ keypad, click the Pattern button .

2. Click the Set button .

�
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ACTIVATING A PATTERN

When activated, a pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

To activate a pattern:

1. On the PTZ keypad, click a pattern number (1-4) on the keypad.

2. Click the Pattern button .

Figure 27. Activating a Pattern

CLEARING A PATTERN
To clear a pattern:

1. On the PTZ keypad, click Set button  to enter programming mode.

2. Select a pattern number (1-4) on the keypad.

3. Click the Pattern button .

4. Click the Clr button .

5. Click the Pattern  again.

6. Click the Set button  again to exit programming mode.

Figure 28. Clearing a Pattern
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ACCESSING PROGRAMMING FEATURES OF REMOTE CAMERAS
You can use the PTZ function to program features of remote cameras, such as Pelco’s Spectra or Esprit®. Only cameras that support remote 
programming through D, P, Coaxitron, or supported third-party protocols can use this feature. 

The DX8100 allows you to navigate the remote camera menu system using any of the following:

• PTZ OSD Menu controls. For information about using the PTZ OSD Menu controls, refer to Using the PTZ OSD Menu Control on page 58.

• Keypad controls. For information about using the keypad controls, refer to Accessing a Remote Camera Programming Menu on page 59.

• Keyboard keys. For information about using the keyboard keys, refer to Using Keyboard Shortcuts to Operate PTZ and Lens Functions on 
page 52.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

This section describes how to access the programming features of remote cameras and includes the following topics:

• Using the PTZ OSD Menu Control 

• Accessing a Remote Camera Programming Menu on page 59 

Using the PTZ OSD Menu Control
The DX8100 allows you to navigate the menu system of remote cameras using the PTZ OSD Menu control. The PTZ OSD Menu control is 
available when the DX8100 is in Live View mode. The PTZ controls are hidden in the extended view mode. In this case, select the standard view 
mode to display the PTZ controls. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

Alternative methods to navigate the remote camera menu system are as follows:

• Keypad controls. For information about using the keypad controls, refer to Accessing a Remote Camera Programming Menu on page 59.

• Keyboard keys. For information about using the keyboard keys, refer to Using Keyboard Shortcuts to Operate PTZ and Lens Functions on 
page 52.

Figure 29 shows the parts of the PTZ OSD Menu control.

Figure 29. PTZ OSD Menu Control
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Table Q describes the parts of the PTZ OSD Menu control.

Accessing a Remote Camera Programming Menu
The DX8100 allows you to navigate the remote camera menu system using any of the following:

• PTZ OSD Menu controls. For information about using the PTZ OSD Menu controls, refer to Using the PTZ OSD Menu Control on page 58.

• Keypad controls. For information about using the keypad controls, refer to Accessing a Remote Camera Programming Menu.

• Keyboard keys. For information about using the keyboard keys, refer to Using Keyboard Shortcuts to Operate PTZ and Lens Functions on 
page 52.

The following procedure instructs you to use the PTZ OSD Menu control to navigate the remote camera programming menu.

To access a programming menu for a remote camera:

1. On the DX8100 toolbar, click the Live button . 

2. Drag a remote camera from the Site Tree onto a view panel.

For certain camera models, you can also select preset number 95 from the keypad to access remote setup mode.

3. To access remote camera setup mode, do one of the following:

• On the PTZ keypad, click the Pgm button .

• On the PTZ keypad, click the Set button , the number buttons 9, 5, and the Preset button .

Figure 30. PTZ Control Panel

4. To navigate up and down through camera menu choices, do one of the following:

• Use the PTZ OSD Menu controls. 
• Use the on-screen PTZ controls or the focus (+) and focus (-) buttons. 

Table Q.  Parts of the PTZ OSD Menu Control

Item Part Description

Enter Provides the following actions:

• Accepts the selected remote camera OSD menu choice.

• Accesses menu option parameters. For example, point the cursor at the Language option and click Enter 
accesses the list of available languages. 

Exit N/A

Up and Down Buttons Navigate up and down the remote camera OSD menu, or cycle through a list of options or parameters.

Left and Right Buttons Perform no activity.
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5. To select an option from the camera’s on-screen menu, do one of the following:

• On the PTZ OSD Menu, click Enter.
• On the keypad, click the iris (+) button.

6. Click the iris (-) button to cancel an option or select the Exit command.

You can also use the on-screen PTZ controls with your mouse to navigate through camera menus. Click and drag the mouse up or down to 
move between menu options.

7. Click the iris (+) button to select the option, or to exit a menu when the cursor is pointed at the Exit command.

Figure 31. Camera Setup Menu
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SENDING AUXILIARY COMMANDS TO A DEVICE
The DX8100 auxiliary feature allows you to control external equipment connected to the auxiliary outputs of Spectra domes or Esprit positioning 
systems. The auxiliary function is implemented through the D protocol and P protocol. In this case, the attached camera and DX8100 must be 
configured to communicate using one of these protocols. 

The Aux key selects the auxiliary mode. Buttons 1-4 select which of the camera’s auxiliary outputs to operate. Buttons 1-4 operate as a toggle 
(on/off) each time they are clicked. 

For example, an Esprit equipped with a wiper uses Aux 1 to control the wiper. In this case, pressing Aux and then 1 sends a command to the 
Esprit to operate the wiper. You must configure the camera to establish how the camera responds to an auxiliary command. For detailed 
information about how a specific Spectra or Esprit camera system interprets auxiliary commands, refer to the documentation that accompanies 
your Spectra or Esprit camera system. 

To send an auxiliary command:

1. On the PTZ keypad, click the Set button  to enter the programming mode. 

2. Select the camera in the DX8100 view panel to which you want to send the auxiliary command.

3. Click the Aux button. Keypad buttons 1-4 are available.

Figure 32. Auxiliary (Aux) Button

4. Click a keypad button (1-4). The auxiliary function, assigned by camera for the selected button, is executed.

�
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CONFIGURING PRESET TOURS
A preset tour allows a camera to move through a programmed sequence of PTZ presets. The DX8100 Series HVR can store up to four preset 
tours. While four tours can be programmed, only one tour can be activated at a time. A preset tour will operate continuously until another PTZ 
control action is performed. At least one PTZ preset must be set in order to create a preset tour.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

This section describes how to configure preset tours and includes the following topics:

• Programming a Preset Tour 

• Activating a Preset Tour on page 65 

• Deactivating a Preset Tour on page 65

PROGRAMMING A PRESET TOUR
This section describes how to program a preset tour and includes the following topics:

• Accessing a Preset Tour Group

• Adding Presets to a Tour on page 63

• Deleting Presets from a Tour on page 64 

Accessing a Preset Tour Group
To access the “Preset tour group” dialog box:

1. On the DX8100 toolbar, click the Live button . 

2. On the PTZ keypad, click the Set button  and then click the Pgm button . The “Preset tour group” dialog box opens.

3. Select the preset tour (1-4) that you want to program from the drop-down box.

4. Do one of the following:

• To add presets to a tour, refer to Adding Presets to a Tour on page 63.
• To delete presets from a tour, refer to Deleting Presets from a Tour on page 64.

Figure 33. Preset Tour Dialog Box

�
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Adding Presets to a Tour
To add presets to a tour:

1. Access the “Preset tour group” dialog box. For information about accessing the “Preset tour group” dialog box, refer to Accessing a Preset 
Tour Group on page 62.

2. Click the check box beside one of the presets you want to add to the tour.

3. Double-click in the Dwell Time field of a preset, and then increase or decrease the time (in seconds) at which the camera will remain during 
that sequence of the tour. 

4. Repeat steps 1 and 2 for each additional preset you want to add to the tour.

5. Click Add to Group.

6. Click Save.

7. Click Exit to return to the main screen.

Figure 34. Adding Preset to Tour
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Deleting Presets from a Tour
To delete presets from a tour:

1. Access the “Preset tour group” dialog box. For information about accessing the “Preset tour group” dialog box, refer to Accessing a Preset 
Tour Group on page 62.

2. Click the check box beside one or more presets you want to delete from the preset tour group.

3. Click Delete.

4. Click Save.

5. Click Exit to return to the main screen.

Figure 35. Deleting Preset from Tour
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ACTIVATING A PRESET TOUR
This section describes how to activate a preset tour. You can save a preset tour for later use without engaging the tour by not performing step 5. 
Then, continue on to step 6 without clicking Apply.

To activate a preset tour: 

1. On the DX8100 toolbar, click . 

2. On the PTZ keypad, click the Set button  and then click the Pgm button  to bring up the “Preset preset tour group” dialog box.

3. From the drop-down box, select the preset tour (1-4) you want to activate.

4. Click Save. 

5. Click Apply. 

6. Click Exit to return to the main screen.

7. Click the Set button  on the PTZ keypad to exit programming mode.

8. Click the Preset button  on the PTZ keypad to activate the tour.

Figure 36. Activating a Preset Tour

To reactivate the last preset tour you configured:

•  On the keypad, click Preset.

DEACTIVATING A PRESET TOUR
To deactivate a preset tour, do one of the following:

• Use the mouse to move the on-screen PTZ control.

• Activate a PTZ preset.
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USING THE KBD300A KEYBOARD
The KBD300A allows you to operate certain DX8100 live view display functions and control camera PTZ operations from a keyboard, rather than 
a mouse. 

When connected to the DX8100 server, the KBD300A supports two modes: the Standard mode and the Shift mode. The Shift mode is entered by 
pressing the Shift button and is indicated by a lit LED. For information about how to operate the KBD300A, refer to the KBD300A Universal 
Keyboard Installation/Operation manual.

This section describes the KBD300A operational features and is organized as follows:

• KBD300A Standard Mode Operational Features

• KBD300A SHIFT Key Mode Features on page 67

For information about connecting the KBD300A to the DX8100, refer to the DX8100 Installation manual. For information about configuring 
DX8100 data communication settings for the KBD300A, refer to Setting Up the KBD300A Keyboard on page 198.

KBD300A STANDARD MODE OPERATIONAL FEATURES
The KBD300A Standard mode allows you to control certain DX8100 operation features from the keyboard. 

This section describes the KBD300A Standard mode features/functions. The Standard mode only works in the DX8100 view pane. You can 
program camera presets and patterns, operate the camera PTZ features, and assign cameras to panes. For detailed information about how to 
operate the KBD300A, refer to the KBD300A Universal Keyboard Installation/Operation manual. For information about configuring DX8100 data 
communication settings for the KBD300A, refer to Setting Up the KBD300A Keyboard on page 198.

Table R describes the KBD300A Standard mode operational features specific for the DX8100 server.

To place the KBD300A in the standard mode:

• On the KBD300A keyboard, press the SHIFT button.

The LED indicator should not be lit.

Table R.  KB300A Standard Operational Mode Features

Keyboard Control Action

Joystick Controls the camera’s PTZ operation.

Number + PRESET (short) Moves camera to the programmed preset position.

Number + PRESET (long) Programs the current camera position to the desired preset number.

Number + PATTERN (long) Starts the pattern record mode.

ACK Stops the pattern record mode.

Number + PATTERN Runs the desired pattern.

Number + AUX ON/AUX OFF Turns on/off the specified auxiliary output.

Number + MON Assigns the selected camera to the desired view pane. The active view pane is highlighted.
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KBD300A SHIFT Key Mode Features
The KBD300A SHIFT key allows you to control certain DX8100 operation features in the Site Tree from the keyboard. 

This section describes the KBD300A SHIFT key features. The SHIFT key is effective within the DX8100 Site Tree. You can move the cursor to 
select elements within the Site Tree, expand and collapse elements, and select the display division. For detailed information about how to 
operate the KBD300A, refer to KBD300A Universal Keyboard Installation/Operation manual. For information about configuring DX8100 data 
communication settings for the KBD300A, refer to Setting Up the KBD300A Keyboard on page 198.

Table S describes the KBD300A SHIFT key features specific to the DX8100 server.

To place the KBD300A in the shift mode:

• On the KBD300A keyboard, press the SHIFT key.

The LED indicator should be on.

Table S.  KBD300A Shift Key Features

Keyboard Control Action

Joystick Activity within the DX8100 Site Tree:

• Up/down direction: Moves the cursor vertically through each element in the Site Tree. 

An element is a DX8100 site, camera within each DX8100 site, or Alarm, ATM/POS, and relay within each 
DX8100 site.

If an element is expanded, the joystick moves the cursor vertically through the objects of that element.

• Left/right direction: 

– Right: Expands an element to display objects contained under the element.
– Left: Collapses an element and hides its objects. Select a camera/unit at the tree.

Number + CAM Expands the Site Tree and selects the first camera in each DX8100 site. For example, if there are two sites with one 
named DX8100 site 1 and the other named DX8100 site 2:

• Pressing 1 + CAM expands the Site Tree for DX8100 site 1 and selects the first camera. It does not assign the 
selected camera to a view pane or display video.

• Pressing 2 + CAM expands the Site Tree for DX8100 site 2 and selects the first camera. It does not assign the 
selected camera to a view pane or display video.

F2, F3, ON, OFF Cameras are assigned numerically 1–16 to the respectively numbered video. These controls display DX8100 video 
in the following divisions:

• F2/OFF: Single-division view

• F3/MOM: 4-division view

• AUX ON: 9-division view 

• AUX OFF: 16-division view

Repeatedly pressing a button causes the DX8100 to cycle through the display of the remaining panels.
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Working in Playback Mode
Recorded video can be played back one channel at a time on the DX8100. Like live video, recorded video is viewed from the camera view panels 
on the main screen. Refer to Switching Between Standard and Extended Panel Views on page 30 for information about view panels. Only users 
with playback access rights (Standard User by default) and higher are allowed to view recorded video. Playback video can also be displayed in 
full screen view. For information about displaying playback video in full screen view, refer to Displaying Playback Video in Full Screen View on 
page 30.

This section describes how to use the Playback mode and includes the following topics:

• Printing Images

• Accessing Playback Mode 

• Assigning Cameras to View Panels 

• Playback On-Screen Display (OSD) on page 68 

• Playback Controls on page 69 

• Playback Timeline on page 71 

• Playing Back Video by Time on page 71

• Playing Back Video by Event on page 73

• Operating Playback Digital Zoom on page 73

• Viewing Video in the Deinterlaced Mode on page 96

• Viewing Live and Playback Video Simultaneously on page 96

PRINTING IMAGES
To print a still image, use the playback controls to pause video playback at a specific image. Then click the Print button  on the DX8100 
toolbar.

ACCESSING PLAYBACK MODE
To access the Playback mode, click the Live button  on the DX8100 toolbar.

ASSIGNING CAMERAS TO VIEW PANELS
To assign a camera to a view panel:

1. Drag a camera from the Site Tree onto a camera view pane.

2. Repeat this process for up to 36 cameras.

PLAYBACK ON-SCREEN DISPLAY (OSD)

Figure 37. Playback OSD
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PLAYBACK CONTROLS
Use the playback controls to start playback, control direction, and adjust speed. On the playback control, click the Stop button  at any 
time to return to live view. 

The playback controls are hidden in the extended view mode. In this case, select the standard view mode to display the playback controls. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

Figure 38 shows the parts of the DX8100 playback controls.

Figure 38. Playback Controls 

Table T describes the parts of the payback controls.

Table T.  Parts of the Playback Controls

Item Part Description

Frame-By-Frame Reverse Each frame is displayed in the reverse direction with each click of the Frame-by-Frame Reverse button.

Frame-By-Frame Forward Each frame is displayed in the forward direction with each click of the Frame-by-Frame Forward button.

Fast Forward to End Advances the bookmark to the end of the latest recorded video. 

Play Forward Initiates normal playback of recorded video in the forward direction.

Stop Stops playback control activity and returns to the Live View mode.

Pause Pauses video playback in the forward or reverse direction.

Play Reverse Initiates normal playback of recorded video in the reverse direction.

Rewind to Beginning Returns the bookmark to the start of the earliest recorded video. 
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Figure 39 shows the parts of the DX8100 playback speed and volume controls.

Figure 39. Playback Speed and Volume Controls

Table U describes the parts of the playback speed and volume controls.

Table U.  Parts of the Playback Speed and Volume Controls

Item Part Description

Normal Playback speed is at normal rate.

Faster Playback speed is increased to a faster rate.

Slower Playback speed is reduced to a slower rate.

Louder Volume is increased to a higher level or decreased to a lower level.

Mute Volume is silenced.

�
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PLAYBACK TIMELINE
The playback timeline is used to select a day and time to begin playback. The timeline includes a horizontal slider that can be moved to select 
playback time over a 24-hour period. Time periods containing recorded video are represented as color-coded segments of the timeline. Figure 40 
shows the parts of the timeline color-coding scheme.

 

Figure 40. Playback Timeline

Table V describes the parts of the playback timeline control.

PLAYING BACK VIDEO BY TIME
This section describes how to play back video by time. The time is displayed in 24-hour clock format. You can select the time by moving the slider 
along the timeline.

This section includes the following topics:

• Starting Playback from a Specific Point in Time

• Understanding Instant Playback on page 72

STARTING PLAYBACK FROM A SPECIFIC POINT IN TIME
To start video playback from a particular point in time:

1. On the DX8100 toolbar, click the Live button . 

2. Select a camera in the Site Tree. You can also select the camera from a view pane if the camera appears in the panel.

Table V.  Parts of the Playback Timeline Control

Item Part Item Part

Currently displayed view panel Selected second

Total number of view windows Increase timeline detail

Site number Decrease timeline detail

Camera number Alarm recording

Camera name Normal recording

Selected date Motion detection recording

Selected hour Timeline slider

Selected minute Instant recording

00   01   02    03   04   05    06   07   08    09   10   11   12    13   14   15   16    17   18    19   20   21   22   23

Panel:      1/8 S03  C09 [Camera 9] 11-27-2003 05 00 56
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3. In the Timeline section, do the following:

a. In the Date Selection drop-down box, select the day you want playback to begin.

b. Use the spinner buttons to select the time.

4. On the playback control, click the Forward button  to begin viewing. 

Figure 41. Date Selection Drop-Down Box

UNDERSTANDING INSTANT PLAYBACK
The DX8100’s ability to perform instant playback of video is limited by a one-minute delay interval. The DX8100 has a built-in latency of 
approximately one minute between the time that video is captured and when it is written to the hard disk. This delay exists to ensure that video 
is accurately stored and the HVR’s database is updated correctly.

The delay interval is not affected if the DX8100 is in the alarm or motion record mode. In this case, the pre-alarm or pre-motion time period does 
not become a factor in determining the delay interval.

To initiate an instant playback:

• On the playback control, click Instant Playback. The timeline is zoomed to the last two or three minutes of data. 

The user can view video that has just been recorded. This video resides in memory and has not yet been stored on the hard drive. The color of the 
timeline for this video will be green. This is because the system cannot identify the data characteristic until the data is stored on the hard disk 
drive.

For example, if this data is recorded from a camera configured to monitor motion and there is no motion activity, the data will not be stored on 
the hard disk drive. 
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PLAYING BACK VIDEO BY EVENT
Users with playback access rights (Standard User by default) and higher can search video by events, such as motion detection or alarm 
activation. A sensor event is identical to an alarm event.

To play back video recorded during an alarm or motion event:

1. On the DX8100 toolbar, click the Live button . 

2. From the DX8100 menu bar, choose View > Index View. The Event Type drop-down box is displayed. 

Figure 42. Event Type Drop-down Box

3. Select a camera by clicking it in the Site Tree.

4. In the Date Section drop-down box above the playback timeline, select the day that you want events to be displayed. 

5. In the Event Type drop-down box, select the event type you want to view. Options are as follows:

• All
• None
• Motion
• Alarm in
• ATM/POS
• Video Loss

6. Select an event from the listing.

7. On the playback control, click the Forward button  to begin viewing. 

OPERATING PLAYBACK DIGITAL ZOOM
Video playback can be zoomed (using a control keypad or the mouse) when the DX8100 is in the Playback or Search mode. In Playback mode, the 
on-screen PTZ feature is replaced with the mouse-activated digital zoom. Playback digital zoom is also available in Search mode. For information 
about the Playback mode, refer to Working in Search Mode on page 77. For information about the Search mode, refer to Working in Search Mode 
on page 77.

The PTZ controls are hidden in the extended view mode. In this case, select the standard view mode to display the PTZ controls. 

To switch between the standard and extended view mode:

• From the DX8100 menu bar, choose View > Extended View.

This section describes how to operate playback digital zoom and includes the following topics:

• Zoom Using the Digital Zoom Control 

• Zoom Using the Mouse on page 75

• Panning a Zoomed Image on page 76

• Working in Playback Mode on page 68

• Working in Search Mode on page 77
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ZOOM USING THE DIGITAL ZOOM CONTROL
The digital zoom feature is accessible when the DX8100 is in the Playback or Search mode. For information about the Playback mode, refer to 
Working in Playback Mode on page 68. For information about the Search mode, refer to Working in Search Mode on page 77.

To zoom using the digital zoom control: 

1. To place the DX8100 in the Playback or Search mode, do one of the following:

• On the DX8100 toolbar, click the Live button . 

• On the DX8100 toolbar, click the Search button .

2. On the playback control, click the Forward button  to start video playback.

3. Use the Digital Zoom control to zoom and pan video playback.

Figure 43. Playback Digital Zoom Control

Table W describes the parts of the Digital Zoom control. 

Table W.  Parts of the Digital Zoom Control 

Item Part Description

Zoom In Allows you to magnify the entire pane. Click the Zoom In button to magnify to the next preset magnification 
level (x1-6). 

Zoom Out Allows you to reduce to the previous preset magnification. Click the Zoom Out button to reduce to the previous 
magnification level.

Pan Left Allows you to move the magnified playback image to the left.

Pan Right Allows you to move the magnified playback image to the right.

Pan Up Allows you to move the magnified playback image up.

Pan Down Allows you to move the magnified playback image down.

Zoom Restore Allows you to return the zoomed image to the original size.
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ZOOM USING THE MOUSE
The DX8100 allows you to use the mouse to drag a selection region (rectangle) around a specific area of a pane, and to zoom the selection in and 
out. A small rectangle about 0.25 inches (6.4 mm) square provides a x6 zoom factor. As the selection area increases in size, the zoom in/out factor 
decreases: x5, x4, x3, x2, and x1.

• If you use the mouse to select an area about 0.25 inches (6.4 mm) in size, the zoom feature performs as follows: 
– If zooming in, the zoom factor is at x6. The selected viewing area is zoomed to the largest size.
– If zooming out, the zoom factor is at x6. The selected viewing area is zoomed to the original size.

• If you use the mouse to select the entire pane, the zoom feature performs as follows: 
– If zooming in, the zoom factor is at x1. In this case, the selected viewing area is slightly enlarged. You will have to perform many zoom 

in operations to arrive at the largest zoom size.
– If zooming out, the zoom factor is at x1. In this case, the selected viewing area is slightly reduced. You will have to perform many zoom 

out operations to arrive at the original size.

• You can also use the hand tool and the mouse wheel to zoom in and out.

The zoom factor is displayed in the upper-right corner of the pane. The effective zoom in factor is displayed after the zoom operation is 
performed. The effective zoom out factor is not displayed.

To zoom using the mouse:

1. To place the DX8100 in the Playback or Search mode, do one of the following:

• On the DX8100 toolbar, click Live. 
• On the DX8100 toolbar, click Search.

2. On the playback control, click the Forward button  to start video playback.

3. Do the following:

a. To zoom in, click and drag the mouse diagonally to your right in a downward direction.
.

Figure 44. Zoom In Using Mouse

b. To zoom out, click and drag the mouse diagonally to your left in an upward direction. 

Figure 45. Zoom Out Using Mouse
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PANNING A ZOOMED IMAGE
This section describes how to use the hand tool and mouse wheel to zoom in and out.

To pan a zoomed portion of video within the view panel: 

1. To place the DX8100 in the Playback or Search mode do one and of the following:

• On the DX8100 toolbar, click Live. 
• On the DX8100 toolbar, click Search.

2. Right-click in the view panel. The mouse pointer now resembles a hand.

3. Click the left mouse button, and drag the mouse in the direction you want to move the video image. 

4. Right-click again to return to zoom mode.
 

Figure 46. Panning Zoomed Video with the Mouse
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Working in Search Mode
The DX8100 Series HVR supports four video search methods: index, thumbnail, POS, and pixel. For information about the user access level 
required to search video data, refer to Definition of User Access Levels on page 210. 

To enter the Search mode:

• On the DX8100 toolbar, click Search.

This section describes how to use the Search mode and includes the following topics:

• Search Window 

• Displaying a Deinterlaced Image in the Search Mode on page 78 

• Reusing the Search Time Range on page 78

• Index Video Search on page 79 

• Thumbnail Video Search on page 80 

• POS Search on page 82

• Pixel Video Search on page 93 

• Working with Special View and Search Methods on page 96

SEARCH WINDOW
The search window facilitates access to the search capabilities of the DX8100. Available search methods include index, thumbnail, POS, and 
pixel. Each search method allows users with playback access rights (Standard User by default) and higher to locate video data instantly using 
criteria such as time of day or changes in window pixels.

As in Playback mode, digital zoom, export, and print features are available in Search mode. For more information, refer to Operating Playback 
Digital Zoom on page 73, Exporting Video on page 97, and Printing Images on page 68. 

Figure 47 shows the parts of the DX8100 window in Search mode.

Figure 47. DX8100 HVR Search Mode Window
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Table X describes the parts of the DX8100 window in the Search mode.

DISPLAYING A DEINTERLACED IMAGE IN THE SEARCH MODE
If you are searching for an image that is recorded at 4CIF at a low frame rate per second, the viewed image might move or tear. The View menu’s 
Deinterlaced Image option is used to enhance the image during a search activity. 

To search video using the deinterlaced option:

1. On the menu bar, click View > Display deinterlaced image.

2. On the DX8100 toolbar, click the Search button . The DX8100 is placed in the Search mode.

REUSING THE SEARCH TIME RANGE
The DX8100 allows sharing of time range search settings between the Thumbnail and Pixel search mode. If you initiate a Thumbnail search, you 
can select a preview clip and initiate a Pixel search. The Pixel search mode is based on the same time criteria as the preview Thumbnail clip.

Table X.  Parts of the DX8100 Window in Search Mode

Item Part Description

Index Search Allows users to search motion and alarm events listed in the event index panel. 

Thumbnail Search Allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a 
series of thumbnail images. Each thumbnail represents the first image recorded during a specified period of 
time. Thumbnails can be expanded and collapsed to represent hourly, 10-minute, and 1-minute intervals.

POS Search Allows users to search ATM/POS transaction text data. 

Pixel Search Allows users to search any 24-hour period of recorded video automatically for changes in screen pixels. 

View Window Displays search video, image thumbnails, and pixel grid.

Site Tree Facilitates top-down, hierarchical management of DX8100 resources such as servers, cameras, alarms, and 
relays.

Event Index Panel Lists motion and alarm events over the 24-hour time period specified in the playback timeline. 

Select All Check Box Enables playback for all visible view panels when selected. If this check box is deselected, only the selected 
channel will play. This control is only available while using Index Search.

Playback Timeline Displays a 24-hour timeline marked with color-coded video events. Allows user to select a date and time for 
playback. 

Playback Control 
Panel

Provides buttons to control video playback. Includes forward and reverse playback and still image. Also 
provides controls for playback speed and volume.

Playback Zoom 
Control

Provides access to digital zoom features during playback.

Search Control Provides access to the index, thumbnail, POS, and pixel search controls.
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INDEX VIDEO SEARCH
Index search allows a user to search video by events, such as motion detection or alarm activation. Events are listed chronologically and by type. 
To ensure the proper camera channel is selected, check the camera information box above the playback timeline or verify that the desired view 
panel is framed with a thin red outline. Index video can also be displayed in full screen view. For information about displaying playback video in 
full screen view, refer to Displaying Index Search Video in Full Screen View on page 30.

To search video by motion or alarm events:

1. On the DX8100 toolbar, click the Search button .

2. On the DX8100 Search control, click the Search button .

3. On the DX8100 toolbar, click a view panel division button. 

4. From the Site Tree, drag the camera channel you want to search onto one of the view panels. 

5. Click the view panel of the channel you want to search. 

6. From the drop-down box on the playback timeline, select the day you want playback to begin.

7. Select the event type you want to view from the event type drop-down box. 

Only events recorded for the selected camera are listed in the index. A sensor event is identical to an alarm event. Options are as follows:

• All
• None
• Motion
• Alarm in
• ATM/POS
• Video Loss

8. Select an event from the index.

9. Verify that the “Select all” check box is selected. Deselecting the “Select all” check box will disable playback for all view panels except the 
channel being searched.

The DX8100 allows you to view playback on multiple cameras in addition to the camera being searched. This feature is valuable if you want 
to examine a variety of views recorded at the time a certain event was detected.
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10. On the playback control, click the Forward button  to begin viewing. 

Figure 48. DX8100 HVR Index Search Screen

THUMBNAIL VIDEO SEARCH
Thumbnail search allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a series of thumbnail 
images. Each thumbnail represents the first image recorded during a specified period of time. Thumbnails can be expanded and collapsed to 
represent hourly, 10-minute, and 1-minute intervals.

The DX8100 allows sharing of time range search settings between the Thumbnail and Pixel search mode. In this case, if you initiate a Thumbnail 
search, you can select a preview clip and initiate a Pixel search. The Pixel search mode is based on the same time criteria as the preview 
Thumbnail clip.

To visually search video using thumbnail images:

1. On the DX8100 toolbar, click the Search button . 

2. On the DX8100 Search control, click Thumbnail Search button .

3. Select a camera from the Site Tree.

4. From the drop-down box, select the date on which you want to begin your search.

5. Click the thumbnail for the hour you want to begin searching.
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6. Click the Expand button  to change the thumbnail time range to shorter intervals, or click the Collapse button  to change the 

thumbnail time range to longer intervals.

• Click the Expand button  to change from 1-hour intervals to 10-minute intervals.

• Click the Expand button  again to change from 10-minute intervals to 1-minute intervals.

• Click the Collapse button  once to change from 1-minute intervals to 10-minute intervals.

• Click the Collapse button  again to change from 10-minute intervals to 1-hour intervals.

7. Click the thumbnail of the interval you want to search.

8. Click the Forward button  to view video.

Double-clicking a thumbnail image will enlarge the image and begin playback.

9. Click  to return to thumbnail images.

Figure 49. DX8100 HVR Thumbnail Search Screen
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POS SEARCH
The DX8100 allows a user to search any 24-hour period of recorded POS video and data. To record ATM/POS video and data, the ATM/POS 
devices and DX8100 must first be connected and configured as follows:

• Connect the ATM/POS devices to the DX8100.

• Set up camera-to-ATM/POS device linking. 

• Configure the DX8100 ATM/POS settings for each attached ATM/POS device.

• Start an ATM/POS transmittal and verify that the DX8100 is receiving the ATM/POS video and data.

For information about setting up the DX8100 for ATM/POS applications, refer to the following sections:

• Linking Relay Outputs to ATM/POS Events on page 135

• Linking Cameras to Record in Response to ATM/POS Events on page 137

• Linking Presets and Patterns to ATM/POS Events on page 141

• Verifying the ATM/POS Communication Connection on page 196

• Setting UP ATM/POS Device Properties on page 180

This section describes how to use the POS search feature and includes the following topics:

• Understanding the POS Search View

• Searching and Displaying POS Data by Device Name on page 85 

• Searching by POS Transaction Number on page 87 

• Searching for All Transactions with Exceptions on page 88

• Searching for Transactions That Satisfy Specific Exceptions on page 89 

• Searching for Transactions by Line Item on page 90 

• Searching for Transactions by Action Code on page 91

UNDERSTANDING THE POS SEARCH VIEW
To enter the POS Search mode:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button . The POS search view is displayed.
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Figure 50 shows the parts of the POS search view.

Figure 50. POS Search View
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Table Y describes the parts of the POS search view.

Table Y.  Parts of the POS Search View (1 of 2)

Item Part Description

Date Date range for which to search the video and data. 

Time Time range based on a 24-hour time period for searching POS events.

Transaction 
Information

Allows POS search by transaction information options as follows:

• Device name: The ATM/POS device linked to a specific camera. In this case, selecting a camera linked to an 
ATM/POS device automatically inserts the name of the ATM/POS device in the Device Name box. 

• Transaction Number: A number assigned by the ATM/POS device that is printed on the sales are 
transaction receipt.

Data Information Allows POS search by data information options as follows:

• Transaction with Exception Only: Finds all transactions for which an exception is defined.

• Line Item: Allows you to search POS data by a specific transaction line item, based on the following 
guidelines: 

– Line item entries are not case sensitive. Enter lower or uppercase characters. 
– Specify the asterisk (*) wildcard. 
– Search by a single word or multiple words appearing in a transaction line. 
– Type the first few characters of the first word appearing in the transaction and the wildcard. For example, 

type sma* for a line item containing the entry “small orange juice.” The search returns all transactions that 
contain the word “small.”

– Type the first few characters of the second word in a transaction and the wildcard. For example, type ora* 
for a line item containing the entry “small orange juice.” The search returns all transactions that contain the 
word “orange.”

– Search by abbreviation. For example type 6-pk, for a line item containing the entry “Soda 6-pk.” The search 
returns all transactions that contain the abbreviation “6-pk.”

• Action Code: A two-letter abbreviation designating a specific action code. For information about action 
codes, refer to Setting UP ATM/POS Device Properties on page 180.

• Exception Code: A predefined transaction filter used to detect a specific data structure within the ATM/
POS transaction data. For information about exceptions, refer to Setting Up ATM/POS Exceptions on 
page 191.

Start and Stop Start: Initiates a search event.

Stop: Ends a search event.

POS Search Table Lists the data discovered in response to the POS options selected for the transaction and data information.

• Channel number: From 1–16.

• Device name: By default, ATM/POS01 to ATM/POS16. The device name can be changed.

• Transaction number: Number assigned by the ATM/POS device to the transaction data.

• Date/Time: Date and time transaction is recorded.

• Exception: Yes if an exception filter is active for the transaction data has an exception. No if the transaction 
does not have an exception filter.

The transaction and data information are based on the ATM/POS configuration settings derived from the 
following:

• Data format 

• ATM/POS exceptions 

• Exception action codes

For information about setting up ATM/POS transaction and data options, refer to Setting UP ATM/POS Device 
Properties on page 180.
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SEARCHING AND DISPLAYING POS DATA BY DEVICE NAME
You can perform a general search for POS transaction data record for a particular ATM/POS device and its associated camera. Use the date and 
time and ATM/POS device name as the search criteria. The search results contain all POS transactions recorded for that device according to the 
specified date and time.

Searching POS Data by Device Name
To search POS transaction data by ATM/POS device name:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button . The POS search view is displayed. 

3. To select a channel, in the DX8100 Site Tree, click a camera that is linked to an ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name box. In this case, the 
Device Name box is deselected.

4. Select the date and time for the POS search event as follows:

a. Select the Start date.

b. Select the End date.

c. Select the End time.

d. Select the Start time.

5. In the Transaction Information section, click the check box to select Device Name. The Device Name box is available.

6. Verify that the ATM/POS device name displayed in the Device Name box is the correct device for the search.

Data Window Area where recorded transaction data is displayed.

Data Overlay Box The function is not supported at this time.

Video Window Area where live and playback (recorded) video is viewed. Playback video is started at the date and time specified 
for the respective transaction data as shown in the POS Search table. The DX8100 playback controls are used to 
view playback video.

Table Y.  Parts of the POS Search View (2 of 2)

Item Part Description
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7. Click Start Search. The POS Search Table is populated with POS transaction data.

Figure 51. POS Transaction Search by Device Name

Displaying POS Data Discovered by Device Name
To display a POS transaction and its associated video:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button . The POS search view is displayed.

3. Perform a POS search by device name. For information about performing a search by ATM/POS device name, refer to Searching POS Data 
by Device Name on page 85. 

4. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

5. On the playback control, click Play. The video recorded for the selected POS transaction is played back and is displayed in the Video 
window.
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6. Use the playback control to stop or pause playback, reverse playback, and so forth.

Figure 52. Display a POS Transaction Search by Device Name

SEARCHING BY POS TRANSACTION NUMBER
The DX8100 allows you to search for a POS event by transaction number. You must specify the channel, date, and a time window in which the 
transaction is recorded. 

To search for a POS event by transaction number:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button . The POS search view is displayed.

3. To select a device name, do one of the following:

• In the DX8100 Site Tree, click a camera that is linked to an ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name box. In this case, 
the Device Name box is deselected.

• In the Transaction Information section, click the check box to select Device Name. When the Device Name box is enabled, type the 
ATM/POS device name in the box.

4. Set the date and time range you want to search for the transaction number.

5. In the Transaction Information section, click the check box to select Transaction Number. The Transaction Number box is available.

6. In the Transaction Number box, type the transaction number.

7. Click Start Search. If the channel, date, time, and transaction number are valid, the POS transaction is displayed in the POS Search Table.

8. In the POS Search Table, click a transaction entry. The transaction data is displayed in the Data window.

�
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9. On the playback controls, click the Forward button. The video recorded for the transaction is displayed in the Video window.

Figure 53. Searching an POS Event by Transaction Number

SEARCHING FOR ALL TRANSACTIONS WITH EXCEPTIONS
The DX8100 allows you to search for transactions that meet conditions defined by one or more exceptions. In this case, you must configure your 
search criteria based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transactions were recorded.

To use an exception to search transaction data, the exception must be created before recording the transaction data. If the transaction data is 
recorded before the exception filter is defined, the exception filter will not find the data structure within the transaction data.

To search for only POS events by transaction with exception:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button . The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

• In the DX8100 Site Tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name box. In this case, 
the Device Name box is deselected.

• In the Transaction Information section, click the check box to select Device Name. When the Device Name box is enabled, type the 
ATM/POS device name in the box.

4. Set the date and time range for the search.

5. In the Data Information section, click the check box to select Transaction with Exception Only. The Exception Code check box is available. 

6. Click Start Search. If the device name/channel, date, and time are valid, and if transactions with exceptions were recorded during the time 
range, the transactions are displayed in the POS Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.
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8. On the playback controls, click the Forward button. The video recorded for the transaction is displayed in the Video window.

Figure 54. Searching for Transaction with Exception Only Events

SEARCHING FOR TRANSACTIONS THAT SATISFY SPECIFIC EXCEPTIONS
The DX8100 allows you to search for and display ATM/POS transactions that meet conditions as defined by one or more exceptions. You can use 
specific exception codes to define the search criteria. To use an exception to search transaction data, the exception must be created before 
recording the transaction data. If the transaction data is recorded before the exception filter is defined, the exception filter will not find the data 
structure within the transaction data.

The search criteria is based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transactions were recorded.

• Exception code: The predefined transaction filter used to detect a specific data structure within the ATM/POS transaction data.

To search for transactions that meet specific exceptions:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button . The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

• In the DX8100 Site Tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name box. In this case, 
the Device Name box is deselected.

• In the Transaction Information section, click the check box to select Device Name. When the Device Name box is enabled, type the 
ATM/POS device name in the box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Transaction with Exception Only. The Exception Code check box is available. 

b. Click the check box to select Exception Code. The Exception Code box is available.

c. Type the exception code in the box.
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6. Click Start Search. If the device name/channel, date, and time are valid, and if transactions with exceptions were recorded during the time 
range, the transactions are displayed in the POS Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

Figure 55. Transactions that Satisfy Specific Exception Filters

SEARCHING FOR TRANSACTIONS BY LINE ITEM
The DX8100 allows you to search for and display ATM/POS transactions that contain a unique line item. Use the asterisk (*) as a wildcard 
character to substitute for zero or more characters. 

The search criteria is based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transaction(s) were recorded.

• Line item: The line item has the following guidelines:
– Line item entries are not case sensitive. Enter lower- or uppercase characters. 
– Specify the asterisk (*) wildcard. 
– Search by a single word or multiple words appearing in a transaction line. 
– Enter the first few characters of the first word appearing in the transaction and the wildcard. For example, type sma* for a line item 

containing the entry “small orange juice.” The search returns all transactions that contain the word “small.”
– Enter the first few characters of the second word in a transaction and the wildcard. For example, type ora* for a line item containing 

the entry “small orange juice.” The search returns all transactions that contain the word “orange.”
– Search by abbreviation. For example, type 6-pk for a line item containing the entry “Soda 6-pk.” The search returns all transactions that 

contain the abbreviation “6-pk.”

To search for transactions that contain a unique line item:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button .The POS search view is displayed.
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3. To select a ATM/POS device, do one of the following:

• In the DX8100 Site Tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name box. In this case, 
the Device Name box is deselected.

• In the Transaction Information section, click the check box to select Device Name. When the Device Name box is enabled, type the 
ATM/POS device name in the box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Line Item. The Line Item box is available. 

b. Type the name of the line item in the box.

6. Click Start Search. If the device name/channel, date, and time are valid, transactions containing the line item are displayed in the POS 
Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.
 

Figure 56. Transactions that Contain a Unique Line Item

SEARCHING FOR TRANSACTIONS BY ACTION CODE
The DX8100 allows you to search for and display ATM/POS transactions by action code. To use an action code to search transaction data, the 
action code must be created before recording the transaction data. If the transaction data is recorded before the action code is defined, the 
action code will not find the data structure within the transaction data.

The search criteria is based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transaction(s) were recorded.

• Action code: The special two-character filter that defines a specific transaction event.

To search for transactions by action code:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the POS Search button . The POS search view is displayed.
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3. To select a ATM/POS device, do one of the following:

• In the DX8100 Site Tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name box. In this case, 
the Device Name box is deselected.

• In the Transaction Information section, click the check box to select Device Name. When the Device Name box is enabled, type the 
ATM/POS device name in the box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Action Code. The Action Code drop-down box is available. 

b. In the Action Code drop-down box, select an action code. 

For information about action codes, refer to Using Action Codes on page 192.

6. Click Start Search. If the device name/channel, date, and time are valid, transactions containing the line item are displayed in the POS 
Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

Figure 57. Searching Transactions by Action Code
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PIXEL VIDEO SEARCH
The DX8100 allows a user to automatically search any 24-hour period of recorded video for changes in screen pixels. This feature can be 
configured to identify motion events even when motion detection has not been enabled on a camera.

The DX8100 allows sharing of time range search settings between the Thumbnail and Pixel search mode. If you initiate a Thumbnail search, you 
can select a preview clip and initiate a Pixel search. The Pixel search mode is based on the same time criteria as the preview Thumbnail clip.

This section describes how to search video by changes in screen pixels and includes the following topics:

• Searching Video Based on Changes in Screen Pixels on page 93

• Viewing a Video Thumbnail on page 95

SEARCHING VIDEO BASED ON CHANGES IN SCREEN PIXELS
DX8100 pixel video search is accomplished in two steps:

• Searching recorded video for changes in screen pixels. 

After the search has been completed, the DX8100 displays a series of thumbnails below the search grid. Each thumbnail contains the first 
image of recorded video for the specified date and time range period. 

NOTE:  A pixel search might not detect obvious movement. 

• Viewing the thumbnails. 

For information about how to view the video thumbnail, refer to Viewing a Video Thumbnail on page 95.

To search video by analyzing changes in screen pixels:

1. On the DX8100 toolbar, click the Search button .

2. On the Search control, click the Pixel Search button .

3. Select a camera from the Site Tree.

4. From the drop-down box, select the date on which you want to begin your search.

5. Select the start and end times to define your search range.

6. Using your mouse, highlight the areas on the grid that you want to search for pixel changes.

• Hold down the left mouse button and drag to select areas.
• Hold down the right mouse button and drag to clear areas.

7. Adjust the pixel sensitivity threshold. Moving the slider to the left decreases sensitivity and moving it to the right increases sensitivity.

8. Click Start. Wait for the progress line on the status bar to return to Ready.
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9. Use the  icon to show and hide the pixel grid for a clearer view in the search screen.

Figure 58. Pixel Search Screen
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VIEWING A VIDEO THUMBNAIL
After the search has been completed, a series of thumbnails appear on the screen below the search grid. Each thumbnail contains the first image 
of recorded video for the listed time period.

• Double-clicking a thumbnail will cause it to begin playing.

• Click the Prev button  and the Next button  to move backward and forward through thumbnails. 

To view a video thumbnail:

1. Click a thumbnail. The thumbnail’s search parameters (date and time) are displayed below the search grid. The thumbnail’s search start 
time is a few seconds ahead of the search start time you entered.

Figure 59. Thumbnail Images Marking Pixel Changes

2. To locate playback at the start of the first image, click Reverse playback button . The video scene is played back and displayed in 
reverse. 

3. Click the Pause button  to pause the video playback when the beginning of the first recorded is reached.

4. Click the Forward button . Playback starts and the video scene is displayed.

5. Click the Clear button  to remove the thumbnail results.

�
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WORKING WITH SPECIAL VIEW AND SEARCH METHODS
The DX8100 allows you to do the following:

• View video in the deinterlaced mode.

• View live and playback video simultaneously.

• View, search, export, and print backed up video. You must use the DX8100 Client application to view, search, export, and print backed up 
video. For more information, refer to the DX8100 Client Application manual.

This section describes how to use special view and search methods and includes the following topics:

• Viewing Video in the Deinterlaced Mode 

• Viewing Live and Playback Video Simultaneously 

VIEWING VIDEO IN THE DEINTERLACED MODE
Images recorded at 4CIF at a low frame rate per second might move or tear. In this case, you can use the View menu’s Deinterlaced Image option 
to enhance the displayed image. In the deinterlaced mode, the DX8100 converts the recorded image and displays it at 2CIF resolution. The 
process removes one of the 4CIF interlaced fields (even or odd) from the 4CIF recorded image to arrive at 2CIF resolution for the displayed image. 
The original image is retained at the recorded 4CIF resolution. 

For exported images, the DX8100 provides a global option for enabling a deinterlacing filter. In this case, the selected channel’s image is 
exported at 2CIF resolution. This setting is effective for all channels and cannot be set for individual channels. For more information about 
enabling the denaturalizing filter, refer to Enabling the Deinterlacing Filter on page 101.

To view video using the deinterlaced option:

1. Click the Forward button  to start video playback.

2. On the menu bar, click View > Display deinterlaced image.

VIEWING LIVE AND PLAYBACK VIDEO SIMULTANEOUSLY
The DX8100 allows simultaneous viewing of live and playback video from a single camera source.

To view live and playback video from the same camera:

1. On the DX8100 toolbar, click the Live button . 

2. Drag a camera from the Site Tree to a view panel.

3. Click the Forward button  to begin playback.

4. Drag the same camera from the Site Tree onto a different view panel while video is playing.
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Exporting Video
Users with export access rights (Power Users and Administrators by default) can export sections of prerecorded video to magnetic or optical 
media. The DX8100 must be in the Playback or Search mode to export video. You cannot access Export in Live mode. To export video or still 
images to a CD-R/RW or DVD-R/RW, you must have Nero® Express 7 Essentials software installed on the DX8100 HVR.

This section describes how to export video and includes the following topics:

• Exporting Bookmarked Video Regions 

• Inserting and Removing a USB Flash Drive on page 100

• Enabling the Deinterlacing Filter on page 101

• Mapping and Disconnecting a Network Drive on page 101 

• Performing the Export on page 102

• Stopping an Export While in Process on page 108 

EXPORTING BOOKMARKED VIDEO REGIONS
You can bookmark multiple regions of video along the timeline for export. Bookmarked regions are designated with start point and end point 
bookmarks. Multiple regions can be bookmarked along a single 24-hour timeline, but only a single channel can be exported at a time. 
Bookmarked regions are listed in the Export Video dialog box at the time of export. 

Table Z describes the bookmark controls.

CREATING BOOKMARKS
To select a region to export:

1. Make sure the HVR is in Playback or Search mode by clicking the Live button  or the Search button . 

2. Click the Forward button  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Select a camera from the Site Tree.

4. Locate the timeline slider at the beginning of the range you want to bookmark. 

You can use the drop-down box and spinner buttons above the timeline to locate a bookmark.

Table Z.  Bookmark Controls

Button Command Description

Add Bookmark Does the following:

• Adds a red bookmark flag to mark the beginning of a start point.

• Adds a gray bar to indicate the range between the start point and end point.

Remove Bookmark Removes the selected bookmark.

Remove All Bookmarks Removes all bookmarks.
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5. Click . A red bookmark flag appears on the timeline.

Figure 60. Setting a Starting Bookmark

6. Locate the timeline slider at the end of the range you want to bookmark.

7. Click the Add Bookmark button . The bookmark flag and the region between bookmarks turn gray.

Exporting a bookmarked region of video requires start and end bookmarks. If only one bookmark is set, video will not be marked for export.

8. Repeat steps 4-7 for each additional region you want to bookmark for that camera.

9. Click the Forward button  if you are in Live mode, or proceed to step 8 if you are in Search mode.

10. Click the Export button  and follow the directions in Performing the Export on page 102.

CLEARING BOOKMARKS
This section describes how to clear bookmarks and includes the following topics:

• Clearing a Single Bookmark on page 98

• Clearing All Bookmarks on page 98

Clearing a Single Bookmark
To clear a single bookmark:

1. Select a bookmark flag from the timeline. The bookmark flag should change to a light green color.

2. Click the Remove Bookmark button  to remove the selected bookmark.

Figure 61. Removing a Single Bookmark

Clearing All Bookmarks
To clear all bookmarks:

• Click Remove All Bookmarks.

� 	
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BOOKMARKING AND EXPORTING MULTIPLE CHANNELS
The DX8100 allows you to bookmark a video region for one camera and apply that book marked time window to multiple channels. This feature is 
used in conjunction with the export feature. For example, if you want to export video recorded between 9:00 a.m. and 9:05 a.m. for multiple 
cameras, you set the bookmarks for camera 1 at 9:00 a.m. and 9:05 a.m. During the export process you can associate that same bookmarked time 
window with multiple cameras.

To book mark data and export video for multiple channels:

1. On the DX8100 toolbar, click the Search button . This ensures that the HVR is in the Search mode. 

2. Select a camera from the Site Tree.

3. Locate the timeline slider at the beginning of the range you want to bookmark. 

You can use the drop-down box and spinner buttons above the timeline to locate a bookmark.

4. To create book marks, do the following:

a. Click the Expand Bookmark button . A red bookmark flag appears on the timeline.

b. Locate the timeline slider at the end of the range you want to bookmark.

c. Click Expand Bookmark button . The bookmark flag and the region between bookmarks turn gray.

Exporting a bookmarked region of video requires start and end bookmarks. If only one bookmark is set, video will not be marked for 
export.

d. Repeat steps 3 and 4 for each additional region you want to bookmark for that camera.

Figure 62. Book Marking Multiple Time Regions

5. Click click the Export button . The Export Video dialog box opens.

6. Do the following:

a. Right click the time range you want to assign to multiple channels. The Duplicate Bookmark submenu is displayed.

Figure 63. Selecting a Time Range for Duplication

b. Click Duplicate Bookmark. The Select Channel dialog box opens.

c. Click the check box for each channel to which you want to assign the book mark region.

d. Click OK. The time range for each selected channel is displayed in the Time Range table. 
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7. Do the following:

a. In the Device panel, click the check box of the desired export device. 

b. Click the check box for each time range you want to export.

8. Click Export.

Figure 64. Selecting the Export Device and Time Ranges

INSERTING AND REMOVING A USB FLASH DRIVE
The DX8100 supports both USB 1.1 and USB 2.0 flash drives. To ensure data is not lost or corrupted when exporting data to a USB flash drive, 
follow the steps listed in Removing a USB Flash Drive on page 100.

This section describes how to insert and remove a USB device and includes the following topics:

• Installing a USB Flash Drive on page 100

• Removing a USB Flash Drive on page 100

INSTALLING A USB FLASH DRIVE
This section describes how to install a USB flash drive. To install a USB flash drive into the DX8100:

1. Insert the USB drive into the USB 2.0 port on the HVR’s front panel.

2. Wait five seconds while the DX8100 recognizes and automatically installs the device.

REMOVING A USB FLASH DRIVE
You can remove a USB device within the DX8100 environment. In this case, you do not have to exit to the Windows environment. 

To remove the USB flash drive from the DX8100:

1. Click > File Unplug/Eject Hardware. The Unplug or Eject Hardware dialog box opens. 

2. Select the USB flash drive in the Hardware devices list.

3. Click Stop. The Stop a Hardware device dialog box opens.

4. Select the USB device.

5. Click OK.

6. Wait for the DX8100 to respond with a message stating that it is safe to remove the USB device from the DX8100. Removing a USB flash 
drive before the DX8100 acknowledges that it is safe to do so, might result in lost or corrupted data.

7. Remove the USB flash drive. 

WARNING: Improperly removing a USB drive can cause data to be lost or corrupted.
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ENABLING THE DEINTERLACING FILTER
Images recorded at 4CIF at a low frame rate per second might move or tear. The DX8100 provides a global option for enabling deinterlacing 
filtering to enhance the exported image for 4CIF recorded channels. In this case, the exported image is converted to 2CIF resolution. This setting 
is effective for all channels, and cannot be set for enabling individual channels. For more information about viewing video in the deinterlaced 
mode, refer to Viewing Video in the Deinterlaced Mode on page 96.

To enable the deinterlacing filter:

1. Make sure the HVR is in Playback or Search mode by clicking the Live button  or the Export button . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

4. From the Export Format area, select the “Enable deinterlacing filter” check box.
. 

Figure 65. Enabling the Deinterlacing Filter from the Export Video Dialog Box

MAPPING AND DISCONNECTING A NETWORK DRIVE
You can export sections of prerecorded video to a network drive. The DX8100 allows you to map to or disconnect from a network drive. In this 
case, you must use the IP address of the target drive. The DX8100 allows you to use the host name of the target device. To do so, you must 
enable NetBIOS option in the Windows environment. You need to know what letters are already assigned to drives and the path to the folder you 
want to map.

This section describes how to map to and disconnect from a network drive, including the following topics:

• Mapping a Network Drive

• Disconnecting a Network Drive 

MAPPING A NETWORK DRIVE
To map a network drive: 

1. Make sure the HVR is in Playback or Search mode by clicking the Live button  or the Export button . 

2. Click the Forward button  if you are in Live mode, or proceed to step 3 if you are in Search mode. Click the Export button . 
The Export Video dialog box opens.

3. Click Map NetDrv. The Map Network Drive dialog box opens asking for a drive letter and path.

4. In the Drive drop-down box, select a drive letter that is not being used.

5. Type the path in the Folder drop-down box. (For example, type \\IP_address_of_server\folder_name.)

6. (Optional) Click the “Reconnect at logon” box if you do not want the mapped drive to remain connected each time you logon. 
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7. Click Finish. The newly mapped drive is added as a remote drive and is displayed in the Device area. The mapped drive can now be 
accessed just like a local drive.

Figure 66. Export Video Dialog Box

DISCONNECTING A NETWORK DRIVE
To disconnect a network drive:

1. On the DX8100 toolbar, click the Search button . The DX8100 is in the Search mode.

2. Click the Export button . The Export Video dialog box opens.

3. Click Disconnect NetDrv. The Disconnect Network Drive dialog box opens.

4. Select the network drive that you want to disconnect.

5. Click OK. The drive is disconnected and removed from the Export Video dialog box Device area.

PERFORMING THE EXPORT
This section describes how to export data and includes the following topics:

• Starting an Export Process

• Changing a Bookmarked Time Range on page 104

• Assigning a Custom Export Video File Name on page 104

• Selecting the Export Format on page 106

• Exporting a Sequence of Still Images on page 107

• Finalizing an Export Process on page 108

• Stopping an Export While in Process on page 108

• Working with DX8100 backed up Video on page 109

STARTING AN EXPORT PROCESS
To start the export process:

1. Make sure the HVR is in Playback or Search mode by clicking the Live button  or the Export button . 

2. Click the Forward button  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click the Export button . The Export Video dialog box opens.

4. Click the plus (+) sign next to a drive in the Device list. Available devices are indicated by a check box to the left of the device name.
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5. Select the check box of the desired device. If you choose a remote device, select the drive and folder path where you would like to store the 
exported file. You can also click the Browse button to access the file system for the appropriate folder. 

If your DX8100 is connected to a network that supports shared folders and drives, you can map a network drive from within the Export Video 
dialog box. For more information, refer to Mapping and Disconnecting a Network Drive on page 101.

Table AA describes the available devices.

6. Select the check box of the video time range you want to export. You can export multiple time ranges simultaneously. For more information, 
refer to Changing a Bookmarked Time Range on page 104.

7. Click in the File Name box, and then type the file name for each selected video time range. You can accept the default file name assigned to 
the time range. For more information, refer to Assigning a Custom Export Video File Name on page 104.

8. Select the export format. For more information, refer to Selecting the Export Format on page 106.

9. Click Export. 

Figure 67. Exporting Selected Video

Table AA.  Available Backup Space

Type Description

Optical drives The DX8100 supports the following drives:

• CD-R

• DVD-R

Hard disk drives The hard disk drive can be any of the following:

• Local drives

• Remote drives

Removable drives USB flash drives
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CHANGING A BOOKMARKED TIME RANGE
To change a bookmarked time range or create a new time range to be exported:

1. Select the desired row in the Time Range table.

2. Double-click the Start Day field, and then use the spinner buttons to set the start date for the export.

The start days and times cannot be set later than end days and times.

3. Double-click the Start Time field, and then use the spinner buttons to set the start time for the export.

4. Double-click the End Day field, and then use the spinner buttons to set the end date for the export.

5. Double-click the End Time field, and then use the spinner buttons to set the end time for the export.

6. Select the check box next to each time range you would like to export.

Figure 68. Export Time Range

ASSIGNING A CUSTOM EXPORT VIDEO FILE NAME
By default, the DX8100 assigns a file name to each time range. When the video channel selected is exported, the file is assigned the name 
appearing in the Name column.

Figure 69. Default File Names

�
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The default filename is constructed from the information displayed in the Start Day, Start Time, End Day, and End Time columns. 

To assign a custom file name for a time range:

1. Verify that the check box of the row you want to rename is selected.

2. Enter a file name for the file you want to export. (Export file names follow standard Windows file-naming conventions.)

3. Click Apply. The Apply button updates the Name field.

Figure 70. Renaming Export Time Ranges
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SELECTING THE EXPORT FORMAT
The DX8100 allows you to select the export format. Table AB describes the available export formats.

• Native format: When exporting video in the native format, the DX8100 embeds a digital watermark in the video stream for the purpose of 
authentication. Watermarking ensures that an image has not been edited or damaged after it has been recorded. The watermark is an 
encrypted, digital signature embedded in the video stream during the compression stage, protecting the video from the moment of creation. 
The DX8100 Viewer software is capable of reading a DX8100 watermark and verifying the originality of the video.

• AVI or ASF format: Video exported in AVI or ASF format can be viewed using standard viewer software such as Windows Media Player.

NOTE: Refer to the DX8100 product specification or DX8100 Client Operation/Configuration manual for recommended computer 
requirements for playing back exported video.

When exporting video in the native format to a CD or DVD device, the DX8100 will automatically include the DX8100 Viewer application 
along with the video. This viewer is designed to play a variety of still image, video, and audio media formats, including the native DX8100 
format. The DX8100 Viewer application will automatically run each time a CD or DVD created by the DX8100’s export feature is inserted 
into a Windows-based computer. To ensure that the viewer software runs automatically after the disk has been inserted, verify that the 
auto-run feature of your computer’s optical drive has not been disabled.

To select the export format:

• From the Export Video dialog box, select the radio button of the file format you want to export. 

Table AB.  Export Formats 

Format Description

AVI Saves video sequence as a standard Windows video format.

ASF Saves video sequence as a standard Windows media file.

Native Saves video sequence using Pelco’s engineered compression format. Native format provides increased compression 
and smaller file sizes.

BMP Saves a still image file in standard Windows bitmap format. Only the first frame of the video sequence is saved.

JPEG Saves a still image file in JPEG format. Only the first frame of the video sequence is saved.

TIF Saves a still image file in TIF format. Only the first frame of the video sequence is saved
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EXPORTING A SEQUENCE OF STILL IMAGES
Still image formats export the first frame of a bookmarked region, and then a single frame for each time interval until the number of images 
specified has been exported. For example, consider exporting a six-hour bookmarked region of video with an image count of 100 and a time 
interval of 3 seconds. The resulting export will include the first frame of the bookmarked region followed by 99 additional images taken at three 
second intervals. The first exported image will be the first frame of the bookmarked region and the last image will be the frame taken at 
300 seconds into the bookmarked region.

To export a sequence of still images:

1. Select a still image format. Options are BMP, JPEG, and TIF.

2. Select the number of images (1-999) you want to save in the sequence.

3. Select the time interval between each saved image in the sequence. Options are as follows:

• Continuous
• 0.5 seconds
• 1 second
• 2 second
• 3 second
• 4 seconds
• 5 seconds

Figure 71. Still Image Export Formats
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FINALIZING AN EXPORT PROCESS
This section describes how to finalize an export process. The following guidelines are applicable:

• Audio export is available only with DX8100 native, AVI, and ASF video formats.

• Real Time setting applies only to DX8100 native, AVI, and ASF video formats.

• When the Real Time check box is selected, the DX8100 will export video so it can be played back in real time (30 fps) for the same length of 
time as the original recording. For example, if video was recorded at 1 fps, this means the DX8100 will insert 29 null frames for every 
one frame of actual video. Thus, one minute of video recorded at 1 fps (60 frames total) will play back for one minute at 30 frames per 
second (60 frames of actual video interspersed with 1,740 null frames). If the Real Time check box is not selected, one minute of video 
recorded at 1 fps will play back in two seconds in real time. 

Figure 72 illustrates the two video streams: 1) one padded with null frames to match the actual time duration and 2) another stream without 
null frames.

Figure 72. Real Time Versus Non-Real Time Export

To finalize the export process:

1. Make sure that the export media selected is inserted in the drive unit that the drive is ready. 

2. In the Time Range table, click selection box for each backed-up video time range you want to export.

3. In the Export Format section, do the following:

a. Click the Audio Record check box to include recorded audio.

b. Click the Real Time check box to export video using standard clock time. 

4. Click Export to export video data.

STOPPING AN EXPORT WHILE IN PROCESS
Once an export operation has begun, a user can easily stop it by interrupting or canceling the operation from the Export menu on the main or 
search screens. Interrupting an export simply stops the progress of the export while keeping all current video information intact. Canceling an 
export will delete any video data exported during the operation, as well as end the export itself.

This section describes how to stop an export process and includes the following topics:

• Retaining Video When Stopping an Export Process

• Deleting Video Data When Stopping an Export Process

Retaining Video When Stopping an Export Process
To halt an export that is in process while retaining current video data stored:

• From the DX8100 menu bar, choose Export > Interrupt Export.

Deleting Video Data When Stopping an Export Process
To halt an export that is in process and delete any current video data stored:

• From the DX8100 menu bar, choose Export > Cancel Export.

u
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WORKING WITH DX8100 BACKED UP VIDEO
The DX8100 allows you to view, search, export, back up, and print backed up video. To do so, you must use the DX8100 Client application.

For more information about viewing backed up video, refer to Viewing and Searching Backed Up Video in the Client Applications Help or the 
Client Applications manual. 
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Logs and Health Status
This section describes how to work with the system log and system health status feature and includes the following topics:

• Viewing Logs from the Application Window

• Viewing System Health Status on page 112

VIEWING LOGS FROM THE APPLICATION WINDOW
You can access the system logs from the application window or from the System setup page. For information about working with logs from the 
System setup page, refer to Using System Logs on page 222. 

NOTE: The UPS area is reserved for future use.

To access system logs:

1. From the DX8100 menu bar, click View > Log. A submenu is displayed listing the various commands.

Figure 73. Accessing Log Commands from the Application Window

2. From the submenu, click a command. The Log View dialog box opens. If there are no log events for the specific log command you selected, 
the Log View message box is displayed.

Figure 74. Log View Dialog Box_C2630MB

3. Click OK. 

4. In the Period section, do the following:

a. Click the Start Date drop-down arrow, and then select a start date.

b. Click the End Date drop-down arrow, and then select an end date.

Figure 75. Period Start and End Dates
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5. Do one of the following:

• Search by user ID: Click User and type the user’s login ID in the text entry box.
• Search by system state: Click System State, and then click the drop-down arrow to select a log.

6. Click Start Update. If the system logged events for search criteria, those events are displayed in the Log View window.

Figure 76 shows all the events that occurred for user ID Admin.

Figure 76. User ID Log Events

Figure 77 shows the log events that occurred for System On/Off.

Figure 77. System On/Off Log Events

7. To save the log search results to a file, do the following:

a. Click Save As. The DX8100 Save As Log Info dialog box opens.

b. Select a destination folder, and then type the name of the file.

c. Click Save. The file is saved.

8. Do one of the following:

• To remain in the Log View dialog box and run another report, click Clear.
• To exit the Log View dialog box, click OK.
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VIEWING SYSTEM HEALTH STATUS
The system health feature allows you to view the health status and configure low and high operating thresholds for various system devices. If a 
threshold is exceeded, the system displays an alert notification. You can elect to open a subsequent event log, which provides a more detailed 
description about the event. The system devices are as follows:

• CPU temperature

• Fan speed

• Power supply status

• Self-Monitoring Analysis and Reporting Technology (SMART) for hard disk drive status

• Network information

• Uninterruptible power source (UPS) status when connected

NOTE: The UPS area is reserved for future use.

An alert notification also appears on the remote client computer. For this to occur, the remote client must be connected to the server to receive 
the notification.

WORKING WITH SYSTEM HEALTH STATUS VIEW
To access the System Health dialog box: 

1. From the DX8100 menu bar, click View > System Health View. 
 

Figure 78. System Health View Submenu

2. On the submenu, select Status View. The System Health dialog box opens. 

Figure 79. System Health Dialog Box

3. To set a threshold for a device/function, do the following:

a. Click the box for the device/function.

b. Enter the value you want.

c. Click Apply.

d. Click Close to exit the dialog box. 
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WORKING WITH SYSTEM HEALTH LOG VIEW
The System Health Log allows you to view a history of the events that have occurred. A calendar function allows you to use a date range to 
display health status events. 

To access the System Health Log:

1. From the DX8100 menu bar, click View > System Health View. 

2. On the submenu, select Log View. The System Health Log opens.
 

Figure 80. System Health Log

3. To display logged events, do the following:

a. In the calendar, click the left and right arrow buttons to select a month.

a. Click the date.

4. To navigation to the data you want to view, do the following:

• Click “Go to today” to display information about the current date. 
• Click “Go to” to advance to subsequent pages.

5. Click OK to exit the System Health Log.
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Setting Up the DX8100
Only a single user with Administrator or Power User access is allowed to access a DX8100’s Setup mode at one time. When connected to a 
network supporting multiple HVRs and clients, users with Administrator access override and block Power Users. If two users with the same 
access level attempt to enter Setup mode simultaneously, the DX8100 will allow access to setup features on a first-come, first-served basis. 
Unavailable setup options will be grayed out.

This section describes the Setup Mode and includes the following topics:

• Accessing the Setup Mode

• Understanding the Setup Dialog Box on page 115

• Camera Setup on page 116

• IP Camera Setup on page 122

• Link Setup on page 132 

• Schedule Setup on page 143 

• Setting Up Network Properties on page 168 

• Data Backup Setup on page 201

• User Setup on page 208 

• Site Setup on page 214 

• System Setup on page 218 

• External Monitor Setup on page 228 

• Emergency Notification Setup on page 235 

• Emergency E-Mail Notification Setup on page 238 

ACCESSING THE SETUP MODE
The Setup Mode is accessed from the DX8100 toolbar by clicking the Setup icon. When clicked, the Setup icon opens the Setup dialog box in the 
DX8100 view panel. Major configuration categories are displayed on individual tabbed pages. Each configuration page contains all of the options 
and parameters for the respective functions, which allows you to customize how the DX8100 operates for your particular application. To access a 
setup page, click the icon displayed on the right side of the view panel.

The Setup dialog box allows Administrators and Power Users access to the DX8100’s setup functions. However, only Administrators can define 
user names and passwords for new users.

To access the Setup Mode, click the Setup button  on the DX8100 toolbar. The Setup dialog opens to the Camera page.

To access a Setup page, click a setup button in the DX8100 Setup dialog box. The selected setup page appears.

For information about the Setup dialog, refer to Understanding the Setup Dialog Box on page 115.
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UNDERSTANDING THE SETUP DIALOG BOX
The Setup dialog box opens in the DX8100 view panel to the default Camera page. You can only view video in the Camera page. You must exit 
the Setup dialog box to access the DX8100 functions in the main window. Figure 81 shows the parts of the Setup dialog.

Figure 81. Parts of the DX8100 Setup Dialog Box

Table AC describes the parts of the Setup dialog.

Table AC.  Parts of the DX8100 Setup Dialog Box

Item Button Part Description

Camera Click the Camera button to configure cameras. Available options are PTZ functions, motion detection, 
picture adjustment, audio, and video loss detection settings.

 
Linking Click the Linking button to configure relays and alarms, associate relays and alarms with cameras, 

link relays to alarms, and link cameras to other cameras.

Schedule Click the Schedule button to build custom recording schedules, set image resolution, frame rate, and 
image quality, and configure relay settings. 

Network Click the Network button to set up the network configuration and communication port settings.

Backup Click the Backup button to configure and perform backups.

User Click the User button to add, delete, or change user accounts.

Site Click the Site Setup button to add, delete, and configure additional DX8100 Series HVRs.

System Click the System button to set up additional system options.

Ext. Monitor Click the Ext. Monitor button to configure an additional display monitor. (This button appears only if 
the optional display card has been installed.)

Notification Click the Notification button to configure emergency agent and e-mail notification options.

�
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��
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CAMERA SETUP
Up to 32 video cameras can be connected to the unit. Only an Administrator or Power User can configure cameras.

This section describes how to setup the camera and includes the following topics: 

• Basic Camera Setup 

• Motion Detection Setup on page 118 

• Audio Setup on page 119 

• Configuring Video Loss Detection on page 121

• Applying Settings to All Cameras on page 122 

• IP Camera Setup on page 122

BASIC CAMERA SETUP
This section describes how to set up an analog camera. For information about setting up an IP camera, refer to IP Camera Setup on page 122.

To set up camera picture and PTZ options:

1. Do one of the following:

• On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

• If the Setup dialog box is already open, click the Camera button . The Camera page is displayed.

2. In the Camera Properties section, do the following:

a. Select a camera from the Selected Channel drop-down box. Alternately, you can click a camera in the Site Tree to select it.

b. Verify that Local Camera is displayed in the associated Selected Channel drop-down box. 

c. (Optional) To disable an analog camera, select Disable in the associated Selected Channel drop-down box.

d. Enter an optional new name in the Camera Name box for the camera. Camera names can be up to 32 characters long and can include 
spaces and special characters. The Camera Name box cannot be left blank or have any spaces. If a valid name is not entered in the 
Camera Name box when you click Apply, the previous name is displayed. 

e. Set camera security level. The default security levels are as follows:

• None: The camera can be viewed by all users.
• Low: The camera can be viewed by all users except the Guest account. 

NOTE: If you do not want video from a low security level camera to be viewed by the Guest user, set the security level for that 
cameras to medium or higher.

• Medium: The camera can be viewed by users with Standard User access and higher.
• High: The camera can be viewed by users with Power User access and higher.

f. In the Protocol drop-down box, select the appropriate PTZ protocol for the camera, or select No PTZ if the selected camera does not 
support PTZ functions. Some of the supported protocol options are as follows:

• NO PTZ: Disables all PTZ functions for the current camera 
• PELCO-C: Coaxitron
• PELCO-D: Pelco engineered
• PELCO-P: Pelco engineered
• SAMSUNG™ (V2.0)
• PANASONIC®

• VICON®

• KALATEL™

• Honeywell™ (HSD251)
• American Dynamics™

• Phillips® (TC8560, TC700 Series)
• LG® (v1.0)

You must configure one of the RS-422/RS-485 PTZ ports for Spectra for Coaxitron to function. For more information, refer to Setting 
Up RS-422/RS-485 Communication Port Properties on page 180.
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g. Do the following:

(1) In the PTZ Locking Auto-timeout drop-down box, select an appropriate timeout value. Timeout values can be set between five 
and 60 seconds. The default value is 10 seconds.

Because the DX8100 Series HVR is designed to operate in a networked environment, it is possible that multiple users may 
attempt to simultaneously control the PTZ features of a single camera. To minimize potential conflicts, only one user at a time is 
allowed to control the PTZ features of a camera. PTZ control is made available on a first-come, first-served basis. Once a user 
gains control of a camera’s PTZ features, all other users are locked out. All other users must wait until the controls for that 
device have been left idle for the amount of time configured for that camera, as specified in the PTZ Locking Auto-timeout 
drop-down box.

(2) To perform a PTZ test, click Pan-L (left), Pan-R (right), Tilt-U (up), and Tilt-D (down), to verify that the camera responds to PTZ 
commands.

h. Set the selected camera address as follows:

(1) In the Dip Switch Address drop-down box, select an address from the available addresses. If the selected camera’s protocol is 
set to NO PTZ or PELCO-C, the DIP Switch Address drop-down box is unavailable. In this case, the camera’s dip switch setting 
cannot be set using software. 

This option is available for cameras and protocols that support software-configured addresses. Only one address can be 
assigned per camera. The DX8100 displays an error message if you attempt to assign the same address to different cameras. 

(2) To view the camera DIP switch address setting for all attached local cameras, click View. The DIP Switch Address View dialog 
box opens. The assigned DIP switch setting for all attached cameras is displayed.

3. In the Picture Adjustment section, adjust picture properties by moving sliders for Brightness, Contrast, Hue, and Saturation.

As you adjust the picture properties of a camera on the local HVR, changes will be reflected immediately in the view area near the top of 
the screen. Changes made to cameras at a remote site will not appear in the view area until you click Apply.

4. Click Default to return all picture property settings to the normal state.

You can click the Hide/Show button to clear the view area to get a better look at your picture property changes. Refer to step 2 in Motion 
Detection Setup on page 118.

5. Click Apply. 

Figure 82. Camera Page
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MOTION DETECTION SETUP
Up to five motion detection profiles can be defined for each camera. When the DX8100 is set to record motion detection, any motion sensed in 
the selected zone will be recorded on that channel. Motion detection can also be used to trigger relays, PTZ presets, and the recording of 
multiple cameras. Refer to Schedule Setup on page 143 and Link Setup on page 132 for more information. 

To define motion detection profiles for the selected camera:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. To set up the motion grid, do the following:

a. Select the motion zone (1-5) from the drop-down box.

b. Click the Hide/Show button to either hide or display the motion grid. 

c. Move the Number of Blocks slider to change the grid size of the motion overlay.

3. Define the area for motion detection as follows:

a. Click Clear All to remove the currently defined motion detection area.

b. Click Select All to enable motion detection for the entire viewable area.

c. Hold down the left mouse button and drag to select areas.

d. Hold down the right mouse button and drag to deselect areas.

4. In the Motion Detection section, move the Sensitivity slider to adjust motion sensitivity. Moving the slider to the left decreases the 
sensitivity; moving the slider to the right increases the sensitivity. The motion sensitivity window provides a visual indicator that helps you 
set the sensitivity to the correct level, so that erroneous motion events caused by wind or other disturbances are avoided.

• Figure 83 shows the position of the red sensitivity indicator at a low sensitivity setting. In this case, a large motion level is needed to 
cause the green motion indicator to exceed the red sensitivity indicator. 

Figure 83. Low Sensitivity Level

• Figure 84 shows the position of the red sensitivity indicator at a high sensitivity setting. In this case, a low motion level will cause the 
green motion indicator to surpass the red sensitivity indicator.

Figure 84. High Sensitivity Setting Level

• Figure 85 shows the position of the red sensitivity indicator at a medium 50% sensitivity setting (default). In this case, a motion event 
is large enough to cause the green motion indicator to surpassed the red sensitivity indicator.

Figure 85. Adequate Sensitivity Level
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5. Click Apply.

Figure 86. Camera Motion Detection Setup

AUDIO SETUP
The DX8100 server supports two audio configurations: standard audio and optional expanded audio. Both of these configurations allow you to 
configure individual camera channels to listen to and record live audio. You can monitor live audio at a local server or listen to live audio from a 
remote DX8100 server or client system. You can play back audio recorded by a camera channel. For information about listening to live audio at 
the server or client system, refer to Using the KBD300A Keyboard on page 66.

NOTE: Live audio is not supported for IP cameras. 

• Standard audio input: The DX8100 provides two standard audio inputs: Line In (stereo), Mic In (mono), and one audio output. The 
standard audio inputs are available by default if the optional audio option card is not installed. If the optional audio card is installed, the 
standard audio inputs are disabled. 

The standard audio connections are described as follows:

– Line In (stereo): A 2-channel stereo input (left and right channel) allows you to connect up to two external audio sources. You can 
assign a specific camera to record video in association with each audio channel. For example, you can assign camera 2 to the left audio 
channel and camera 32 to the right audio channel. 

– Mic In: Accepts one audio input. You can assign one camera to record video in association with the audio input.
– Audio output: Allows you to connect an audio output device, such as an amplifier, to listen to recorded video and audio 

simultaneously.

• Optional expanded audio input: To use the DX8100 expanded audio feature, the optional DX8100-AUD audio card must be installed. You can 
determine if the audio card is installed by checking the Audio option status in the Channel Information section of the Camera page. The 
Audio status is one of the following:
– Not installed: If the optional audio card is not installed, the Advanced button in the Audio Settings area is available.
– Installed (enabled): If the optional audio card is installed, the Advanced button in the Audio Settings area is not available.

The DX8100 compresses audio data to save space. In this case, recorded audio that may not be of the same quality as live audio. Consult your 
Pelco sales representative for more information regarding the DX8100-AUD option.
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This sections describes how to setup the audio feature and is organized into the following sections:

• Setting Up the Standard Audio Options

• Setting Up the Expanded Audio Options on page 121

• Listening to Live Audio at the Server on page 49

Setting Up the Standard Audio Options
By default, the DX8100 supports two standard audio inputs if the expanded audio card is not installed. If the expanded audio card is installed, the 
two standard audio inputs are disabled.

To set up the standard audio options:

1. Connect the audio input source to the DX8100. For information about connecting an audio source to the DX8100, refer to the DX8100 
Installation manual.

2. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

3. In the Channel Information area, verify that expanded audio option is not installed. This is indicated by the label Audio: Not Installed.

Figure 87. Audio Option Not Installed

4. In the Audio Settings area, click Advanced >>. The AUX Audio Settings dialog box opens.

5. In the AUX Audio Settings dialog box, do the following:

a. Click to deselect the Audio Disable check box.

b. In the Input Device drop-down box, select Mic (single channel only) or “Line in” (two standard channels).

c. Click the Left Channel check box and in the drop-down box, select an associated camera.

d. Click the Right Channel check box and in the drop-down box, select an associated camera.

e. (Optional) Left-click the Aux volume control and drag left to decrease the audio input level or to the right to increase the audio input 
level.

f. Click OK.

g. Click Apply.

Figure 88. AUX Audio Settings Dialog Box
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Setting Up the Expanded Audio Options
To set up the expanded audio option:

1. Do the following:

a. Install the optional DX8108-AUD/DX8116-AUD audio card (if necessary). For information about installing the optional 
DX8108-AUD/DX8116-AUD audio card, refer to the DX8100 8/16 Channel Audio Card Installation manual.

b. Connect an audio input device (microphone) to the numbered DX8108-AUD/DX8116-AUD audio card input for the camera channel 
being configured for live audio recording.

c. To hear live audio at the local server, connect head phones to the DX8100 audio output connector.

2. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page. 

3. Check the Channel Information section to verify that the audio option is installed and available. 

4. In the Camera Properties section, select the camera channel you want to configure for live audio recording. 

5. In the Audio Settings section, verify that the Audio Disable check box is not selected.

6. Click Apply.

7. Verify that you can hear sound from the DX8100 audio output.

For information about listening to live audio, refer to Listening to Live Audio at the Server on page 49.

CONFIGURING VIDEO LOSS DETECTION
You can configure the DX8100 to monitor each camera for the following events:

• Loss of synchronization: This event occurs if the data cable between the camera and DX8100 is disconnected (cable is cut or unplugged) 
or when the camera looses power.

• Low level of video: This event occurs if the DX8100 detects a low level of video signal from the camera:
– The available light source for the camera (indoor/outdoor lightly) is greatly diminished. 
– The DX8100 data cable is disconnected.

You can adjust the operation time from 0:00 to 23:59. For example, if the start time is 6:00 and the end time is 18:00, a low video level event 
from 18:01 to 5:59 will not be detected. The low video level detection time option is only available when the low level of video option is 
selected.

The DX8100 also stores a video incident as a video loss recovery event. The status provides the start and restore time for the video loss event.

The DX8100 allows you to select the loss of synchronization and low level of video option independently. 

• The PTZ camera and multiple relay output can be mapped to a video loss event. 

• Multiple cameras can be configured to record in response to a video loss event.

• The DX8100 can be configured to use emergency agent notification. In this case, the last available video image at the time the event 
occurred is sent to the designated remote client. If no image exist, then the system attaches a red colored pane to the e-mail. The red pane 
contains the text “Video Loss.” For information about setting up emergency notification, refer to Emergency Notification Setup on page 235.

• The DX8100 can be configured to send an e-mail notification in response to a video loss event. In this case, the last available video image 
at the time the event occurred is attached to the e-mail. If no image exist, then the system attaches a red colored pane to the e-mail. The 
red pane contains the text “Video Loss.” For information about setting up emergency notification, refer to Emergency E-Mail Notification 
Setup on page 238.

• The record icon turns purple indicating a video loss recording, regardless of the schedule. The video loss utility is constantly running in the 
background. If a schedule is not available, the record icon defaults to purple. If the DX8100 loses feed, video on that channel is recorded. 
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To set up video loss detection:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. In the Video Loss Detection section, do one or both of the following:

• Click the “Loss of synchronization” check box.
• Click the “Low level of video” check box.
• In the Low Level of Video Detection Operation Time section, set the Start Time and the End Time.

3. Click Apply.

Figure 89. Video Loss Detection

APPLYING SETTINGS TO ALL CAMERAS
If you want to keep the changes you made to options and parameters on the Camera page, you must click Apply. If you attempt to leave the 
Camera page, the system will display a message box, prompting you to apply, not apply, or cancel the changes.

To apply camera configuration options to all attached cameras:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. Perform the camera configuration.

3. In the Apply to All Cameras section, select the check boxes for one or more of the settings you want to apply to all cameras: Protocol, 
Camera Security, Picture Adjustment, Motion Detection, Audio Settings, and Video Loss.

4. Click Apply to All Cameras.

5. Click Apply.

IP CAMERA SETUP
This section describes how to configure IP cameras and is organized into the following sections:

• Configuring the DX8100 to Record IP Camera Video on page 123

• Disabling an IP Camera on page 130

• Deleting an IP Camera on page 131

• Restoring a Disabled Analog or IP Camera on page 131

For information about the supported IP cameras, refer to the DX8100 Series HVR Version 2.0 Release Notes. To access this document, go to 
http://www.Pelco.com and navigate to the Hybrid Video Recorders page.
122 C2630M-C (7/09)



CONFIGURING THE DX8100 TO RECORD IP CAMERA VIDEO
The DX8100 allows you to assign an IP camera to a designated channel. Initially, camera channels above the DX8100 standard analog channels 
are not displayed in the Site Tree. These channels are listed in the Selected Channel drop-down box located on the Camera page. Each IP camera 
configured as a network camera is displayed in the Site Tree. 

The steps for configuring the DX8100 to record IP camera video are organized into the following topics:

• About Analog and IP Camera Channel Configurations

• Searching for IP Cameras

• Assigning an IP Camera to a Camera Channel on page 124

• Configuring IP Camera Settings on page 126

• Customizing IP Camera Display Settings on page 127

About Analog and IP Camera Channel Configurations
The DX8100 channel configuration is as follows:

• Standard analog channel: The DX8108 and DX8116 channel capacity can be expanded by 16 channels using the DX8100 16-channel 
expansion unit kit.
– DX8108 channel configuration: Camera channels 1 to 8 are standard analog inputs and are displayed in the Site Tree; channels 9 to 

24 (sixteen total) are available for assigning IP cameras. 
– DX8116 channel configuration: Camera channels 1 to 16 are standard analog inputs and are displayed in the Site Tree; 

channels 17 to 32 (sixteen total) are available for assigning IP cameras. 
– DX8124 channel configuration: Camera channels 1 to 24 are standard analog inputs and are displayed in the Site Tree; 

channels 25 to 32 (eight total) are available for assigning IP cameras.
– DX8132 channel configuration: Camera channels 1 to 32 are standard analog inputs and are displayed in the Site Tree. Analog 

channels must be disabled to assign an IP camera. 

NOTE: For information about the supported resources for configuring analog and IP cameras, refer to DX8100 Series HVR Version 2.0 
Release Notes.

• Disabling an analog or IP camera results in the following conditions: 
– Frees up system CPU and memory resources.
– Video from the disabled channel is no longer available for recording.
– Settings specific to the disabled camera are preserved.
– The IP camera is not removed from the IP Camera Properties dialog box.

For information about disabling a camera, refer to Disabling an Analog Camera on page 130 or Disabling an IP Camera on page 130. For 
information about restoring a camera, refer to Restoring a Disabled Analog or IP Camera on page 131. 

For information about DX8100 supported analog and IP camera capacity, refer to DX8100 Series HVR Version 2.0 Release Notes. To access this 
document, go to http://www.Pelco.com and navigate to the Hybrid Video Recorders page.
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Searching for IP Cameras

NOTE: The scan utility is a DX8100 server-based feature and discovers IP cameras within the DX8100 network. The scan utility is not available 
in the Client application.

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. Click IP Camera Properties. The IP Camera Properties dialog box appears.

3. To search for IP cameras connected to the network:

• Using the IP Camera Properties dialog box scan utility: The scan utility locates Pelco IP devices, IP cameras, and Axis IP 
cameras.

NOTE: The DX8100 Client application IP Camera Properties scan utility is unavailable.

(1) Click Scan. The IP Camera Searching dialog box appears. 

(2) After the IP Camera Searching dialog box closes, the IP scan results are displayed in the scan table. 

NOTE: The scan results are cleared if the IP Camera Properties dialog box is closed. 

Figure 90. DX8100 Scan Utility Results

• Using the Pelco Device Utility: For information about installing the Device Utility, refer to Utility Device for Pelco IP Cameras 
manual.

NOTE: Install the Device Utility only on a remote computer. Do not install it on the DX8100 server. 

(1) On a remote computer, start the Pelco Device Utility and allow the Device Utility to discover IP devices on the network. 

(2) Search the Device Utility IP Address column for supported IP camera devices. For information about the supported IP cameras, 
refer to DX8100 Series HVR Version 2.0 Release Notes. To access this document, go to http://www.Pelco.com and navigate to 
the Hybrid Video Recorders page.

4. Note the IP address and model number of the supported IP cameras to be configured. 

5. Assign each IP cameras to a DX8100 camera channel (refer to Assigning an IP Camera to a Camera Channel on page 124).

Assigning an IP Camera to a Camera Channel
The DX8100 allows you to select the video format and recording stream. The MPEG4 codec (video format) setting allows you to select the 
primary or secondary stream. The MJPEG codec setting only supports the primary stream. 

• Pelco IP cameras (IP110, IP3701, Spectra IP, and Spectra Mini IP): These cameras record as follows:
– Primary stream: 4CIF 30 ips 
– Secondary stream: CIF 15 ips

• Pelco IX and IXE Series network cameras with Sarix™ technology: The resolution, frame rate, and bit rate can be adjusted.

• Axis Communications® Axis 211 or Axis 232D: Frame rates are selectable from 1 to 30 ips; resolutions are selectable from 640x480, 
480x360, 320x240, 240x810, or 160x120.
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1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. Click IP Camera Properties. The IP Camera Properties dialog box appears.

3. To assign an IP camera to a camera channel, do one of the following:

• Manual assignment: 
(1) Click a check box to select a camera. 

(2) Click the Manufacturer drop-down box and select a manufacturer. The port number, compression method, and video stream 
settings automatically appear in the camera row.

Figure 91. Manually Entering IP Camera Data

(3) Click the IP drop-down box and enter the camera’s IP address.

Figure 92. Manually Entering IP Camera Data

• Automated assignment:
(1) Click Scan. Available IP devices appear in the Scan table.

(2) Click a supported IP camera.

(3) Click the Add button . The Connect dialog box opens. 

(4) In the Connect drop-down box, click a camera.

(5) Click Apply. The selected camera is assigned to the designated camera channel.

Figure 93. Automated Assignment of an IP Camera
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4. (Optional) MPEG-4 is the default codec. Double-click the Codec drop-down box to select a different compression.

5. Double-click the User box and enter the user name.

6. Double-click the Password box and enter the password.

7. The DX8100 allows you to select the IP camera stream that the unit uses to record video.

• Stream 1: Primary is the default stream. It supports a higher resolution and image rate. 
• Stream 2: Stream 2 supports a lower resolution and image rate.

NOTE: For information about supported resolution and image rates, refer to DX8100 Series HVR Release Notes. To access this document, 
go to http://www.Pelco.com and navigate to the Hybrid Video Recorders page.

Double-click the Stream drop-down box to select the secondary stream. 

Figure 94. Entering the User Name, Password, and Stream

8. Repeat step 2 to 7 to associate additional IP cameras with other camera channels.

9. Click OK. The channel assignments are saved and the Camera page appears. 

10. (Optional) To adjust IP camera settings, refer to Configuring IP Camera Settings. Otherwise, refer to Customizing IP Camera Display Settings 
on page 127.

Configuring IP Camera Settings

For Pelco IP cameras, use the IP Camera Properties dialog box, the Web browser running on the DX8100 Client computer, or the Device Utility. 

For Axis IP cameras, use the Web-based Axis interface. For information about configuring Axis camera settings, refer to the Axis documentation 
that came with the camera. 

Using the IP Cameras Properties Dialog to Configure IP Cameras

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. Click IP Camera Properties. The IP Camera Properties dialog box appears.

3. Click a check box to select an IP camera channel. The Show Setup button is available.

4. Click Show Setup. The IP Camera Properties setup content area appears and the Web browser accesses the IP camera’s Settings page. 

Figure 95. Pelco IP110 General Tab
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5. Configure the IP camera settings. 

6. Log out of the IP camera. A login dialog box appears.

7. Click Hide Setup. 

8. Click OK. The camera settings are saved and the DX8100 Camera page appears.

9. Set up the IP camera to be displayed in the DX8100 Site Tree (refer to Customizing IP Camera Display Settings on page 127).

Using the Device Utility to Configure IP Cameras

1. Run the Device Utility on a remote computer and configure the IP camera settings.

2. Set up the IP camera to be displayed in the DX8100 Site Tree (refer to Customizing IP Camera Display Settings on page 127).

Customizing IP Camera Display Settings

The Camera page allows you to customize the IP camera display settings. Perform this step after the IP camera is assigned to a camera channel. 

NOTE: The IP camera’s status is automatically set to “Network Camera” when it is assigned to a camera channel, and assumes the default 
camera settings for that channel. 

For information about assigning an IP camera to a camera channel, refer to Assigning an IP Camera to a Camera Channel on page 124.

For information about removing an IP camera from the Site Tree, refer to Disabling an IP Camera on page 130.

To customize an IP camera’s display settings:

1. If the Camera page is not displayed, click the Setup button  on the DX8100 toolbar. The Setup dialog opens to the Camera page.

2. In the Camera Properties section:

a. Select an IP camera from the Selected Channel drop-down box.

b. Verify that the IP cameras is set to Network Camera in the related Selected Channel drop-down box. 

c. (Optional) To disable an IP camera, refer to Disabling an IP Camera on page 130. To disable an IP camera, refer to Disabling an IP 
Camera on page 130.

d. Enter an optional new name in the Camera Name box. 

Camera names can be up to 32 characters long and can include spaces and special characters. The Camera Name box cannot be left 
blank or have any spaces. If a valid name is not entered in the Camera Name box when you click Apply, the previous name is 
displayed. 

e. Select the appropriate PTZ protocol setting. Select No PTZ if the selected IP camera does not support PTZ; select Network Camera PTZ 
if the IP camera supports PTZ. 

3. Select an appropriate timeout value. 

4. Adjust picture properties by moving the sliders for Brightness, Contrast, Hue, and Saturation.

As you adjust the picture properties of a camera on the local HVR, changes are reflected immediately in the viewing area near the top of 
the screen. Changes made to cameras at a remote site do not appear in the viewing area until you click Apply.

5. Click Default to return all picture property settings to the normal state.

6. Click Apply. The IP camera is added to the Site Tree. 
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7. Verify that the IP camera resolution is displayed in the Site Tree and Channel Information area.

Figure 96. Viewing IP Camera Settings

8. In the Site Tree, click the IP camera. The IP camera video is displayed in the Camera page preview window. 

9. Verify that the CPU (orange) and Memory (blue) levels are within the DX8100 Resource Meter’s 0 to 100 percent range. If either level 
exceeds 100 percent, a warning dialog box appears.

Click the check box to disable future DX8100 System Resources Warning dialog boxes. If the unit is restarted, the DX8100 System 
Resources Warning dialog box is enabled again.

Figure 97. DX8100 System Resources Warning Dialog Box

To configure the analog and IP cameras to bring the CPU or Memory level within range:

a. (Optional) Click the check box to disable the DX8100 System Resources Warning dialog box.

b. Go to Configuring Analog and IP Cameras for Optimal Hybrid Video Recording on page 130.

10. Verify that the IP camera is communicating with the DX8100. Click IP Camera Status. The IP Camera Network Status dialog box appears and 
displays the IP camera’s status.

11. Click OK. 

12. Click Apply.

13. On the DX8100 toolbar, click the Setup button . The DX8100 application window appears.

14. Drag the newly configured IP camera to a camera pane.
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UNDERSTANDING THE DX8100 RESOURCE METER 

Figure 98. DX8100 Resource Meter

Table AD describes the parts of the DX8100 Resource Meter.

Table AD.  DX8100 Resource Meter

Item Part Description

View Pane Displays the available system resources (CPU and Memory resource levels) for the DX8100 server. The meter 
range is 0 to 100 percent. The CPU and Memory resource levels cannot exceed 100 percent. If either level 
exceeds 100 percent, the DX8100 System Resources Warning dialog box appears. For information about 
configuring analog and IP cameras for optimal system resources performance in order to bring the system 
resources within an acceptable range, refer to Configuring Analog and IP Cameras for Optimal Hybrid Video 
Recording on page 130.

NOTE: The DX8100 Resource Meter shows the CPU and memory resource levels that are specific to the 
DX8100 server application. They do not match the resource levels that appear in Windows Task Manager on 
the server. 

Memory Level (Blue) Indicates the DX8100 server’s memory usage. 

CPU Level (Orange) Indicates the DX8100 server’s CPU usage.

Data Area Displays the CPU and Memory usage as a percentage.

IP Camera Status 
Button

Sends a command to the IP address of the camera displayed in the Selected Channel drop down box. The 
ping command opens and displays the results in the IP Camera Network Status dialog box.

IP Camera Properties 
Button

Opens a dialog box that allows you to assign an IP camera to a camera channel.
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CONFIGURING ANALOG AND IP CAMERAS FOR OPTIMAL HYBRID VIDEO RECORDING

If the CPU level or the Memory level exceeds 100 percent, the DX8100 System Resources Warning dialog box appears. 

Click the check box to disable the DX8100 System Resources Warning dialog box.

Figure 99. DX8100 System Resources Warning Dialog Box

You can easily add, remove, and configure analog and IP cameras to achieve optimal hybrid video recording and system resources performance. 

NOTE: The system operates best when the CPU and Memory levels are less than 100 percent. For information about the DX8100 Resource 
Meter, refer to Understanding the DX8100 Resource Meter on page 129. 

The DX8100 Resource Meter provides a real-time display of available system resources. Use the DX8100 Resource Meter to help you fine tune 
the analog and IP camera recording settings. 

In summary, to configure the unit for optimal hybrid video recording, do any combination of the following: 

• Adjust the analog camera recording settings (refer to Basic Camera Setup on page 116 and Schedule Setup on page 143)

• Adjust the IP camera recording settings (refer to Configuring IP Camera Settings on page 126 and Customizing IP Camera Display Settings 
on page 127)

• Disable an analog camera (refer to Disabling an Analog Camera on page 130

• Disable an IP camera (refer to Disabling an IP Camera on page 130 and Deleting an IP Camera on page 131)

• Restore a disabled analog or IP camera (refer to Restoring a Disabled Analog or IP Camera on page 131)

Disabling an Analog Camera

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. From the Selected Channel drop-down box, select an analog camera. The camera is highlighted in the Site Tree.

3. From the extended Selected Channel drop-down box, select Disable. 

4. Click Apply. The selected analog camera is removed from the Site Tree. The camera’s customized settings are retained.

A disabled analog camera can be reassigned to the Site Tree. For information about restoring a disabled analog camera, refer to Restoring a 
Disabled Analog or IP Camera on page 131.

Disabling an IP Camera
Disabling an IP camera does not delete its customized settings. For example, you can temporarily disable an IP camera to recover system 
resources. For information about other reasons to disable an IP camera, refer to About Analog and IP Camera Channel Configurations on 
page 123.

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. In the Camera Properties section, do the following:

a. In the Site Tree, select an IP camera. The IP camera name is displayed in the Selected Channel drop-down box.

b. Select Disable in Camera page Selected Channel drop-down box. 

Figure 100. Disabling an IP Camera
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3. Click Apply. The IP camera is removed from the Site Tree, but it is still assigned to the channel in the IP Camera Properties dialog box. 

The IP camera can be reassigned to the Site Tree. For information about restoring a disabled IP camera, refer to Restoring a Disabled 
Analog or IP Camera on page 131. 

Deleting an IP Camera

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. Click IP Camera Properties. The IP Camera Properties dialog box appears.

3. In the IP Camera Properties dialog box, select the IP camera you want to delete. 

4. Click Delete. The IP camera is deleted from the IP Camera Properties dialog box. 

5. In the IP Camera Properties dialog box:

• To accept the deletion: Click OK. The IP Camera Properties dialog box closes. The IP camera is removed from the Site Tree and its 
status changes to “Disable” in the extended Selected Channel drop-down box. The IP camera retains its customized camera name and 
display settings. 

Figure 101. IP Camera Status: Disabled

If you select Network Camera in the extended Selected Channel drop-down box, a DX8100 message appears, stating that the IP 
camera is not registered. To register the IP camera, you must assign it to a camera channel. For information about assigning an IP 
camera to a camera channel, refer to Assigning an IP Camera to a Camera Channel on page 124.

Figure 102. IP Camera Not Registered Dialog

• To cancel the deletion: 
(1) Click Cancel. The IP Camera Properties dialog box closes. The IP camera is not removed from the Site Tree, but its status 

changes to “Disable” in the extended Selected Channel drop-down box. 

Figure 103. IP Camera in Site Tree and Status: Disabled

(2) In the Camera page, click Cancel. The IP camera status changes to Network Camera in the extended Selected Channel 
drop-down box. The IP camera is not deleted from the IP Camera Properties dialog box.

Restoring a Disabled Analog or IP Camera
A disabled analog or IP camera can be restored. For information about configuring an IP camera, refer to Assigning an IP Camera to a Camera 
Channel on page 124.

NOTE: An IP camera that was deleted in the IP Camera Properties dialog box cannot be restored; a deleted IP camera must be reconfigured. 
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Analog Camera

1. From the Selected Channel drop-down box, select an analog camera. The camera name is displayed in the Camera Name box.

2. From the extended Selected Channel drop-down box, select Local Camera.

3. Click Apply. The camera name is displayed in the Site Tree and video is displayed in the Camera page preview window.

IP Camera

NOTE: An IP camera must be configured and assigned to a camera channel in the IP Camera Properties dialog box before it can be assigned as a 
network camera.

1. From the Selected Channel drop-down box, select an IP camera. The camera name is displayed in the Camera Name box.

2. From the extended Selected Channel drop-down box, select Network Camera. If an error message appears, reassign the IP camera to a 
camera channel (refer to Customizing IP Camera Display Settings on page 127).

3. Click Apply. The camera name is displayed in the Site Tree and video is displayed in the Camera page preview window.

LINK SETUP
This section describes how to use the Link page to set up the following:

• Relay and alarm settings

• Event-relay link settings

• Event-recording link settings

• Event-PTZ link settings

This section includes the following topics:

• Configuring Basic Relay and Alarm Settings 

• Linking Relay Outputs to External Events on page 134 

• Linking PTZ Presets and Patterns to External Events on page 139 

• Linking Cameras to Record in Response to External Events on page 136 

CONFIGURING BASIC RELAY AND ALARM SETTINGS
The DX8100 can support up to 32 alarm inputs and 24 relay outputs. Each 8-channel HVR has 8 dry contact alarm inputs and 8 relay terminals; 
each 16-channel HVR has 16 dry contact alarm inputs and 16 relay terminals. 

This section describes how to configure basic relay and alarm settings, including the following topics:

• Understanding How Relays and Alarms React to a Power Outage

• Configuring DX8100 Basic Relay and Alarm Settings 

• Configuring Basic Relay Operating Properties 

• Configuring Basic Alarm Input Operating Properties on page 133

Understanding How Relays and Alarms React to a Power Outage
The DX8100 server might experience an external AC power outage that impacts how the relay and alarm features function.

• Power outage: Relays configured as NO are closed if the DX8100 is server is shut down by a power outage, or the AC cord is unplugged. 

• Power button: Relays configured as NO are closed if the DX8100 power button is pressed and held down. 

In the scenarios above, a relay will remain closed as long as the DX8100 is powered down. In this case, alarms or sirens connected to the relays 
might produce a false alert. 

Configuring DX8100 Basic Relay and Alarm Settings
To access the Link page to program alarms and relays:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera setup page.

2. Click the Linking button . The Link page is displayed. 
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Configuring Basic Relay Operating Properties
To configure basic relay operating properties:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. Click the Linking button  to display the Link page. 

3. In the Relay Settings section, do the following:

a. In the Relay Channel drop-down box, select the relay you want to configure.

b. In the Relay Name box, enter an optional new name for the relay. Relay names can be up to 32 characters long and can include spaces 
and special characters.

You can also rename sites, cameras, alarms, and relays from the Site Tree by slowly clicking twice on each object’s name.

c. In the Relay Type section, click the NO/NC button to toggle the default output type for each relay (normally open or normally closed).

4. Click Apply.

Figure 104. Relay and Alarm Settings Page: Relay Settings Section

Configuring Basic Alarm Input Operating Properties
Most applications will not require you to change relay and alarm settings from their default states.

To configure basic alarm input operating properties:

1. On the DX8100 toolbar, the Setup button . The Setup dialog opens to the Camera page.

2. Click the Linking button  to display the Link page.

3. In the Alarm Settings section, do the following:

a. In the Alarm Channel drop-down box, select the Alarm you want to configure.

b. In the Alarm Name box, enter an optional new name for alarm. Alarm names can be up to 32 characters long and can include spaces 
and special characters.

You can also rename sites, cameras, alarms, and relays from the Site Tree by slowly clicking twice on each object’s name.

c. In the Alarm Type section, click the NO/NC button to toggle the default output type for each alarm (normally open or normally closed).
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4. Click Apply.

Figure 105. Relay and Alarm Settings Page: Alarm Settings Section

LINKING RELAY OUTPUTS TO EXTERNAL EVENTS
This section describes how to link relay outputs to external events, such as motion, alarm, ATM/POS, and video loss events. The following topics 
are included:

• Linking Relay Outputs to Motion Events 

• Linking Relay Outputs to Alarm Events on page 135

• Linking Relay Outputs to ATM/POS Events on page 135

• Linking Relay Outputs to Video Loss Events on page 136

To access the Event-Relay Link Settings page:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page opens to the Relay and Alarm Settings page.

3. Click the Event-Relay Link Settings tab.

Linking Relay Outputs to Motion Events
To set relay outputs to activate in response to motion detection events:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button .

3. Click the Event-Relay Link Settings tab.

4. In the Motion Detection Link Settings section, do the following:

a. Select a camera channel from the Camera Channel drop-down box.

b. Click the button for each relay you want to link to the selected camera.

You can also drag relays onto cameras in the Site Tree while in Live mode (main screen).

5. Click Apply.

Figure 106. Event-Relay Link Settings: Motion Detection Link Settings Section
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Linking Relay Outputs to Alarm Events
To set relay outputs to activate in response to an alarm event:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button .

3. Click the Event-Relay Link Settings tab.

4. In the Alarm Link Settings section, do the following:

a. Select an alarm channel from the Alarm Channel drop-down box.

b. Click the button for each relay you want to link to the selected alarm.

You can also drag relays onto alarms in the Site Tree while in Live mode (main screen).

5. Click Apply.

Figure 107. Event-Relay Link Settings: Alarm Link Settings Section

Linking Relay Outputs to ATM/POS Events
To set relay outputs to activate in response to an ATM/POS event:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button .

3. Click the Event-Relay Link Settings tab.

4. In the ATM/POS Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS Address drop-down box.

b. Click the button for each relay you want to link to the selected ATM/POS address.

You can also drag relays onto ATM/POS devices in the Site Tree while in Live mode (main screen).

5. Click Apply.

Figure 108. Event-Relay Link Settings: ATM/POS Link Settings Section
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Linking Relay Outputs to Video Loss Events
To set relay outputs to activate in response to a video loss event:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button .

3. Click the Event-Relay Link Settings tab.

4. In the Video-Loss Link Settings section, do the following:

a. Select a camera from the Video-Loss Channel drop-down box.

b. Click the button for each relay you want to link to the selected Video-Loss Channel. 

5. Click Apply.

Figure 109. Event-Relay Link Settings: Video-Loss Link Settings Section

LINKING CAMERAS TO RECORD IN RESPONSE TO EXTERNAL EVENTS
Multiple cameras can be configured to begin recording in response to detected motion, alarm, ATM/POS transaction, and video loss events. 
This section describes how to link cameras to record in response to these events and includes the following topics:

• Linking Cameras to Record in Response to Motion Events on page 136 

• Linking Cameras to Record in Response to Alarm Events on page 137

• Linking Cameras to Record in Response to ATM/POS Events on page 137

• Linking Cameras to Record in Response to Video Loss Events on page 138 

Linking Cameras to Record in Response to Motion Events
To link multiple cameras to record in response to motion detection events:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Motion Record Link Settings section, do the following:

a. Select a camera from the Motion Source Camera drop-down box.

b. Click the button for each camera you want to begin recording when motion is detected by the source camera.

4b
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5. Click Apply.

Figure 110. Event-Relay Link Settings: Video-Loss Link Settings Section

Linking Cameras to Record in Response to Alarm Events
To link multiple cameras to record in response to a single alarm input:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Alarm Record Link Settings section, do the following:

a. Select an Alarm channel from the Alarm Channel drop-down box.

b. Click the button for each camera you want to begin recording when the source alarm is triggered.

5. Click Apply.

Figure 111. Event-Recording Link Settings: Alarm Record Link Settings Section

Linking Cameras to Record in Response to ATM/POS Events
To link multiple cameras to record in response to an ATM/POS event:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the ATM/POS Record Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS address drop-down box.

b. Click the button for each camera you want to begin recording in response to an ATM/POS event. 
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5. Click Apply.

Figure 112. Event-Recording Link Settings: ATM/POS Record Link Settings Section

Linking Cameras to Record in Response to Video Loss Events
To link multiple cameras to record in response to a video loss event:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Video-Loss Record Link Settings section, do the following:

a. Select a camera from the Video-Loss Channel drop-down box.

b. Click the button for each camera you want to begin recording in response to a video loss event. 

5. Click Apply.

Figure 113. Event-Recording Link Settings: Video-Loss Record Link Settings Section
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LINKING PTZ PRESETS AND PATTERNS TO EXTERNAL EVENTS
The DX8100 can be configured in such a way that motion, alarms, ATM/POS transactions, and video loss events detected by one camera will 
result in the repositioning of another. Similarly, alarm inputs can be set to trigger camera-positioning presets. Only a single preset or pattern can 
be linked to a camera.

This section describes how to link PTZ presets and patterns to motion and alarm events, including the following topics:

• Linking PTZ Presets and Patterns to Motion Events on page 139

• Linking PTZ Presets and Patterns to Alarm Events on page 140 

• Linking Presets and Patterns to ATM/POS Events on page 141

• Linking Presets and Patterns to Video Loss Events on page 142 

Linking PTZ Presets and Patterns to Motion Events
To link two cameras so that motion detected on one results in the repositioning of another:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Motion Detection Link Settings section, do the following:

a. Select a camera from the Camera Channel drop-down box. (This camera will be the motion source.)

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to motion detected by the source camera.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do one of the following: 

• To force the linked camera to move to a PTZ preset in response to motion detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150).

• To force a PTZ pattern to be activated in response to motion detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 114. Event-PTZ Link Settings: Linking Presets and Patterns to Motion Events
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Linking PTZ Presets and Patterns to Alarm Events
To link an alarm input to a camera so activation of the alarm results in a repositioning of that camera:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Alarm Record Link Settings section, do the following:

a. Select an alarm from the Alarm Channel drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to an alarm input detected by the source alarm.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do one of the following: 

• To force the linked camera to move to a PTZ preset in response to an alarm input detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150).

• To force a PTZ pattern to be activated in response to alarm input detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 115. Event-PTZ Link Settings: Linking Presets and Patterns to Alarm Events
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Linking Presets and Patterns to ATM/POS Events
To link an ATM/POS input to a camera so the detected ATM/POS event results in a repositioning of that camera:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the ATM/POS Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS Address drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to an ATM/POS input detected by the source ATM/POS device.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do one of the following: 

• To force the linked camera to move to a PTZ preset in response to an ATM/POS input detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150).

• To force a PTZ pattern to be activated in response to ATM/POS input detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 116. Event-PTZ Link Settings: Linking Presets and Patterns to ATM/POS Events
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Linking Presets and Patterns to Video Loss Events
To link a video loss event to a camera so the detected video loss event results in a repositioning of that camera:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Linking button . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Video-Loss Link Settings section, do the following:

a. Select a camera channel from the Video-Loss Channel drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to a video loss event detected by the source camera.

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do the one of the following: 

• To force the linked camera to move to a PTZ preset in response to a video loss event detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150) for the camera to move to.

• To force a PTZ pattern to be activated in response to video loss input detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 117. Event-PTZ Link Settings: Linking Presets and Patterns to Video Loss Events
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SCHEDULE SETUP
The DX8100 provides extensive scheduling capabilities. Flexible recording schedules can be established for daily, weekday, weekend, or 
individual day recording. Recording time can be broken up into increments of one-half hour, and each increment can be scheduled to record 
continuously or in response to an alarm, motion, or ATM/POS event. Users with Power User access and higher can create recording schedules.

This section describes how to setup recording schedules and includes the following topics:

• Accessing the Schedule on page 143 

• Setting Up the Camera Recording Mode on page 145 

• Creating Yearly Recording Schedules on page 147 

• Creating Monthly or Multiple-Day Recording Schedules on page 149 

• Creating Single-Day Schedules on page 150

• Editing Schedules on page 152 

• Working with Custom Camera Settings on page 154 

• Configuring the Frame Rate on page 156 

• Setting Up Advanced Relay Output on page 163 

ACCESSING THE SCHEDULE
To access the scheduling features of the DX8100:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed. 

Figure 118 shows the parts of the Schedule page.

Figure 118. Schedule Page
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Table AE describes the parts of the Schedule page.

Table AE.  Parts of the Schedule Page

Item Part Description

Schedule Type 
Drop-down Box

Selects the type of schedule. Options are as follows:

• All days; Seven days a week

• Weekdays; Monday through Friday, with the exception of any day assigned in Custom mode

• Weekends; Saturday and Sunday, with the exception of any day assigned in Custom mode

• Custom Mode; Any day, such as a holiday

Recording 
Schedule Profile 

Allows you to do the following:

• Select and apply an existing schedule profile.

• Create and save a new profile.

• Change an existing profile.

• Delete an existing profile. 

Calendar Displays current schedule profile in accordance with the schedule type selected (All Days, Weekdays, 
Weekends, or Custom Mode).

Start and End Date 
Markers

Sets the start and end dates for a custom schedule.

Record Mode Selects a recording mode to be applied to a camera. Options are as follows:

• Normal

• Motion 

• Alarm

• ATM/POS

Channel 
Scheduling Panel 

Allows the assignment of recording modes across individual camera channels over a 24-hour period.

Camera Settings 
Panel

Allows custom settings to be applied to individual cameras for each recording mode.

Apply Saves current schedule.

Frame Rate 
Configuration 

Allows configuration of channel resolution and frame rates.

Configure Relays Allows configuration of relays that have been linked to cameras and alarms. 

Instant Recording Enables or disables selection of instant recording from the View menu.
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SETTING UP THE CAMERA RECORDING MODE
The DX8100 allows you to schedule each camera to record in a single or multiple-event mode across a 24-hour timeline. Users with Power User 
access or higher can schedule video recording for one or more cameras. Use the Record Mode section near the bottom of the Schedule page to 
configure the recording mode for each camera. 

This section describes how to schedule a recording mode and includes the following topics:

• Scheduling a Record Mode

• Clearing a Scheduled Recording on page 146

Scheduling a Record Mode
The DX8100 allows you to schedule a camera for multiple event recording. In this case, pre-event (motion, alarm, or ATM/POS) recording is set at 
the frame rate of the active record mode when the alarm, motion, or ATM/POS event occurred. For example, if the DX8100 HVR is recording at 
1 ips in the Normal record mode when an alarm event occurs, video is recorded at 1 ips during the pre-event time period. After the pre-event time 
period expires, the recording rate switches to the frame rate configured for the event. 

To schedule a record mode for one or more channels:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed. 

3. Click the check box for the record mode you want to apply to a channel.

• Normal 
• Motion
• Alarm
• ATM/POS

Table AF describes the record modes.

4. Click and drag the mouse to highlight the time periods and channels where you want the recording mode to apply.

Drag the mouse diagonally to highlight periods across multiple camera channels simultaneously.

Table AF.  Record Modes

Mode Color Description

Normal Green Continuous recording. 

Motion Blue Recording is triggered during the selected time block if a motion event is detected in the camera’s predefined 
motion field. For information about motion detection, refer to Motion Detection Setup on page 118.

Alarm Red Recording is triggered during the selected time block when an alarm is activated. At least one alarm must be 
linked to the camera for this option to work. For information about alarms, refer to Linking Alarm Inputs to a 
Camera on page 39.

ATM/POS Yellow Recording is triggered during the selected time block if an ATM or POS event is detected in the camera’s 
predefined ATM/POS field. For information about ATM/POS detection, refer to Linking Cameras to Record in 
Response to ATM/POS Events on page 137.
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5. Click Apply.

Figure 119. Filling In Recording Blocks in a Schedule Grid

Clearing a Scheduled Recording
The DX8100 Schedule feature allows you to do the following:

• For one or multiple channels, clear the scheduled recording times for a specific record mode. You can select one channel or you can drag 
and select a group of channels. For example, you can select and drag the recording times for channel 1-32. However, the system does not 
allow you to select random channels from the list. For example, you are not allowed to select channel 1, 2, and 4 (excluding camera 3).

• For one or multiple channels, you can clear the scheduled recording times for all record modes simultaneously. 

• You can select and clear recording times periods in increments of 30 minutes to 24 hours.

This section describes how to clear a scheduled recording and includes the following sections:

• Clearing Recording Times for a Specific Record Mode on page 146

• Clearing Recording Times for All Record Modes on page 147

Clearing Recording Times for a Specific Record Mode

To clear the scheduled recording times for a specific record mode for one or more channels:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. Click a record mode check box to select the specific record mode.

4. Right-click and drag to highlight the time periods and channels for which you want to clear recording times.

5. Release the right mouse button. The highlighted recording times are cleared. 

6. Do one of the following:

• To accept the change, click Apply. The selected time period is deleted.
• To cancel the change, click Cancel. The deleted recording times are restored.

Figure 120. Clearing Recording Times for a Specific Record Mode

�
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Clearing Recording Times for All Record Modes

To clear the scheduled recording times for all record modes:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed. 

3. Click a record mode check box to deselect the record mode. No record mode is selected.

4. Right-click and drag to highlight the time periods and channels for which you want to clear recording times.

5. Release the right mouse button. The highlighted recording times are cleared.

6. Do one of the following:

• To accept the change, click Apply. The selected time period is deleted.
• To cancel the change, click Cancel. The deleted recording times are restored.

Figure 121. Clearing Recording Times for All Record Modes

CREATING YEARLY RECORDING SCHEDULES
The DX8100 allows you create and save various recording schedules. This section describes how to create yearly recording schedules and 
includes the following sections:

• Creating a Yearly Recording Schedule 

• Scheduling Individual Days Using the Year View on page 148 

• Copying Schedule Attributes to a Different Day on page 148

Creating a Yearly Recording Schedule
Year View allows a user to customize recording schedules for individual days. Year View displays daily recording schedules in a calendar format. 
The calendar displays one year’s worth of daily recording schedules. The scheduling period begins in the current month.

• Days circled in red have been assigned weekday, weekend, or everyday recording schedules.

• Days circled in blue have been assigned a custom recording schedule.

• Days without circles denote that no recording has been scheduled for that day.

�

�

�
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Scheduling Individual Days Using the Year View
To schedule individual days using the Year View:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed. 

3. Click the Year View tab. The Year View page is displayed.

4. Click the day you want to schedule.

5. Using your mouse, select the recording modes and times for each channel you want to schedule. For information about selecting a 
recording mode, refer to Setting Up the Camera Recording Mode on page 145.

6. Repeat steps 2 and 3 for each additional day you want to schedule.

7. Click Apply.

Copying Schedule Attributes to a Different Day
To copy the schedule attributes of one day and apply them to a different day:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed. 

3. Right-click the calendar day you want to copy.

4. Select Copy from the shortcut menu.

Figure 122. Year View Calendar Shortcut Menu

5. Right-click the day on the calendar you want to apply the copied schedule attributes.

6. Select Paste from the shortcut menu.

7. Click Apply.

To change a custom schedule day to a regular schedule day, right-click and select “Revert to daily schedule” from the shortcut menu.
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CREATING MONTHLY OR MULTIPLE-DAY RECORDING SCHEDULES
Unlike schedules set in the Year View, Month View schedules are recurrent. Schedules can be set for subsequent weekdays, weekends, 
everyday, or a single day. 

This section describes how to create a monthly or multiple-day schedule and includes the following topics:

• Creating Multiple-Day Schedules

• Creating Single-Day Schedules on page 150

Creating Multiple-Day Schedules
To create a recording schedule to recur indefinitely:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. Click the Month View tab if it is not currently selected.

4. Select All days, Weekday, or Weekends from the drop-down box.

5. Click New. The New File Name dialog box opens.

6. In the New File Name box, enter a new filename for the profile. 

The profile file name follows the standard Windows file-naming conventions.

7. Click OK.

8. Using your mouse, select the recording modes and times for each camera you want to schedule. For information about camera scheduling, 
refer to Setting Up the Camera Recording Mode on page 145.

9. Click Save.

10. Click Apply.

11. Click the Apply button at the bottom of the Schedule page.

Figure 123. Month View Page: Multi-Day Schedule
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Creating Single-Day Schedules
This section describes how to create a single-day schedule and includes the following topics:

• Working with Single-Day Schedules 

• Copying and Applying Schedule Attributes on page 152

Working with Single-Day Schedules

Custom Mode schedules are defined for single days only. A custom-scheduled day can be set to recur on the same day of every month or the 
same day every year.

To set the HVR to record on a specific day: 

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed. 

3. Click the Month View tab (if it is not currently selected.)

4. Select Custom Mode from the drop-down box.

5. Click New. The New File Name dialog box opens.

6. Enter a new file name for the profile.

The profile file name follows the standard Windows file-naming conventions.

7. Click OK.

8. Select Once Per Month or Once Per Year.

9. Select the date range for the custom schedule.

a.  Set the start date with the Start spinner buttons.

The start date cannot be set later than the end date.

b. If you want the schedule to recur indefinitely, deselect the Finish on End Date check box.

c. Set the end date with the End spinner buttons.

10. On the calendar, click the desired date.

11. Select the recording modes and times for each camera you want to schedule. Refer to Setting Up the Camera Recording Mode on page 145 
for instructions.

12. Click Save.

13. Click Apply.
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14. Click the Apply button at the bottom of the screen.

Figure 124. Month View Page: Single-Day Schedule
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Copying and Applying Schedule Attributes

To copy the schedule attributes of one day and apply them to a different day:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. Right-click the calendar day you want to copy.

4. Select Copy from the shortcut menu.

Figure 125. Month View Calendar Shortcut Menu

5. Right-click on the calendar day to which you want to apply the copied schedule attributes.

6. Select Paste from the shortcut menu.

7. Click the Apply button at the bottom of the screen.

To change a custom schedule day to a regular schedule day, right-click and select “Revert to daily schedule” from the shortcut menu.

EDITING SCHEDULES
This section describes how to edit a schedule to change its profile or delete a schedule. The following topics are included:

• Changing an Existing Schedule Profile 

• Deleting an Existing Schedule Profile on page 153

Changing an Existing Schedule Profile
To change a profile:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. Click the Month View tab if it is not currently selected.

4. In the drop-down box, select the type of schedule you want to change. Options are as follows:

• All Days
• Weekdays
• Weekends
• Custom Mode

5. Select the schedule profile from the drop-down box.

6. Using your mouse, assign new recording modes and times for each camera you want to schedule. Refer to Setting Up the Camera 
Recording Mode on page 145 for instructions.

7. Click Save.
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8. Click Apply.

9. Click the Apply button at the bottom of the screen.

Figure 126. Month View Page

Deleting an Existing Schedule Profile
To delete a schedule profile:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. In the drop-down box, select the type of schedule you want to change. Options are as follows:

• All days 
• Weekdays
• Weekends
• Custom Mode

5. In the drop-down box, select a profile that is different from the one you want to delete. (This step is necessary because you cannot delete a 
schedule profile that is currently active.)

6. Click Apply.

7. In the drop-down box, select the profile you want to delete.

8. Click Delete.
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9. Click Apply.

Figure 127. Month View Page

WORKING WITH CUSTOM CAMERA SETTINGS
This section describes how to configure customized camera settings and includes the following topics:

• Configuring Custom Camera Settings 

• Examples of Custom Camera Settings on page 155 

Configuring Custom Camera Settings
Each camera can be configured with custom recording settings. 

To customize camera settings for normal, motion, alarm, or ATM/POS recording:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. Click the plus (+) sign next to a camera in the Site Tree.

4. Select a recording mode from one of the following options:

• Normal
• Motion
• Alarm
• ATM/POS

5. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

6. Adjust the parameters in the camera settings section.

7. Click OK.

�
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8. Click Apply.

Figure 128. Custom Camera Settings Panel

Examples of Custom Camera Settings
The DX8100 allows you to configure customized camera settings for the following recording modes:

• Normal

• Motion

• Alarm

• ATM/POS

Figure 129 shows camera settings for the supported modes.

Figure 129. Examples of Custom Camera Settings
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Table AG describes the settings for the supported modes.

CONFIGURING THE FRAME RATE
The DX8100 can record at frame rates up to 480 ips by National Television System Committee (NTSC) standards and 400 ips by Phase Alternating 
Line (PAL) standards. 

This total frame rate capacity is distributed among 8, 16, 24, or 32 cameras, depending on the configuration of your unit. Resolution and frame 
rate values can be assigned evenly among all cameras, or they can be configured independently for individual cameras. Frame rate values can 
also be customized according to recording mode type (normal, motion, alarm, or ATM/POS). 

Power Users and Administrators can configure recording frame rates on the DX8100. All cameras are optimized to provide 30 ips frame rates at 
320 x 240 resolution for NTSC (352 x 288 resolution for PAL). The DX8100 allows you to change the frame rates available to each camera, while 
resolution values must remain constant or change both frame rate and resolution settings. 

This section describes how to configure the frame rate and includes the following topics:

• Accessing the Frame Rate Configuration Dialog Box 

• Setting the Frame Rate 

• Setting the Resolution and Frame Rate on page 158

• Understanding the DX8100 Frame Rate Calculations on page 163

Accessing the Frame Rate Configuration Dialog Box
To access the Frame Rate Configuration dialog box:

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

Table AG.  Camera Settings for the Supported Recording Modes

Normal Motion Alarm ATM/POS

Image Resolution* Image Resolution* Image Resolution* Image Resolution*

Frame Rate* Frame Rate During Motion* Frame Rate During Alarm* Frame Rate During ATM/POS*

Image Quality† (Best, High, 
Normal, Low, Lowest)

Pre-Motion Frame Rate Pre-Alarm Frame Rate Pre-ATM/POS Frame Rate

Pre-Motion Image Quality† 
(Best, High, Normal, 
Low, Lowest)

Pre-Alarm Image Quality† 
(Best, High, Normal, 
Low, Lowest)

Pre-ATM/POS Image Quality† 
(Best, High, Normal, 
Low, Lowest)

Motion Image Quality† 
(Best, High, Normal, 
Low, Lowest)

Alarm Image Quality† 
(Best, High, Normal, 
Low, Lowest)

ATM/POS Image Quality† 
(Best, High, Normal, 
Low, Lowest)

Pre-Motion (1-60 sec) Pre-Alarm (1-60 sec) Pre-Event (1-60 sec)

Post-Motion (1-180 sec) Post-Alarm (1-180 sec) Post-Event (1-180 sec)

*This field appears for information purposes only. To change this setting, refer to Configuring the Frame Rate on page 156.
†Image quality is a function of video compression. Higher quality video images require larger file sizes.
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Setting the Frame Rate
The DX8100 Series HVR is optimized to provide 8, 16, 24, or 32 cameras of continuous video recording, with a frame rate of 30 ips at a resolution 
of 320 x 240 (NTSC) or 320 x 288 (PAL). The DX8100 allows you to change the frame rate independent of the resolution. For information about 
accessing the Frame Rate Configuration dialog box, refer to Accessing the Frame Rate Configuration Dialog Box.

To set the frame rate values for cameras: 

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens. 

4. Select the button for the recording mode you want to configure. Options are as follows:

• 604 
• 704
• Normal
• Motion
• Alarm
• ATM/POS

5. Do the following:

a. Using the ALL frame rate settings slider, set the frame rate for all channels. 

b. To set the frame rate for an individual channel, use the frame rate slider for that channel to select a frame rate from 1-30 ips 
(according to the available capacity for the channel). The frame rate of an individual channel is limited to the maximum setting of the 
ALL frame rate slider.

The frame rate ranges from 1 to 30 ips, depending on the DX8100 Series HVR configuration. The 8-camera HVR has 8 sliders, the 16-camera 
HVR has 16 sliders, the 24-camera HVR has 24 sliders, and the 32-camera HVR has 32 sliders.

6. Repeat step 5b for each camera you want to configure.

7. Click OK.
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8. Click Apply at the Schedule page.

Figure 130. Frame Rate Configuration Dialog Box

Setting the Resolution and Frame Rate
Both resolution and frame rate settings can be adjusted using the Frame Rate Configuration dialog box. For information about accessing the 
Frame Rate Configuration dialog box, refer to Accessing the Frame Rate Configuration Dialog Box on page 156.

To set recording resolution and frame rates for each channel: 

1. From the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Schedule button . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

4. Select the button for the recording resolution and mode you want to configure. Options are as follows:

• 640
• 704
• Normal
• Motion
• Alarm
• ATM/POS

The 640 resolution setting is for the standard VGA format. The 704 resolution is for the cropped D1 video (NTSC, PAL).

	

�
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5. Select resolution values for individual channels from the drop-down boxes. Table AH describes the available resolution values.

Setting a resolution value for one recording mode sets the resolution value for all modes. For example, setting resolution to 640 x 480 in 
Motion recording mode will change the resolution to 640 x 480 in Normal and Alarm recording modes as well.

6. Do the following:

a. Using the ALL frame rate settings slider, set the frame rate for all channels. 

b. To set the frame rate for individual channels, use the frame rate slider for each channel to select a frame rate from 1-30 ips (according 
to the available capacity for that channel). The frame rate of an individual channel cannot exceed the maximum setting of the ALL 
frame rate slider.

7. Click OK.

8. Click Apply when you return to the Schedule Setup screen.

Figure 131. Frame Rate Configuration Screen

Table AH.  Resolution Values

Video Format
NTSC PAL

640 704 640 704

CIF 320 x 240 352 x 240 320 x 288 352 x 288

2CIF 640 x 240 704 x 240 640 x 288 704 x 288

4CIF 640 x 480 704 x 480 640 x 576 704 x 576
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Understanding DX8100 Server Maximum IPS Recording
The DX8100 can record at frame rates up to 480 IPS NTSC and 400 IPS PAL. The total frame rate capacity is distributed among 8/16/24/32 
channels, depending on the configuration of your unit. Resolution and frame rate values can be assigned evenly among all channels, or they can 
be configured independently for individual channel. Frame rate values can also be customized according to recording mode (normal, motion, 
alarm, and ATM/ POS). For information about setting up the DX8100 to record at the maximum rate and resolution, refer to Setting Up DX8100 for 
Maximum IPS Recording.

Setting Up DX8100 for Maximum IPS Recording

Table AJ describes how the DX8100 organizes cameras (channels) into groups of four cameras per group. To achieve the maximum recording rate 
and resolution: (30 ips at 4CIF [NTSC] or 25 ips at 4CIF [PAL]), enable one camera from each group while the other three cameras in the group are 
disabled. For information about the various recording rates and resolutions, refer to Understanding DX8100 Server Maximum IPS Recording.

Table AI.  DX8100 Server Maximum IPS Recording

Model Format
NTSC IPS PAL IPS

Total Per Camera Total Per Camera

DX8108

CIF 240 30 200 25

2CIF 120 15 100 12

4CIF 60 7 50 6

DX8116

CIF 480 30 400 25

2CIF 240 15 200 12

4CIF 120 7 100 6

DX8124

CIF 360 15 300 12

2CIF 180 6 150 6

4CIF 90 3 75 3

DX8132

CIF 480 15 400 12

2CIF 240 6 200 6

4CIF 120 3 100 3

Table AJ.  DX8100 Camera Grouping

Model Group Assigned Camera

DX8108
1 1-4

2 5-8

DX8116

1 1-4

2 5-8

3 9-12

4 13-16
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To set up the DX8100 to record at the maximum rate and resolution:

1. Do one of the following:

• On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

• If the Setup dialog box is already open, click the Camera button . The Camera page is displayed.

2. In the Camera Properties section, for Group 1, do the following:

a. Select a camera from the drop-down box. (You can also select a camera from the Site Tree by clicking on it.)

b. For the camera you want to enable, verify that the Disable check box is not selected.

c. For the remaining cameras in the group, click the Disable check box to disable the respective camera.

3. Repeat step 2 for Groups 2, 3, and 4 (if applicable).

4. Click Apply.

5. Click the Schedule button . The Schedule page is displayed. 

6. Verify that the enabled camera from each group is displayed in the Site Tree.

Figure 132. Setting Up DX8100 for Maximum IPS Recording
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7. Click the Frame Rate configuration button. The Frame Rate Configuration screen is displayed.

Figure 133. Frame Rate Configuration Screen

8. Do the following:

a. Using the ALL frame rate settings slider, set the frame rate to 30 ips. The recording rate for each enabled camera is changed to 30 ips.

b. For the ALL resolution setting, from the drop-down box, select 704 x 480 from the drop-down box. The resolution for each enabled 
camera is set to 704 x 480.

c. Click OK.

9. Click Apply at the Schedule page, and verify that each enabled camera listed in the Site Tree is configured to record at 30 ips at 4CIF.

Figure 134. Maximum Rate and Resolution Recording
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Understanding the DX8100 Frame Rate Calculations
The DX8100 uses a complex algorithm to calculate the amount of recording resources available for each channel. This calculation takes into 
account factors such as the number of enabled cameras; whether uniform or mixed resolution values are used; recording type (continuous, alarm, 
or motion); and the frame rate settings of enabled channels. The resulting calculations provide the operator with a margin of available frame rate 
capacity to distribute among the recorder’s channels. This margin of frame rate capacity, or “headroom,” is presented to the user as color-filled 
sections of the frame rate sliders. White areas on the slider represent frame rate capacity that is not available to that channel. In certain cases, 
adjusting the available frame rates of one channel or resolution type may free up capacity for other channels. Figure 135 shows the available and 
unavailable frame rate capacity.

Figure 135. Example of Frame Rate Capacity

Table AK describes the available and unavailable frame rate capacity.

SETTING UP ADVANCED RELAY OUTPUT
Relays work much like switches. When triggered, relays can activate external devices such as sirens, light fixtures, and door locks. The 
DX8100 Series HVR allows Administrators and Power users to link relays to cameras and alarms. Up to 20 seconds of delay can be set from the 
moment an event is triggered to the time when a relay is activated.

Make sure you have linked relays to the appropriate cameras and alarm inputs before attempting to configure them. For instructions on linking 
alarms and relays, refer to Linking Alarm Inputs to a Camera on page 39 and Linking Relay Outputs to Alarm Inputs on page 40.

This section describes how to setup advanced alarm and motion relay output and includes the following topics:

• Configuring Advanced Motion-Activated Relay Output 

• Configuring Advanced Alarm-Activated Relay Output on page 165 

• Configuring Advanced ATM/POS-Activated Relay Output on page 166 

• Configuring Advanced Video Loss-Activated Relay Output on page 167

Configuring Advanced Motion-Activated Relay Output
To configure a motion relay output:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click Schedule button . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Motion tab.

5. Configure each relay that is linked to a camera:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box. 

6. Click Save.

Table AK.  Frame Rate Capacity

Item Description

Available frame rate capacity

Unavailable frame rate capacity

� �
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7. Click Exit.
 

Figure 136. Linking Relays to Motion Detection

Table AL describes the available motion-activated relay settings.

Table AL.  Motion-Activated Relay Settings

Option Result

Disable Relay will not activate when motion is detected.

Follow Event Relay will activate at the exact moment that motion is detected.

1, 3, 5, 10, 15, and 20 Seconds Sets the amount of time the relay will remain active after motion has been detected.

� 5a5a

5b
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Configuring Advanced Alarm-Activated Relay Output
To configure an alarm relay output:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click Schedule button . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Alarm tab if it is not already selected.

5. Configure each relay that is linked to an alarm:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box. 

Figure 137. Linking Relays to Alarms

Table AM describes the available alarm-activated options.

Table AM.  Alarm-Activated Relay Settings

Option Result

Disable Relay will not activate when the alarm is triggered.

Follow Event Relay will activate at the exact moment the alarm is triggered.

1, 3, 5, 10, 15, and 20 Seconds Sets the amount of time the relay will remain active after the alarm has been triggered.

� 5a

5b
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Configuring Advanced ATM/POS-Activated Relay Output
To configure an ATM/POS-activated relay output:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click Schedule button . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the ATM/POS tab if it is not already selected.

5. Configure each relay that is linked to an ATM/POS:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box.

Figure 138. Linking Relays to ATM/POS

Table AN describes the available ATM/POS-activated relay options.

Table AN.  ATM/POS-Activated Relay Settings

Option Result

Disable Relay will not activate when the ATM/POS event occurs.

Follow Event Relay will activate at the exact moment the ATM/POS event occurs.

1, 3, 5, 10, 15, and 20 Seconds Sets the amount of time the relay will remain active after the ATM/POS event occurs.
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Configuring Advanced Video Loss-Activated Relay Output
To configure an advanced video loss-activated relay output:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click Schedule button . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Video Loss tab if it is not already selected.

5. Configure each relay that is linked to an alarm:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box.

Figure 139. Linking Relays to Video Loss

Table AO describes the available video loss-activated relay settings.

Table AO.  Video Loss-Activated Relay Settings

Option Result

Disable Relay will not activate when a video loss event occurs.

Follow Event Relay will activate at the exact moment the video loss event happens.

1, 3, 5, 10, 15, and 20 Seconds Sets the amount of time the relay will remain active after the video loss event occurs.

� 5a5a
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SETTING UP NETWORK PROPERTIES
The DX8100 networking capability allows you to network up to five DX8100s. You can configure such networking options as follows:

• Configuring the DX8100 for Network Access

• Setting Up DHCP

• Setting Up a Static IP Address

• Setting Up TCP/IP and Bandwidth Throttle

• Setting Up DNS/WINS

• Working with Time Synchronization on page 172

• Setting Up COM1 Port Properties

This section describes how to set up DX8100 network communication and includes the following topics:

• Configuring the DX8100 for Network Access on page 168

• Setting Up TCP/IP and Bandwidth Throttle on page 170 

• Working with Multicasting on page 170

• Accessing Network Information on page 171 

• Setting Up DNS/WINS on page 172

CONFIGURING THE DX8100 FOR NETWORK ACCESS
Using the TCP/IP protocol, up to five DX8100 Series HVRs can be networked for remote viewing and management. In addition, up to five 
simultaneous computer, Web, and mobile clients can connect to each HVR. The DX8100 Series HVR supports both static IP addressing and 
dynamic addressing through DHCP. Consult your network administrator for more information about IP address configuration.

The system must be turned on and connected to a secured private network, and you must be logged in with either Power User or Administrator 
access to configure network software settings. You must reboot the HVR for any network configuration changes to take effect.

This section describes how to setup network access and includes the following topics:

• Setting Up DX8100 Network Access 

• Setting Up DHCP on page 169 

• Setting Up a Static IP Address on page 170

Setting Up DX8100 Network Access
To begin the network setup process:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network button . The Network page is displayed.

3. Click the Network tab if it is not already selected.

4. Enter a new name for your HVR in the Site Name box. (Site names can be up to 30 characters in length; the default site name is DX8100.)

5. Enter a unique System ID for your HVR in the System ID field. (System IDs must start with a letter, be 15 characters or less, and not include 
spaces or special characters.)

Your HVR’s site name is used to identify your system to clients and other DX8100 servers. Your HVR’s system ID is used to uniquely identify 
your system on a LAN. System IDs are required to prevent possible conflicts with other network devices.
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6. Set up the. For information about setting up DHCP or static IP addressing, refer to Setting Up DHCP on page 169 or Setting Up a Static IP 
Address on page 170.

Figure 140. Network Setup Page

Setting Up DHCP
Your network must support DHCP, and an active DCHP server must be present for dynamic addressing to work. If you select DHCP and your 
network does not include an active DHCP server, the IP address settings will default to addresses in the 169.254.x.x range. Consult your network 
administrator for more information. 

Access the Network page to set up the DHCP options. For information about accessing the Network page, refer to Setting Up DX8100 Network 
Access on page 168.

To configure the HVR to acquire a dynamic IP address through DHCP:

1. In the Network page, click the check box labeled Obtain An IP Address Automatically (DHCP).

2. Click Apply.

� 	�
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Setting Up a Static IP Address
The DX8100 allows you to set up a static IP address. This information can be obtained from your network administrator.

Access the Network page to set up the static IP address. For information about accessing the Network page, refer to Setting Up DX8100 Network 
Access on page 168.

To set up a static IP address:

1. In the Network page, verify that the Obtain An IP Address Automatically (DHCP) check box is not selected. 

2. In the IP Address box, enter a unique IP address (for example, 10.10.0.170). The last three digits must be different for each recorder (for 
example, 171, 172, 173, and so forth).

3. In the Subnet Mask box, enter the subnet mask (for example, 255.0.0.0 is the default).

4. In the Default Gateway box, enter the gateway address (the IP address of the default router on your immediate network segment).

5. Click Apply.

SETTING UP TCP/IP AND BANDWIDTH THROTTLE
The DX8100 uses the TCP/IP networking protocol to communicate over LAN and WAN networks. TCP/IP uses logical network ports to organize 
data transmissions and to ensure that data packets are delivered to the proper application. For example, e-mail is traditionally delivered through 
TCP/IP port 25 and Web pages through port 80. 

Table AP describes the ports assigned to direct video and control information into and out of the DX8100. You should keep port numbers set at 
their default values unless there is a known conflict with your existing network infrastructure. Consult your network administrator before 
changing any port information about the DX8100.

Access the Network page to set up the TCP/IP DHCP and bandwidth throttle options. For information about accessing the Network page, refer to 
Setting Up DX8100 Network Access on page 168. Consult your network administrator before assigning or changing port numbers. Make sure that 
the ports are not blocked internally but are protected from external threats by a firewall. Client and server ports must be identical.

To configure the base port and software upgrade port:

1. If necessary, in the DX8100 Base Port box, enter a new base port number (9002 is the default). 

2. If necessary, in the Software Upgrade Port box, enter a new software upgrade port (9003 is the default).

3. If necessary, in the Information Port box, enter a new information port (9005 is the default).

4. To set the network bandwidth throttle to limit the amount of network resources allocated to client connections, drag the network bandwidth 
throttle slider to the desired value. (Client bandwidth can be adjusted from a minimum of 64 Kbps to a maximum of 10 Mbps in increments 
of 64 Kbps.)

5. Click Apply.

WORKING WITH MULTICASTING
The DX8100 supports a layer 2 multicast feature that allows the multicast and unicast mode to co-exist. In this case, the DX8100 Web Client and 
DX8100 Client software can connect to a DX8100 server simultaneously. The recommended multicasting IP range is from 224.0.1.1 to 
224.0.1.253. If the DX8100 server is not configured to operate in the multicast mode, then the DX8100 network automatically uses the unicast 
protocol. 

Table AP.  TCP/IP Ports Used by the DX8100

Port Number User Changeable Description

9002 Yes Base port for transmission of video, audio, and interface data

9003 Yes Software upgrades

9004 Yes Emergency agent notifications

9005 No Information port 

13900 No Ping port
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The DX8100 layer 2 multicast feature conserves bandwidth and reduces network traffic by simultaneously delivering one stream of data to an 
unlimited number of connections. 

This section describes the DX8100 layer 2 multicasting feature and is organized into the following topics:

• Multicast Requirements

• Enabling Multicasting on page 171

Multicast Requirements
The DX8100 multicast feature has the following requirements:

Enabling Multicasting
The recommended multicasting IP range is from 224.0.1.1 to 224.0.1.253. 

To enable multicasting:

1. In the Network page, click the check box labeled Enable Multicasting.

2. In the Multicast Group IP box, enter the multicast group IP address.

3. Click Apply. The DX8100 message dialog box opens, prompting you to restart the DX8100.

4. Do one of the following:

• Click Yes to restart the DX8100.
• Click No to cancel the restart action. If you exit the Network page, you are not prompted to apply the previous settings. If you open the 

Network page again, the Enable Multicasting check box is selected. However, the DX8100 must still be restarted to activate the 
multicasting mode. 

ACCESSING NETWORK INFORMATION
Access the Network page to view DX8100 network settings. For information about accessing the Network page, refer to Setting Up DX8100 
Network Access on page 168. 

To access network information, such as IP and default gateway addresses:

1. In the Network page, click Network Information. The IP Configuration information box appears.

2. Click OK to return to the Network page.

Table AQ.  DX8100 Multicast Requirements and Operation

Item Description

Network equipment The switch or router must support layer 2 multicasting.

Network requirements • The DX8100 Web Client establishes multicast connections with DX8100 servers in its own VLAN.

• The network must support Internet Group Management Protocol (IGMP).

• The number of DX8100 Web Client connections is unlimited.

Operation • Initially, the DX8100 Web Client uses the IP address of the target DX8100 server (using the TCP port) to 
establish a connection to the DX8100. After the connection is established, the session switches from 
using TCP to using User Data Protocol (UDP). 

• Since the Web Client connection is using UDP, the user does not have to log in or out of the DX8100 
server. The Web Client displays the connection status: connected or disconnect.

• The PTZ feature is not available. 

• The Web Client displays only the camera name in the Site Tree. All other camera recording details, such 
as the recording mode, resolution, recording rate, and so forth are not displayed. 

• The camera name and DX8100 server information is not updated until a new connection to the DX8100 
is initiated. 

• The Web Client monitors the UDP socket every 10 seconds to ensure that live data is being received. 
If live data is not received within 30 seconds, the Web Client will disconnect from the DX8100 server 
after two minutes and automatically reconnect to the DX8100.
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SETTING UP DNS/WINS
The DX8100 allows you to set up DNS or WINS services, if your network supports these services. Access the Network page to configure DX8100 
DNS/WINS services. For information about accessing the Network page, refer to Setting Up DX8100 Network Access on page 168.

To set up DNS/WINS: 

1. In the Network page, click the DNS/WINS tab. The DNS/WINS page is displayed.

2. Do one of the following:

• If you are using dynamic IP addressing through a DHCP server, click the “Obtain DNS/WINS info from DHCP” check box.
• If you are using static IP addressing, provide the following information in the appropriate fields. This information can be obtained from 

your network administrator.
(1) Primary DNS server IP address

(2) Secondary DNS server IP address

(3) Primary WINS server IP address

(4) Secondary WINS server IP address 

3. Click Apply to update the configuration.

WORKING WITH TIME SYNCHRONIZATION
The DX8100 supports the Simple Network Time Protocol (SNTP), which allows the DX8100 to access Network Time Protocol (NTP) servers to 
synchronize DX8100 clocks. The DX8100 allows you to manually or automatically synchronize its time to an NTP time server. Additionally, the 
DX8100 server can provide time synchronization for the other DX8100 network. There can be only one NTP time server in the DX8100 network.

This section describes how to synchronize the DX8100 clock and is organized into the following topics:

• Adding an NTP Time Server on page 173

• Editing an NTP Time Server on page 174

• Deleting an NTP Server on page 175

• Comparing the DX8100 and NTP Server Time on page 175

• Manually Synchronizing the DX8100 Time on page 175

• Setting Up Automatic Time Synchronization on page 176

• Enabling Database Overwrite on page 176
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Adding an NTP Time Server
To add an NTP time server:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network button . The Network page is displayed.

3. Click the NTP tab.

4. Do the following:

a. Click Add/Edit/Delete. The NPT Server List dialog box opens.

Figure 141. NTP Server List Dialog Box

b. Click Add. The Add/ Edit NTP Server dialog box opens.

Figure 142. Add / Edit NTP Server Dialog Box
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c. To select the NTP server, do one of the following:

• Do nothing and accept the default SNTP Server option button. In this case, an NTP server is used to provide time 
synchronization.

• Click the DX8100 NTP Server option button to select the DX8100 to provide time synchronization for the network.

d. To specify the NTP server addressing, do one of the following:

• If the DX8100 NTP Server option is selected, the URL option is not available. In this case, the IP option button is automatically 
selected and you must provide the DX8100 NTP Server IP address. 

or

• If the SNTP Server options is selected, you can do nothing and accept the default URL option button. In this case, you must enter 
the SNTP Server URL.

• Click the IP option button and enter the SNTP Server IP address. 

e. Enter either the NTP server URL or IP address. 

f. Accept the default NPT server port number or enter a port number.

5. Click OK. The DX8100 attempts to locate the NTP server. If successful, the NTP server is added to the NTP Server List. The DX8100 displays 
the message “NTP server not found” if the server cannot be located.

Editing an NTP Time Server
To edit an NTP time server:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network button . The Network page is displayed.

3. Click the NTP tab. The NTP page is displayed.

Figure 143. Editing an NTP Time Server

4. In the NTP Server drop-down box, select an NTP server.

5. Click Add / Edit / Delete. The NTP Server List dialog box opens.

6. In the Server List, select a server.

7. Click Edit. The Add / Edit NTP Server dialog box opens.

8. Make the desired change. 

9. Click OK. 

10. Click Apply.
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Deleting an NTP Server
To delete an NTP time server:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network button . The Network page is displayed.

3. Click the NTP tab. The NTP page is displayed.

4. In the NTP Server drop-down box, select an NTP server.

5. Click Add/Edit/Delete. The NTP Server List dialog box opens.

6. In the Server List, select a server.

7. Click Delete. The selected server entry is deleted.

8. Do one of the following:

• To accept the deletion and close the dialog box, click OK.
• To reject the deletion and close the dialog box, click Cancel.

9. Make the desired change. 

10. Click Apply. 

Comparing the DX8100 and NTP Server Time
The DX8100’s “check the difference” feature allows you to quickly compare its time with an external time source.

To compared the DX8100’s time with an external time source:

1. On the DX8100 toolbar, click Setup. The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network. The Network page is displayed.

3. Click the NTP tab. The NTP page is displayed.

4. In the NTP Server drop-down box, select an NTP server.

5. Click “Check the Difference.” The difference between the DX8100 server and NTP Server time is displayed in the Difference time area.

Manually Synchronizing the DX8100 Time
You can manually synchronize the DX8100 to an external time source. You do not have to enable the NTP service, but you do need access to an 
NTP time server.

To manually synchronize the DX8100 to an external time server:

1. On the DX8100 toolbar, click Setup. The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network. The Network page is displayed.

3. Click the NTP tab. The NTP page is displayed.

4. In the NTP Server drop-down box, select an NTP server. For information about adding an NTP time server, refer to Adding an NTP Time 
Server on page 173.

5. Click Synchronize Clock Immediately. The DX8100 time is synchronized to the NTP time server.
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Setting Up Automatic Time Synchronization
You can configure the DX8100 to be automatically synchronized to an NTP time server. You can also set the synchronization interval from zero to 
23 hours and 59 minutes. In this case, you have to enable the NTP service and synchronize time in intervals options. 

To automatically synchronize the DX8100 to an external time server:

1. On the DX8100 toolbar, click Setup. The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network. The Network page is displayed.

3. Click the NTP tab. The NTP page is displayed.

4. In the NTP Server drop-down box, select an NTP server. For information about adding an NTP time server, refer to Adding an NTP Time 
Server on page 173.

5. Do the following:

a. To synchronize the DX8100 upon startup, click the Auto-start/Synchronize When System Starts check box.

b. Click the Synchronize Time in Intervals [H:M] check box.

c. In the Synchronize Time in Intervals [H:M] spin box, set the interval in hours and minutes.

d. Click the Enable NTP Service check box.

6. Click Apply.

Enabling Database Overwrite
In the event that the DX8100 time is reset to a period earlier than the current time, the DX8100 allows you to do one of the following:

• Database Overwrite: Enabling this option causes the DX8100 to overwrite previously recorded data, coincide with the time at which the 
clock is turned back. For example, if at 2:00 p.m. (current time) you set back the DX8100 clock to 1:30 p.m. (an earlier time), the previously 
recorded data beginning at 1:30 p.m. is overwritten.

• Select not to enable Database Overwrite: If this option is not enabled, previously recorded data is not overwritten. For example, if at 
2:00 p.m. (current time) you set back the DX8100 clock to 1:30 p.m. (an earlier time), the DX8100 does not record data between 1:30 p.m. 
and 2:00 p.m. In this case, any video events occurring during that half-hour time period are not recorded. Recording does not begin again 
until after the DX8100 clock exceeds 2:00 p.m.

To enable Database Overwrite:

1. On the DX8100 toolbar, click Setup. The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network. The Network page is displayed.

3. Click the NTP tab. The NTP page is displayed.

4. Click the Database Overwrite check box to select the option.
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SETTING UP PORT AND DEVICE COMMUNICATION PROPERTIES
The system must be powered on, and you must be logged in as a Power User or Administrator to configure communication port settings. Refer to 
the instructions that came with your peripheral device for correct settings. 

This section describes how to set up port and device communication properties including the following topics:

• Understanding the Port/Device Page 

• Setting Up ATM/POS Device Communication Ports on page 179 

• Setting Up RS-422/RS-485 Communication Port Properties on page 180

• Installing or Updating Device Protocols on page 200

UNDERSTANDING THE PORT/DEVICE PAGE
This section describes the Port/Device page. Figure 144 shows the parts of the Port/Device page.

Figure 144. Port/Device Page
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Table AR describes the parts of the Port Device page.

Table AS describes the ports and the associated serial data communication standard they support.

• For COM1: RS-232 is the default serial data standard.

• For Port 1 to 4: RS-422 and RS-485 are the available serial data standards.

Table AR.  Parts of the Port Device Page

Item Part Description

Port Communications port drop-down box, where you select the port for connecting a device to the DX8100. 
The available choices are as follows:

• COM1: Uses RS-232 serial data standard. 

• Port 1 to 4: Uses either RS-422 or RS-485 serial data standard.

Device Attached device drop-down box, where the type of device is selected to be interfaced to the DX8100 
through the communication port.

Configure Device configuration button that opens the Device Configuration dialog box. The Device Configuration 
dialog box performs two functions, depending on the type of device selected.

• KBD300A and dome devices: only displays device configuration information. 

• ATM/POS devices: allows you to configure ATM/POS device options and parameters for the selected 
device. 

Install Protocol installation button that opens the Protocol Install dialog box. The Protocol Install dialog box allows 
you to do the following:

• View the current device protocols already installed.

• Update the device protocols.

Interface Mode Interface mode drop-down box that allows you to select the serial data standard for the selected device. 
The DX8100 supports COM1 (RS-232) and Port 1 to Port 4 (RS-422/RS-485). 

Baud Rate Baud rate drop-down box that allows you to select the baud rate for each device. Available baud rates are 
as follows: 1200, 2400, 4800, 9600, 19200, 28800, 38400, 57600, or 115200.

Parity Parity drop-down box. You select the parity for none, odd, or even.

Data Bits Data bits drop-down box. Configure the number of data bits for 5, 6, 7, or 8.

Stop Bits Stop bits drop-down box. Select the number of stop bits for 1 or 2.

Table AS.  DX8100 Ports and Serial Data Communication Standards

Port
Serial Data Standard Supported

RS-232 RS-422 RS-485

COM1

1

2

3

4
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SETTING UP ATM/POS DEVICE COMMUNICATION PORTS 
The DX8100 allows you to use both the COM1 (RS-232) port and Port 1 to Port 4 (RS-422/RS-485) to connect ATM/POS devices. Typically, Port 1 
to Port 4 are used to connect the KBD300A and dome devices.

This section describes how to select and configure the ATM/POS device communication port and includes the following topics:

• Setting Up COM1 Port Properties 

• Selecting the ATM/POS Device Mode and Communications Options on page 181 

• Setting Up an ATM/POS Data Format on page 186 

• Assigning a Data Format to an ATM/POS Device on page 190 

• Setting Up ATM/POS Exceptions on page 191

• Verifying the ATM/POS Communication Connection on page 196

Setting Up COM1 Port Properties
This topic describes how to set up COM1 communication port properties. Access the Network page to configure the communication ports. For 
information about accessing the Network page, refer to Setting Up DX8100 Network Access on page 168. For information about the Port/Device 
page, refer to Setting Up Port and Device Communication Properties on page 177.

Table AT describes the COM1 port properties.

To set up COM1 communication properties:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select COM1. RS-232 is the serial data communication standard. 

3. In the device drop-down box, select a device.

4. Configure the following COM port settings using the drop-down boxes provided.

• Interface mode: RS-232 is the only allowed setting by default.
• Baud rate
• Parity
• Data bits
• Stop bits

5. Click Apply.

Table AT.  COM1 Port Properties

Property Selection

Interface Mode RS-232 (default)

Baud Rate 1200, 2400, 4800, 9600, 19200, 28800, 38400, 57600, or 115200

Parity None, Odd, or Even

Data Bits 5, 6, 7, or 8

Stop Bits 1 or 2
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Setting Up RS-422/RS-485 Communication Port Properties
The DX8100 interfaces with the KBD300A, ATM/POS, and third-party dome devices using Port 1 to Port 4. All ports are compatible with both 
RS-422 or RS-485 serial data communication standard. This setting describes how to connect a device to the DX8100 using Port 1 to Port 4. 
Access the Network page to configure Port 1 to Port 4 communication properties. For information about accessing the Network page, refer to 
Setting Up DX8100 Network Access on page 168. For information about the Port/Device page, refer to Setting Up Port and Device 
Communication Properties on page 177.

To configure Port 1 to Port 4 properties: 

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select the port number you want to configure. 

3. In the device drop-down box, select a device. 

ATM/POS devices can use COM1 and Port 1 to Port 4. The KBD300A and third-party dome devices use Port 1 to Port 4. For information 
about interfacing ATM/POS devices to the DX8100 using COM1, refer to Setting Up COM1 Port Properties on page 179.

4. Configure the following port settings using the drop-down box.

• Interface mode
• Baud rate
• Parity
• Data bits
• Stop bits

5. Click Apply.

SETTING UP ATM/POS DEVICE PROPERTIES
The DX8100 allows you to connect up to 16 ATM/POS devices and provides 2 ATM/POS device modes: 

• Single Mode: Use this option to connect up to 4 ATM/POS devices to the DX8100.

• Multi Mode: Use this option to connect up to 16 ATM/POS devices to the DX8100 over one serial connection. 

Single Mode and Multi Mode can be combined to connect up to 16 ATM/POS devices to the DX8100. For information about installing the 
ATM/POS equipment for each mode, refer to the DX8100 Installation manual.

This section describes how to configure ATM/POS device properties and includes the following topics:

• Selecting the ATM/POS Device Mode and Communications Options 

• Setting Up an ATM/POS Data Format

• Assigning a Data Format to an ATM/POS Device on page 190

• Setting Up ATM/POS Exceptions on page 191

• Verifying the ATM/POS Communication Connection on page 196

• Recording ATM/POS Events on page 197
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Selecting the ATM/POS Device Mode and Communications Options
This section describes the complete process for configuring DX8100 ATM/POS device communication options. For additional information about 
each phase of the configuration process, refer to the following topics: 

• Setting Up an ATM/POS Data Format

• Assigning a Data Format to an ATM/POS Device on page 190

• Setting Up ATM/POS Exceptions on page 191

• Verifying the ATM/POS Communication Connection on page 196

• Recording ATM/POS Events on page 197

To select the device mode and set up the ATM/POS communications options: 

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. Do one of the following:

• Single Mode: In the Communication Port drop-down box, select a port (COM1, Port 1, Port 2, Port 3, or Port 4).
• Multi Mode: In the Communication Port drop-down box, select COM1. 

If you select COM1, the Interface Mode option is unavailable and is set to RS-232C by default.

3. In the device drop-down box, select ATM/POS and configure the port settings for Interface mode (the default setting is RS232C for COM1), 
Baud Rate, Parity, Data Bits, and Stop Bits.

Figure 145. Multi Mode Communication Port Settings

4. In the Port/Device page, do the following:

a. In the Communication Port Configuration section, click Configure. The Device Configuration dialog box opens.

b. In the Device Mode drop-down box, select either Single Mode (the default setting) or Multi Mode.
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5. In the Device Configuration page, do the following:

a. Click Data Format. The Data Format List page is displayed. By default, the ER-650 data format is selected. You can modify the ER-650 
data format or create a new format.

Figure 146. Default Data Format List Page

b. Configure a data format:

• To use and modify the ER-650 format, highlight the data format, and then click Edit.
• To start a new data format, click Add. 

The Data Format dialog box opens.

c. In the Data Format Name box, type a name.

Figure 147. Modified ER-650 Data Format Dialog Box
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d. Using the information from the transaction record or other source, set the parameters for the following Data Format sections (as 
applicable):

• Transaction Format
• Monetary Format
• Time Format
• Character Format

e. Click OK. The new or updated data format appears in the Data Format List.

Figure 148. Data Format List

6. In the Device Configuration page, do the following:

a. Click the Settings tab. The Available ATM/POS Device table is displayed.

b. In the Device ID column, click an ATM/POS device to select it.

c. Double-click the Data Format cell for the selected ATM/POS device. The Data Format cell drop-down box is displayed.

d. Click the Data Format cell to display the available data formats.

e. Select the data format you want to assign to the ATM/POS device.
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7. In the Protocol column, do the following:

a. Double-click the Protocol cell for the selected ATM/POS device. The Protocol cell drop-down box is displayed.

b. Click the Protocol cell to display the available protocols.

c. Select the protocol you want to assign to the ATM/POS device.

8. Do one of the following:

• Click Apply to save your settings without closing the Device Configuration dialog box.
• Click OK to save your settings and return to the Port/Device page.

Figure 149. Assigning the Data Format ATM/POS Devices

9. Click the Linking button . The Linking setup page is displayed.
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10. Click the Event-Recording Link Settings tab. The Event-Recording Link Settings page is displayed.

Figure 150. Event-Recording Link Settings Page

11. In the ATM/POS Record Link Settings section, do the following:

a. In the ATM/POS Address drop-down box, select an ATM/POS address. Each ATM/POS address corresponds to a unique Regcom box 
device ID. Each device ID must be assigned to a specific HVR camera channel.

b. In the “Enable Record/Live on Source ATM/POS Event” section, click a camera to link the camera to the ATM/POS address.

c. Click Apply.

12. Click the Schedule button . The Schedule setup page is displayed.
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13. Create an ATM/POS schedule for the camera you linked to the ATM/POS address.

Figure 151. Schedule Setup Page

For information about verifying that the ATM/POS configuration is set up correctly, refer to Verifying the ATM/POS Communication Connection on 
page 196.

Setting Up an ATM/POS Data Format
The DX8100 allows you to create a data format for each ATM/POS device. You can assign a unique name to each data format. The data format 
values determine how data from ATM or POS terminals is interpreted. This information is used to separate the data stream into individual 
transactions and separate the various fields within the transaction. Every field format must match that of the ATM or POS device, especially the 
month format.

Access the Network page to configure the data format. For information about accessing the Network page, refer to Setting Up DX8100 Network 
Access on page 168. For information about the Port/Device tab, refer to Setting Up Port and Device Communication Properties on page 177.

This section describes how to create a data format template and includes the following topics:

• Understanding the Data Format Page

• Creating a New Data Format on page 189

• Editing a Data Format on page 189 

• Deleting a Data Format on page 190 
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Understanding the Data Format Page

The DX8100 allows you to create a device data format for each ATM/POS device. You can assign a unique name to each device data format 
template. 

Figure 152 shows the parts of the Data Format page. Access the Data Format page from the Port/Device page. For information about accessing 
the Data Format page, refer to Setting Up DX8100 Network Access on page 168. For information about the Port/Device tab, refer to Setting Up 
Port and Device Communication Properties on page 177.

Figure 152. Data Format Page
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Table AU describes the parts of the Data Format page.

Table AV describes the transaction start and end parameters.

Table AU.  Parts of the Data Format Page

Item Command Description

Data Format Name Box where a specific name for the data format template is created.

Transaction Format Includes the following options:

• Transaction Number: Allows a transaction symbol to be entered.

• Transaction Start: Selects the control character for indicating the start of a transmission.

• Transaction End: Selects the control character for indicating the end of a transmission.

• The end of text string (Decimal): Specifies the type of control character that marks the end of a 
transaction line. Decimal 13 represents the ASCII CR control character. 

• User String: Allows you to enter an end-of-line string.

Monetary Format Includes the following options:

• Monetary Unit: Box for entering the monetary symbol.

• Thousand Separator: Symbol used in transaction data to separate number by thousands.

• Decimal Separator: Symbol used in transaction data to separate dollars and cents.

Time Format Allows you to set the following options to match those in the transaction data:

• Date: Selects the date format.

• Month Type: Selects the month format.

• Time: Selects the time format.

• Time Period: Selects the time period, 12- or 24-hour.

Character Format Allows you to specify a character filter:

• Special Device Character: Not available at this time.

• Custom Device Filter: Contains the character filter.

• Add: Moves the character filter into the Custom Device Filter table.

• Delete: Deletes the selected filter in the Custom Device Filter table

• Control Code: Contains a selection of control codes for creating a desired filter

• Special Character: Contains a selection of characters for creating a desired filter

• Range: Not applicable.

Table AV.  Transaction Start and End Parameters

Value Description

None First part of transaction field is not used.

CR Carriage return character (13 in ASCII).

LF Line feed character (10 in ASCII).

FF Form feed character (12 in ASCII).

DATE Date field.

TIME Time field.

TEXT Ten selected; another field appears to let you enter a text string (up to 
20 characters) that defines the start of the transaction.
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Using Custom Device Filters

The DX8100 allows you to use a custom device filter to remove unwanted characters from the data input port. These characters may be printer 
commands or some other type of device control/overhead. Each entered line of text in the Custom Device Filter table defines a separate 
character filter. A filter can be a combination of exact characters to match, character ranges to match, and character counts. Incoming characters 
matching any of the character filters will be discarded.

Use the Control Code drop-down box, Special Character drop-down box, and Range box to create the desired filter. Then click the Add button to 
transfer the created filter to the Custom Device Filter table. 

Creating a New Data Format

Create the data format based on information contained in the ATM/POS transaction. For example, a sales receipt provides detailed transaction 
information. The data format values determine how data from ATM or POS terminals is interpreted. This information is used to separate the data 
stream into individual transactions and separate the various fields within the transaction. Every field format must match that of the ATM or POS 
device, especially the month format.

To create a data format:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Data Format tab.

6. In the Data Format page, click Add. The Data Format dialog box opens.

7. Using the information from the transaction record or other source, set the parameters for the following Data Format sections (as 
applicable):

• Transaction Format
• Monetary Format
• Time Format
• Character Format

8. Click OK. 

9. Verify that the new data format is listed in the Data Format List, on the Data Format page. 

Editing a Data Format

The DX8100 allows you to edit a data format. Once you click OK to accept the changes, you cannot undo the changes. 

To edit an existing data format:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. In the Data Format List, highlight the name of a data format.

6. Click Edit. The Data Format dialog box opens.

7. Make sure the correct data format name appears in the Data Format Name box.

8. Perform the edits.

9. Do one of the following:

• To accept the changes, click OK.
• To not accept the changes, click Cancel.
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Deleting a Data Format

To delete an existing data format:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Data Format tab. The Data Format List page is displayed.

6. In the Data Format List, highlight the name of a data format.

7. Click Delete. A DX8100 message box is displayed prompting you to confirm deletion of the data format.

8. Do one of the following:

• To delete the data format, click Yes.
• To not accept the deletion, click No or Cancel.

Assigning a Data Format to an ATM/POS Device
After you have created a data format, you can assign it to a specific ATM/POS device. 

To assign an existing data format to a specific ATM/POS device:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Settings tab. The Available ATM/POS Device setup table is displayed.

6. In the Data Format column, do the following:

a. In the Device ID column, click the check box to select an ATM/POS device.

b. Double-click the Data Format cell for the selected ATM/POS device. The Data Format cell drop-down box is displayed.

c. Click in the Data Format cell to display the available data formats.

d. Select the data format you want to assign to the ATM/POS device.
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e. Do one of the following:

• Click Apply to confirm selection and remain in the Device Configuration dialog box.
• Click OK to confirm selection and return to the Port/Device page.

Figure 153. Assigning a Data Format to an ATM/POS Device

Setting Up ATM/POS Exceptions
An exception is a predefined transaction filter used to detect a specific data structure within the ATM/POS transaction data. Exceptions are 
configured on the Advanced page. 

To use an exception to search transaction data, the exception must be created, before recording the transaction data. If the transaction data is 
recorded before the exception filter is defined, the exception filter will not find the data structure within the transaction data.

The DX8100 allows you to configure unique exceptions for each ATM/POS device from the following:

• ATM/POS device selection drop-down box

• Exception table that contains the name and effect of each exception you create

• Action code drop-down box that contains exception action codes

• User mapping table where you create the string for the action code

Use the Advanced tab to configure exceptions. Entries are case sensitive. For each defined data device ATM device or POS terminal, you can 
specify up to 31 data exceptions. A field left blank is not used in the exception. Any fields containing values must all be found or satisfied before 
a data device exception is generated. Each data device can trigger the DX8100 to record at special rates and for a special length of time, as 
determined in the Record On Data Exceptions screen.

This section describes how to work with exceptions and includes the following topics:

• Using Action Codes

• Creating an ATM/POS Exception on page 193 

• Editing an ATM/POS Exception on page 195 

• Deleting an ATM/POS Exception on page 195 

• Assigning an Exception to An ATM/POS Device on page 196 
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Using Action Codes

To use an action code to search transaction data, the action code must be created, before recording the transaction data. If the transaction data 
is recorded before the action code is defined, the action code will not find the data structure within the transaction data.

Table AW The following table describes the ATM/POS action codes.

Table AW.  Action Codes

Code Description Code Description

AL ALL CODES (item or merchandise sold normally) GR GAS REFUND (refund of unused portion of gasoline 
prepayment) 

AM AMOUNT TENDERED (cash amount tendered) IM INFORMATION MESSAGES (displays message fields, as is)

CC CREDIT CARD (amount tendered with credit card) IT ITEM SALE TRANSACTION (displays message fields) 

CD CASH DROP (safe drop) LO LOTTERY PAYMENT (lottery pay out) 

CG CHARGE ACCT (amount added to charge account 
balance) 

LS LOTTERY (lottery sale) 

CH CHANGE (change due to customer) MT Not included

CK CHECK (amount tendered with check) NS NO SALE (no sale) 

CL CLERK NAME (and/or number) or CLERK LOGIN NT NEG TAX (negative tax) 

CM MFR COUPON (manufacturer coupon redemption) OT Description not available 

CP COUPON (store coupon redemption) OV OVERRIDE (override programmed price-displays message 
fields) 

CR CRITICAL CODES (determined by Action Critical) PL PRICE LOOKUP (displays message fields) 

CX CANCEL (cancel entire sale before completion) PO PAID OUT (pay out cash from register) 

DB DEBIT CARD (amount tendered with debit, ATM or credit) RA RCVD ON ACCT (customer payment toward charge account 
balance) 

DC DRAWER CLOSED (no display) RF REFUND (payment of refund to customer) 

DD DISCOUNT (discount entered as absolute amount) RT RETURN (merchandise returned) 

DO DRAWER OPEN (no display) ST SUBTOTAL (sale subtotal) 

DP DEPOSIT (deposit amount paid pending purchase) SX TAXABLE AMT (taxable subtotal) 

DR DEPOSIT RETURN (deposit return) TI CURRENT TIME (displays description field) 

DS PCT DISCOUNT (discount as percentage of cost or total) TK TRANSACTION RECEIPT NUMBER (displays description field) 

EI EMPLOYEE SIGN ON (to register) TN Tim Norris (publicly viewable) 

EO EMPLOYEE SIGN OFF (to register) TR NEGATIVE TOTAL (negative amount as the total) 

FC COMPLIMENTARY (complimentary or on-the-house 
charge) 

TT TOTAL (total amount due) 

FS FOODSTAMPS (amount tendered in food stamps, WIC, 
and so forth) 

TX TAX (tax amount) 

GA PREPAID GAS (gasoline prepayment after pumping) VD ERROR CORRECT (void of last item entered) 

GP GAS PREPAID (gasoline prepayment) VX VOID (correction of entered item within current transaction) 
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Creating an ATM/POS Exception

To create an ATM/POS exception:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Advanced tab. For information about the Advanced page, refer to Setting Up ATM/POS Exceptions on page 191.

6. In the ATM/POS Name drop-down box, select an ATM/POS device.

Figure 154. Advanced Page
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7. In the Exception Table section, click Add. The Exceptions dialog box opens.

Figure 155. Exceptions Dialog Box 

8. In the Exceptions dialog box, do the following:

a. In the Exception Name box, enter a name or description for the exception (up to 20 characters). 

b. In the Line Item box, enter the name of the line item (up to 20 characters). The line item entry is case-sensitive. If the transaction is 
displayed as all capital letters, then the line item entry must be in all capital letters.

The HVR will search for this entry anywhere in the transaction. ATM transactions do not usually contain line items. The program may 
display a “No data found” error message if searching ATM transactions using line items. If the line item box is blank, it is considered 
found or satisfied.

c. In the Modifier drop-down box, select a modifier that further defines the line item. 

A modifier must be selected before a value can be entered. If a modifier is not selected, the Value box is unavailable.

d. In the Value box, enter the value.

The value (9999.99 maximum) is used with the modifier (above) to trigger an exception. You can use a period to separate dollars and 
cents, but do not use a comma between thousands and hundreds.

e. In the This Exception Effect section, do one of the following:

• Accept the default display effect setting.
• In the Display Effect drop-down box, select Don’t Show or Show.

9. Click OK.
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10. At the Advanced page, do one of the following:

• Click Apply to confirm selection and remain in the Device Configuration dialog box.
• Click OK to confirm selection and return to the Port/Device page.

Editing an ATM/POS Exception

To edit an ATM/POS exception:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Advanced tab. For information about the Advanced page, refer to Setting Up ATM/POS Exceptions on page 191.

6. In the Exception Table, select an exception.

7. Click Edit. The Exceptions dialog box opens.

8. Edit the exception content.

9. Do one of the following:

• Click OK to accept the changes and exit the Exceptions dialog box.
• Click Cancel to exit the Exception dialog box and not save the changes.

Deleting an ATM/POS Exception

To delete an ATM/POS exception:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Advanced tab. For information about the Advanced page, refer to Setting Up ATM/POS Exceptions on page 191.

6. In the Exception Table, select an exception.

7. Click Delete. The DX8100 message box is displayed.

8. In response to the DX8100 message, do one of the following:

• Click Yes to delete the exception.
• Click No if you do not want to continue with the deletion.
• Click Cancel to discard the delete action.

Table AX.  ATM/POS Exception Modifiers

Modifier Description

None Value is not used and is disabled.

> Greater than: Trigger exception only if the value found on the line is greater than the value entered in the Value box.

< Less than: Trigger exception only if the value found on the line is less than the value entered in the Value box.

= Equal to: Trigger exception only if the value found on the line is equal to the value entered in the Value field.

!= Not equal to: Trigger exception only if the value found on the line is not equal to the value entered in the Value field.
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Assigning an Exception to An ATM/POS Device

To assign an exception to an ATM/POS device:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (Port 1 to Port 4). The device mode option is not available for COM1.

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Advanced tab.

6. In the ATM/POS Name drop-down box, select an ATM/POS device.

7. In the Exception Table, click the ID box of the exception you want to assign to the ATM/POS device.

8. Do one of the following:

• Click OK to accept the changes and exit the Exceptions dialog box.
• Click Cancel to exit the Exception dialog box and not save the changes.

Figure 156. Assigning an Exception to an ATM/POS Device

Verifying the ATM/POS Communication Connection
To verify that the ATM/POS connection is working correctly:

1. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

2. In the Communication Port drop-down box, select a port (COM1 or Port 1 to Port 4). 

3. In the selected device drop-down box, select an ATM/POS device.

4. In the Communication Port Configuration section, click Configure. The Device Configuration page is displayed.

5. Click the Diagnostics tab. 

6. In the ATM/POS Information section, select the ATM/POS device in the Device ID drop-down box.
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7. Do the following:

a. Verify that transaction data is displayed in the ATM/POS Raw Data View area. 

b. Verify that transaction data (as interpreted by the DX8100) is displayed in the Result Box.

Figure 157. Verifying the ATM/POS Communication Connection

Recording ATM/POS Events
To view POS recorded dates, the OSD POS view option must be selected at the View menu. For information about the POS option, refer to View 
Menu on page 26.

To record ATM/POS events:

1. Set up the ATM/POS device communication and do the following:

a. Assign the ATM/POS device to a COM port and set up COM port properties. For information, refer to Setting Up ATM/POS Device 
Communication Ports on page 179.

b. Select the ATM/POS device mode. For information, refer to Selecting the ATM/POS Device Mode and Communications Options on 
page 181

c. Create a data format for the ATM/POS device. For information, refer to Setting Up an ATM/POS Data Format on page 186. 

d. Assign the data format to the ATM/POS device. For information, refer to Assigning a Data Format to an ATM/POS Device on page 190.

e. Set up ATM/POS exceptions. For information, refer to Setting Up ATM/POS Exceptions on page 191.

f. Assign the exception to the ATM/POS device. For information, refer to Assigning an Exception to An ATM/POS Device on page 196.

g. Verify the ATM/POS communication connection. For information, refer to Verifying the ATM/POS Communication Connection on 
page 196.
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2. Setup a camera to record the ATM/POS events:

a. Set up the designated ATM/POS camera for scheduled ATM/POS recording. 

b. Configure the ATM/POS link settings.

c. Configure the ATM/POS record link settings.

d. (Optional) Configure the ATM/POS PTZ link settings.

3. In the DX8100 application window, do the following:

a. Assign a camera to a view pane. 

b. Assign the ATM/POS device to the camera designated to record ATM/POS events.

4. Verify the following:

a. The POS record indicator is yellow and flashing.

b. The ATM/POS record symbol flashes blue during an ATM/POS event.

c. The ATM/POS events are displayed yellow in the time line.

Figure 158. Recording ATM/POS Transaction

SETTING UP THE KBD300A KEYBOARD
The KBD300A allows you to operate certain DX8100 live view display functions and control camera PTZ operations from a keyboard rather than a 
mouse. 

When connected to the DX8100 server, the KBD300A supports two modes: standard and shift mode. Shift mode is entered by pressing the Shift 
button and is indicated by a lit Shift button LED. For information about how to operate the KBD300A, refer to the KBD300A universal keyboard 
Installation/Operation manual. For information about using the KBD300A, refer to Using the KBD300A Keyboard on page 66.

In summary, the steps required to set up the KBD300A for operation are as follows:

• Connect the KBD300A to the DX8100: For information about connecting the KBD300A to the DX8100, refer to the DX8100 Installation 
manual.
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• Configure the KBD300A communication settings

Configuring KBD300A Communication Settings
This section describes how to configure the KBD300A communication settings. The KBD300A is interfaced to the DX8100 using Port 1 to Port 4. 
These ports support connectivity to the DX8100 using the RS-422 data communication standard. A user-supplied RJ-45 cable is required. For 
information about using the KBD300A, refer to Using the KBD300A Keyboard on page 66.

To configure the KBD300A communication settings:

1. Connect the KBD300A to the DX8100 to a RS-422 RJ-45 port.

1. On the DX8100 toolbar, click the Setup button . The Setup dialog opens to the Camera page.

2. In the Setup dialog box, click Network button . The Network page is displayed.

3. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

4. In the Communication Port drop-down box, select the Port to which the KBD300A is connected.

5. In the device drop-down box, select KBD300A (Pelco).

6. Configure the following port settings.

• Interface mode: RS-422
• Baud rate: 9600
• Parity: ODD
• Data bits: 8
• Stop bits: 1

7. Click Apply.

KBD300A Standard Mode Operational Features

Table AY describes the KBD300A Standard Mode operational features.

Table AY.  KB300A Standard Operational Mode Features

Control Action

Joystick Controls the camera’s PTZ operation.

Number + PRESET (short) Moves camera to the programmed preset position.

Number + PRESET (long) Programs the current camera position to the desired preset number.

Number + PATTERN (long) Starts the pattern record mode.

ACK Stops the pattern record mode.

Number + PATTERN Runs the desired pattern.

Number+ AUX ON/AUX OFF Turns the specified auxiliary output on or off.

Number + MON Assigns the selected camera to the desired view pane. The active view pane is highlighted.
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KBD300A Shift Key Features
Table AZ describes the KBD300A Shift key features.

INSTALLING OR UPDATING DEVICE PROTOCOLS
The DX8100 uses dynamic-link library (DLL) files to support the various ATM, dome, and keyboard device protocols. The DX8100 is shipped with 
a default set of protocols and devices for Pelco and other manufacturers. As new devices or updates are made available, the DX8100 allows you 
to install new or update existing device protocols to support the devices. 

• DLL files for Pelco devices supported by the DX8100 are provided by Pelco. 

• DLL files for other manufacturer devices supported by the DX8100 are provided by the respective vendor.

To install or update a device (PTZ, POS, or keyboard) in the DX8100:

1. Insert the CD containing the Pelco DLL files in the DX8100 CD drive.

2. In the Network page, click the Port/Device tab. The Port/Device page is displayed.

3. Click Install. The Protocol Install dialog box opens.

4. Click Browse and locate the DLL files for the device.

5. Click Update.

6. Click Exit.

Table AZ.  KBD300A Shift Key Features

Control Action

Joystick Activity within the DX8100 Site Tree:

• Up/Down direction: Moves the cursor vertically through each element in the Site Tree. 

An element is a DX8100 site; a camera within each DX8100 site, alarm, or ATM/POS; or are relay within 
each DX8100 site.

If an element is expanded, the joystick moves the cursor vertically through the objects of that element.

• Left/Right direction: 

– Right: Expands an element to display objects contained under the element.
– Left: Collapses an element and hides its objects. Select a camera/unit at the tree.

Number + CAM Expands the specified DX8100 Site Tree. If there are two sites, 1 + CAM expands DX8100 site 1; 2 + CAM 
expands DX8100 site 2.

F2, F3, ON, OFF Cameras are assigned numerically 1–16 to the respectively numbered video. These controls display DX8100 video 
in the following divisions:

• F2/OFF: Single division view

• F3/MOM: 4-division view

• AUX ON: 9-division view 

• AUX OFF: 16-division view
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DATA BACKUP SETUP
Video data recorded on the DX8100 can be backed up to a variety of media. The backup process involves selecting a specific time range for 
archival and the type of media to be used. The primary difference between backing up and exporting video is performing a backup archives all 
channels for a specific time period, while exporting only archives selected channels. Following the directions below, Power User and 
Administrators can set up and perform backups. 

NOTE: The DX8100 Export feature backs up all configuration settings to the target device; however, the target device setting is not restored 
after the import process is executed. The target device setting must be re-entered before the scheduled backup routine can execute.

You must use the DX8100 Client application to view backed up data. For more information about viewing backed up data, refer to the client 
application manual.

This section describes how to back up data and includes the following topics:

• Accessing the Backup Configuration Page on page 202 

• Adding a Backup Schedule on page 202 

• Editing an Existing Backup Schedule on page 204 

• Deleting an Existing Backup Schedule on page 205

• Initiating an Instant Backup Schedule on page 205 

• Mapping a Network Device on page 206 

• Disconnecting from a Network Drive on page 206

• Selecting a Backup Media Device on page 207 

• Viewing Backed Up Video on page 207

Figure 159 shows the parts of the Backup schedule page.

Figure 159. Backup Configuration Screen
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The following table describes the parts of the Backup schedule page. 

ACCESSING THE BACKUP CONFIGURATION PAGE
For information about the Backup schedule page, refer to Data Backup Setup on page 201.

To access the Backup page:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

ADDING A BACKUP SCHEDULE
The DX8100 allows you to configure the start time and time range for backing up data. The backup schedule can be configured to run on a daily 
basis, at a set time, and for a specified time range. Or, you can set up the backup schedule(s) to run on selected days of the week. In this case, 
selecting a weekly backup schedule allows you to customize the start time and time range for each selected day of the week. The start date and 
time cannot be set to begin later than the end date and time.

To define the time range of the data to be backed up:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

Table BA.  Parts of the Backup Schedule Page

Item Part Description

Backup schedule 
table

Describes the configured backup schedule details.

• Name: The type of backup schedule (Daily or Weekly). Daily includes all days of the week, Monday through 
Sunday; Weekly (indicates a specific day of the week that the backup schedule is to occur. A selection check 
box allows you to select or deselect a backup schedule to run as scheduled. A deselected backup schedule 
does not run as scheduled. 

• Backup start time: The date and time a backup schedule is defined to run. 

• Backup time: The time period entered for the backup schedule. 

• Filter: The channels selected for back up. 

• Target device: The selected backup media device.

Backup schedule 
buttons

Allows you to do the following:

• Add: Opens the Add Backup Schedule dialog box for configuring a backup schedule. For more information 
about the Add Backup Schedule dialog box, refer to Adding a Backup Schedule on page 202.

• Edit: Allows you to edit the details of the selected backup schedule.

• Delete: Allows you to delete a selected backup schedule.

• Instant Backup: Opens the Backup Now dialog box, where you enter options to start a backup schedule

Waiting backup 
information

Displays backup schedules waiting to be executed. 

• Backup time: The date and time a backup schedule is defined to run. 

• Filter: The channels selected for back up.

• Target device: The selected backup media device. 

• Enqueue time: The system’s estimated time for backup completion. 

Waiting backup 
information control 
buttons

Allows you to do the following:

• Priority up: Allows you to move the selected backup schedule to a higher place in the list. 

• Priority down: Allows you to move the selected backup schedule to a lower place in the list. 

• Delete: Allows you to delete the selected backup schedule. 

Running backup 
information

Lists the backup schedules that are currently running.
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3. On the Backup schedule page, click Add to add a backup schedule. The Add Backup Schedule dialog box opens.

Figure 160. Add Backup Schedule Dialog Box

4. In the Time Setting section (to set up the time schedule) do one of the following: 

a. For daily recording click Daily (if it is not selected) and do the following;

(1) Click the Time drop-down boxes, and select the time you want the backup schedule to start. 

(2) Click the Backup Time Range drop-down boxes, and select the time you want the backup schedule to stop.

or 

b. For weekly recording, click Weekly (if it is not selected) and do the following:

(1) Under the Backup Start Time, click the Day drop-down-box. Select the day of the week. In this case, each day represents an 
individual backup schedule for that specific day and the configured time constraints. 

(2) Under the Backup Start Time, click the Time drop-down boxes simultaneously select the time you want the backup schedule to 
start.

(3) Under the Backup Time Range, click the Day drop-down boxes. Select the day you want the backup schedule to start and the day 
you want the backup schedule to stop.

(4) Under the Backup Time Range, click the Time drop-down boxes. Select the time of day you want the backup schedule to start 
and the time you want the backup schedule to stop.

5. In the Channel & Record Type section, select the channel record type as follows:

(1) Click the All or Clear button to select or clear all of the channels simultaneously, or click channels 1–32 individually to select or 
deselect a channel.

(2) Click the Categories drop-down box to select the type of recording. The backup schedule includes only the type of recording you 
have specified.




�
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6. (Optional) In the Device Selection section, map a network drive for backup by performing one of the following:

a. Click the “Map a network drive” button. The Windows Map Network Drive dialog box opens. For more information about mapping a 
network drive, refer to Mapping a Network Device on page 206.

(1) Specify the drive letter for the connection and to which folder you want to connect. 

(2) Click Finish. The mapped drive is displayed in the Device Selection area under “Remote drives.”

or 

b. Click Disconnect a mapped drive” to disconnect. 

7. In the Device Selection section, click the check box for the device to which you want the data backed up.

8. Click OK. 

The “Backup schedule” table is displayed, the newly scheduled backup time range is listed in the table, and the selection check box is 
marked. 

9. Click Apply.

EDITING AN EXISTING BACKUP SCHEDULE
The DX8100 allows you to edit or delete an existing backup schedule.

To edit a backup schedule:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

3. In the “Backup schedule” table, do the following:

a. Click the backup schedule time range you want to edit.

b. Click Edit.

The Edit Backup Schedule dialog box opens, displaying the current settings for the selected backup schedule.

Figure 161. Editing an Existing Backup Schedule

c. Edit the backup parameters. 

d. Click OK.

The Edit Backup Schedule dialog box closes, and the backup configuration screen is displayed. The updated schedule details are 
displayed in the “Backup schedule” table.

4. Click Apply. 

�

�
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DELETING AN EXISTING BACKUP SCHEDULE
To delete an existing schedule:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

3. In the “Backup schedule” table, click the backup schedule you want to delete.

4. Click Delete. 

5. Click Apply.

INITIATING AN INSTANT BACKUP SCHEDULE
The DX8100 allows you to schedule an instant backup; time setting options are displayed when you select instant backup. In this case, you are 
given quick access to select the backup device, day and time, channel record type, and recording category. Once you establish the backup 
schedule, you can view the estimated backup size before starting the actual backup process. 

The DX8100 provides initial default settings. You can save time by accepting the following defaults:

• Backup time range: The current day and time you initiated the instant backup routine. 

• Channel record type: All channels.

• Categories: All Recording.

To perform an instant backup: 

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

3. In the Backup page, do the following:

a. Click Instant Backup. The Backup Now dialog box opens.

b. Click the selection check box for the device you want to receive the instant backup data.

4. Do one of the following:

a. To accept backup schedule options:

(1) Click Estimated Backup Size. The Estimated Backup Size dialog box opens, displaying backup details. 

(2) Read the backup information and verify that the selected backup device provides adequate space to receive the backed up data.

(3) Click OK.

(4) Click OK to accept the defaults for the time setting, channel record type, and categories. The backup starts immediately. 

or

b. To customize the backup options:

(1) Change the backup time range, channel record type, and category.

(2) Click Estimated Backup Size. The Estimated Backup Size dialog box opens, displaying backup details. 

(3) Read the backup information and verify that the selected backup device provides adequate space to receive the backed up data.

(4) Click OK.

(5) Click OK. The backup starts immediately. 
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Figure 162. Instant Record Backup Now Dialog Box

MAPPING A NETWORK DEVICE
The DX8100 allows you to map to or disconnect from a network drive. You need to know the drive letters, as well as the path to the folder to 
which you want to map. 

 To map a network drive: 

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

3. Click the Add or Instant Backup button. The Add Backup Schedule or Backup Now dialog box opens.

4. Click “Map a network drive.” The Map Network Drive dialog box opens asking for a drive letter and path. 

5. In the Drive drop-down box, select an available drive letter.

6. Type the path in the Folder drop-down box (for example, \\IP_address_of_server\folder_name).

7. (Optional) Click the “Reconnect at logon” box if you do not want the mapped drive to remain connected each time you log on. 

8. Click Finish. The newly mapped drive is added as a remote drive and is displayed in the Device area of the Export Video dialog box. 
The mapped drive can now be accessed just like a local drive.

DISCONNECTING FROM A NETWORK DRIVE
To disconnect from a network drive:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

3. Click the Add or Instant Backup button. The Add Backup Schedule or Backup Now dialog box opens.

4. Click “Disconnect mapped drive.” The Disconnect Network Drive dialog box opens. 

5. Select the network drive you want to disconnect

6. Click OK. The drive is disconnected and removed from the Export Video dialog box’s Device area.

4b
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SELECTING A BACKUP MEDIA DEVICE
You can back up video to a local or remote network device. Depending on your system configuration, backup devices may include an optical drive 
such as a CD-R or DVD-R, an external drive, or a network drive. The DX8100 does not support exporting or backing up to CD-RW and DVD-RW 
disks, but it does support exporting or backing up to CD-R and DVD-R disks.

To select the type of backup device you want to use:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Backup button . The Backup schedule page is displayed.

3. Click the Add or Instant Backup button. The Add Backup Schedule or Backup Now dialog box opens.

4. Click the plus (+) sign beside a backup device in the device list. 

5. Select the check box of the device you want to use.

6. Make sure that the backup media selected is inserted in the drive and the drive is ready.

If your DX8100 is connected to a network that supports shared folders and drives, you can map a network drive by right-clicking the 
Network Drive icon in the device list. To map a network drive, select Add Network Drive from the shortcut menu and follow the on-screen 
directions. To remove a drive mapping, right-click the Network Drive icon and select Remove Network Drive.

VIEWING BACKED UP VIDEO
You must use the DX8100 Client application to view backed up video. For more information about viewing backed up video, refer to the section 
titled Viewing and Searching Backed Up Video in the Client online Help or Client Applications manual. 
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USER SETUP
The User page allows an Administrator (Admin) to add, delete, and change the properties of users. Admin has full permission to configure all of 
the DX8100 features, and it is the only user level that can change permissions for all lower level users. Users are subdivided into groups and 
each group is granted a particular level of access. A lower level user cannot have a larger set of permission than a higher level user. 

This section describes how to configure users and includes the following topics:

• Accessing the User Page

• Built-in User Accounts on page 209 

• Definition of User Access Levels on page 210 

• Definition of Camera Security Access on page 210 

• Adding New Users on page 211 

• Modifying User Properties on page 212 

• Changing User Passwords on page 213 

• Changing a User’s Group Affiliation on page 213 

• Deleting Existing Users on page 213

• Setting Login Timeout on page 213

• Assigning Automatic Login Permission to a User on page 214

ACCESSING THE USER PAGE
To access the User page:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the User button . The User page is displayed.

Figure 163 shows the parts of the User page.

Figure 163. User Page
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Table BB describes the parts of the User page.

BUILT-IN USER ACCOUNTS
There are two built-in user accounts that come pre configured with the DX8100, which cannot be deleted or changed.

• Guest: The Guest account provides limited access to the system. The Guest user can view live video but cannot play back recorded video or 
access system configuration functions. The Guest account automatically becomes active when the system is first started and each time a 
user logs out. The Guest user is not a member of any group; however, a Guest retains all of the rights and privileges of the Restricted Users 
group, including the ability to view low security cameras. If you do not want video from a low security level camera to be viewed by the 
Guest user, set the security level for that camera to medium or higher.

• Admin: The Admin account has full access to the system. The Admin user can view live and playback video, access all configuration 
settings, add and modify users, and can perform searches and backups. The Admin user is a member of the Administrators group and 
cannot be removed.

Table BB.  Parts of the User Page

Item Part Description

User Name Table Lists the authorized users.

User Buttons Allows you to do the following:

• Add: Opens the Add New User dialog box, to create a new user account. 

• Remove: Deletes the selected user.

• Properties: Opens the Properties dialog box, to view and modify user details.

• Set Password: Opens the Set Password dialog box, to specify or modify the user’s password.

User Groups Allows you to create user accounts for the following user groups:

• Power 

• Standard 

• Restricted

The DX8100 allows the administrator to configure access rights to any user group for the following functions:

• Camera security

• View live video

• Operate PTZ

• Playback video

• Set PTZ

• Access export menu

For more information about user groups, refer to Definition of User Access Levels and Definition of Camera 
Security Access on page 210.

User Timeout Allows you to configure the amount of time a user is allowed to remain logged on to the DX8100 system, before 
the system automatically logs out. The time period is from 5-60 minutes (in increments of 5 minutes). The manual 
setting allows the user to stay logged on to the DX8100 until the user is manually logged off.

Auto Login User Allows you to configure a user to log on to the DX8100 automatically.
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DEFINITION OF USER ACCESS LEVELS
There are four predefined user access levels or groups. User access levels range from the Administrator group to the Restricted group. By default, 
the system starts up with a default Guest account. The Admin user can assign automatic login for a specified user. For information about setting 
up auto login, refer to Assigning Automatic Login Permission to a User on page 214.

The Guest account has Restricted user access. Table BC describes the default user group access rights.

DEFINITION OF CAMERA SECURITY ACCESS
The administrator can limit the cameras that users are allowed to view. Access to a camera is determined by its security designation. The Admin 
user can configure access rights to any user group, for any of the following functions:

• Camera security

• View live video

• Operate PTZ

• Playback video

• Set PTZ

• Access export menu

Only users with High Security access can view cameras designated as High Security. Medium Security cameras can be viewed by users with 
Medium Security access and higher. All users can view Low Security cameras. All users can view No Security cameras. If you do not want video 
from a low security level camera to be viewed by the Guest user, set the security level for that cameras to medium or higher.

Table BD describes the default camera security levels and user access.

Table BC.  Default User Group Access Rights

User Groups
View 
Live 

Video

View 
Recorded 

Video

Operate 
PTZ

Search 
Video

Backup 
Video

System 
Setup

Shut 
Down 

System

Add/
Remove 

Users

Change
User/Group 
Properties

Exit to 
Windows

Administrators

Power Users

Standard Users

Restricted Users

Guest Users

Table BD.  Default Camera Security Levels

Groups No Security 
Cameras

Low Security 
Cameras

Medium Security 
Cameras

High Security 
Cameras

Administrators

Power Users

Standard Users

Restricted Users

Guest Users
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MODIFYING USER ACCESS RIGHTS
The Admin user can alter default access rights of lower level users. In this case, any permission granted to a lower level user, must first be 
granted to all other higher level users. For example, export rights must first be granted to the Standard user before they can be granted to a 
Restricted user. 

Click the user group buttons to enable/disable the access right for each access category. The access right category is enabled when the button’s 
text is red (permission granted), and it is disabled when the button’s text is white (permission not granted). Click a button to toggle the access 
right, on and off. Repeatedly clicking the Camera Security button cycles through the security levels (none, low, medium, and high). 

To modify a user’s access rights:

1. On the DX8100 toolbar, click (icon). The Setup dialog box opens to the Camera page.

2. Click (icon). The User page is displayed.

3. Do one of the following:

a. To grant an access right to a user, left click on an access right button above the user’s group list. The text will toggle from white to red 
and that permission will be active for that user.

b. To deny an access right to a user, left click on an access right button above the user’s group list. The text will toggle from red to white 
and that permission will be denied for that user.

4. Click Apply.

ADDING NEW USERS
Administrators can create new user accounts and modify existing users; this can be done locally on the DX8100 server or remotely from the 
DX8100 Client Application. 

User names and passwords have the following requirements:

• User names can be between 4 and 20 alphanumeric characters in length. 

• User passwords can be between 4 and 10 alphanumeric characters in length. 

• User names cannot contain spaces and special characters.

• User names and passwords are case sensitive.

To add a new user:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the User button . The User page is displayed.

3. Click Add. The Add New User dialog box opens.

4. Do the following:

a. Enter a login name for the user. 

b. Enter the user’s full name.

c. Enter a brief description for the user. For example, enter Building 6 Security Guard.

d. Enter a password for the user. (Passwords must be between 4 and 10 characters in length and cannot contain spaces and special 
characters.)

e. Re-enter the same password to confirm.

5. Click Next. The user access level options for the New User dialog box are displayed.

6. Select the user’s access level: Restricted, Standard, or Power.

7. Click Finish.
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8. Click Apply.

Figure 164. Add New User Dialog Box

MODIFYING USER PROPERTIES
Follow the steps below to change user attributes, such as user name and group affiliation. Users with Admin or Power User access can change 
name and description properties of lower level users. However, only Admin level users can change a user’s group affiliation. 

To modify a user’s properties:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the User button . The User page is displayed.

3. Do one of the following:

• In the main user list:
(1) Click a user name.

(2) Click Properties. The Property dialog box opens.

• In one of the group lists:
(1) Click a user name.

(2) Click Properties. The Property dialog box opens.

4. Edit the following user properties:

• User name
• Full name
• Description
• Group

5. Click Apply in the Property dialog box.

6. Click Apply in the User Setup screen.

An Administrator level user can also change the group affiliation of users by dragging user names to different groups.

�
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CHANGING USER PASSWORDS
Administrators and Power Users can change or reset an existing user’s password.

To change a user’s password:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the User button . The User page is displayed.

3. Click a user name in the main user list.

4. Click Set Password. The Set Password dialog box opens.

5. Enter a new password in the “New password” field.

6. Retype the password again in the “Confirm new password” field.

7. Click Apply in the Set Password dialog box. 

8. Click Apply in the User Setup screen. 

CHANGING A USER’S GROUP AFFILIATION
An Administrator level user can also change users' group affiliation of users by dragging user names to different groups.

To change a user's group affiliation:

• In the User name column of the User page, click the user's name and drag it into a group.

DELETING EXISTING USERS
Administrators can delete existing users.

To delete a user’s account:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the User button . The User page is displayed.

3. Click the user name of the user you want to delete from the main user list.

4. Click Remove. The Remove User dialog box opens.

5. Click Yes to confirm the deletion or No to cancel and return to the User Setup screen.

6. Click the Apply button at the bottom of the screen.

SETTING LOGIN TIMEOUT
Administrators can define the amount of time a user’s account can remain idle before having to log in again. This setting applies to all users, 
regardless of access level. 

 To set login timeout:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the User button . The User page is displayed.

3. Select a time limit from the User Timeout drop-down box.

• Time limits range from five minutes to one hour, in five-minute increments.
• Selecting Manual from the drop-down box will suspend the automatic logout feature. (A user will remain logged in until the user logs 

out or another user logs in.)

4. Click Apply.
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ASSIGNING AUTOMATIC LOGIN PERMISSION TO A USER
The DX8100 allows one user to automatically log in to the DX8100 application. The administrator must assign automatic login permission to the 
user. Once automatic login permission is assigned to the user, the user will be automatically logged in to the DX8100 application. In this case, the 
assigned user does not have to enter the user name and password. 

NOTE: Automatic login user permission makes the DX8100 more vulnerable because a higher level user is logged in every time. 

To assign automatic login permission:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the User button . The User page is displayed.

3. In the Auto Login User drop-down selection box, select a user.

4. Click Apply. 

The next time the DX8100 application is started, the assigned user is logged in automatically.

SITE SETUP
This section describes how to connect to a remote site and includes the following topics:

• Adding a Remote Site

• Finding Active Remote Cameras on page 217 

• Activating Remote Sites on page 217 

• Editing a Remote Site on page 218 

• Deleting a Remote Site on page 218 

ADDING A REMOTE SITE 
Up to 100 remote DX8100 HVR server sites can be added to the local server’s site list. Up to four remote HVR sites can be accessed from a single 
DX8100 (a total of five sites, including the local HVR, can be active on a single network segment). Up to 16 cameras can be viewed from and 
managed for each remote site (of which 32 cameras can be simultaneously assigned to view panels). Once a site has been added to the site list, 
it can be managed and viewed just as the local HVR. 

NOTE: Only those with Power User or greater permissions can configure the access rights of remote HVRs.

Once a remote site has been added, all viewing, searching, and setup functions of that site can be accessed from the local DX8100. To access the 
features of a remote site, users must possess a valid user account with the appropriate access rights for that site.

This section describes how to add a site with a static IP or dynamic IP address and includes the following topics:

• Adding a Site with a Static IP Address 

• Adding a Site with a Dynamic IP Address on page 216

Adding a Site with a Static IP Address
To add a remote HVR site when the IP address is known:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Site Setup button .

3. Select the Manual button (if it is not already selected).

4. Enter a site name for the remote HVR. (Site names can be up to 32 characters long and can contain spaces and special characters, for 
example, Building 1 HVR.)
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5. Enter the IP address of the remote site.

6. If necessary, do the following:

a. Enter a new base port number (9002 is the default). 

Unless there is a conflict on your network, you should not change port numbers from their default values. Make sure any changes to 
port numbers are made consistently across all DX8100 servers and clients on a network. Client and server ports must be identical.

b. Enter a new upgrade port number (9003 is the default).

c. Enter a new information port number (9003 is the default).

d. Click Add. The site appears in the “Site IP list” on the right.

7. Repeat steps 4-6 for each additional site. Up to 50 remote sites can be added to the site list.

8. Click Apply. 

Once a remote site has been set up, its name appears in the Site Tree. It may take up to five minutes to initially connect to the site. Once a 
connection has been established, cameras from the remote site can be dragged onto the main screen view panels.

Figure 165. Adding a Site with a Static IP Address
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Adding a Site with a Dynamic IP Address
An Administrator level user can connect DX8100 units, even when the exact IP address of a remote HVR is not known. To add a site successfully, 
the following items must be established:

• Each HVR must be attached to the same TCP/IP subnet or LAN.

• The first three octets of the IP address of the HVR host or subnet must be known.

• The range of addresses used in the last octet of the HVR host or subnet must be known.

To add a remote HVR site when the IP address is known:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Site Setup button .

3. Select the Search DX8100 button (if it is not already selected).

4. Enter an IP address range to search for HVR sites.

a. Enter the first three octets of the IP range you want to search (for example, 10.10.1).

b. Enter the beginning value for the search range in the fourth octet (for example, 001).

c. Enter the final value for the search range in the box provided (for example, 254). 

Each octet of the IP address must be an integer number between 1 and 255.

5. Click Find, and then wait while the DX8100 searches the network for remote HVR sites.

6. Select the HVR site(s) you want to add to the site list.

7. Click Add.

8. Click Apply.

Figure 166. Adding a Site with a Dynamic IP Address
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FINDING ACTIVE REMOTE CAMERAS
After connecting to a remote site, you should query the server to determine which cameras are active. HVRs can have 8, 16, 24, or 32 channels. 

To determine which cameras are active:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Site Setup button .

3. Select the Manual button (if it is not already selected).

4. Enter a remote site IP address.

5. Click Refresh. 

6. Click Apply.

Figure 167. Finalizing Site Setup

ACTIVATING REMOTE SITES
The DX8100 only supports up to five remote connections; however, one computer client can connect up to 200 servers simultaneously. Using the 
multicast feature, the DX8100 HVR can support an unlimited number of Web client connections.

To activate up to five remote sites:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Site Setup button .

3. In the “Site IP list,” select up to five HVR sites to be activated.

4. Click Apply. The new DX8100 server site(s) should now be listed in the Site Tree.
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MODIFYING A REMOTE SITE
This section describes how to modify a remote site and includes the following topics:

• Editing a Remote Site on page 218

• Deleting a Remote Site on page 218

Editing a Remote Site 
To change the attributes of a remote site:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click the Site Setup button .

3. Select the site name you want to edit from the “Site IP list” by clicking its site name.

4. Click Edit. The Server Information dialog box opens.

5. Enter a new site name for the remote HVR.

6. Enter the new IP address of the remote site.

7. If necessary, enter a base port number (9002 is the default). 

Unless there is a conflict on your network, you should not change port numbers from their default values. Make sure any changes to port 
numbers are made consistently across all DX8100 servers and clients on a network. Client and server ports must be identical.

8. If necessary, enter an upgrade port number (9003 is the default).

9. Click OK.

10. Click Apply.

Deleting a Remote Site 
To delete an existing site from the site list:

1. Select the site name you want to delete from the “Site IP list” by clicking its site name.

2. Click Delete.

3. Click OK to confirm, or click Cancel to abort the deletion.

4. Click Apply.

SYSTEM SETUP
Users with Power User or greater permissions can save configuration settings using the system export feature. Previously saved settings can be 
loaded into the HVR using system import.

This section describes how to configure system options and parameters, including the following topics:

• Accessing the System Page on page 219 

• Working with the Export Feature on page 219

• Working with the Import Feature on page 220

• Using System Logs on page 222

• Selecting the Language on page 224 

• Setting the System Time on page 224 

• Selecting the Video Format on page 226

• Working with Ctrl+Alt+Del Function on page 226

• Setting Up Auto Reboot on page 227

• Specifying the Data Retention Time Limit on page 227

• Working with Online Help on page 228
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ACCESSING THE SYSTEM PAGE
To access the System page:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

WORKING WITH THE EXPORT FEATURE
The DX8100 provides an import and export feature that allows you to save and reload DX8100 configuration settings. You can save your DX8100 
HVR configuration settings by exporting them to a specific storage location. You can reload a specific configuration profile by importing its 
configuration file. 

NOTE: The DX8100 Export feature backs up all configuration settings to the target device; however, the target device setting is not restored after 
the import process is executed. The target device setting must be re-entered before the scheduled backup routine can execute.

This sections describes how to use the import and export feature, including the following topics:

• Exporting the Current HVR Settings 

• Using the Edit Menu to Perform an Export on page 220 

Exporting the Current HVR Settings
To save current HVR configuration settings:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. Select the Export button.

4. Select the check boxes of each configuration item you want to back up.

5. Do one of the following:

a. To specify the file name to which you want to export, enter the drive, path and file name information into the box. Setting file names 
follow standard Windows file-naming conventions, for example, C:\DX8100\Jan_2004_config.bak.

or

b. To browse for a location:

(1) Click Browse.

The DX8100 Setup File Export Dialog box opens.

(2) Enter a file name in the “File name” box.

(3) Navigate to the drive and folder in which you want to save the settings file.

(4) Click the Up button to move up a level in the folder hierarchy.

(5) Click Save.
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6. Click Export Now.

Figure 168. Exporting HVR Settings

Using the Edit Menu to Perform an Export 
To save the current HVR settings:

1. From the DX8100 menu bar, choose Edit > Export Setup.

The DX8100 Setup File Export Dialog box opens.

2. Select the folder in which you want to save the settings file.

3. Click the Up button to move up a level in the folder hierarchy.

4. Enter a file name in the space provided.

5. Click Save.

WORKING WITH THE IMPORT FEATURE
This sections describes how to import DX8100 HVR settings and includes the following topics:

• Importing HVR Settings 

• Using the Edit Menu to Perform an Import on page 221

Importing HVR Settings
To import a saved settings file:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. Select the Import button.

4. Do one of the following:

a. To specify the file name for import, enter the drive, path, and file name information in the box. Settings file names follow standard 
Windows file-naming conventions. For example, C:\System Settings Backup.bak. 

or

b. To browse for a location:

(1) Click Browse. The DX8100 Setup File Export Dialog box opens.

(2) Navigate to the drive and folder where the settings file is located.

(3) Click the Up button to move up a level in the folder hierarchy.

(4) Select the settings file you want to open.

(5) Click Open.

5. Click Import Now.
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6. Click Apply.

Figure 169. Import DX8100 Server Configuration

Using the Edit Menu to Perform an Import 
To import a settings file from a specific drive or folder:

1. From the DX8100 menu bar, choose Edit > Import Setup.

The DX8100 Setup File Import Dialog box opens.

2. Select the folder location of the file you want to import.

3. Click the Up button to move up a level in the folder hierarchy.

4. Click the settings file you want to open.

5. Click Open.

�
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USING SYSTEM LOGS
The DX8100 automatically stores system information in a number of log files. Users with Power User or greater permissions can use these files 
to track system statistics and monitor security. The DX8100 allows you to view its activity log and Windows OS log files.

NOTE: If the Log View dialog box displays multiple System On notifications, but does not display any System Off notifications, the unit has 
failed. Contact Pelco Product Support for more information. 

This section describes how to use the system logs and includes the following topics:

• Viewing a Log File on page 222 

• Exporting Log Information on page 224

Table BE describes the DX8100 activities and Windows OS log views. The log views are available from the DX8100 server’s View menu.

Viewing a Log File
To view a log file:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page. 

2. Click the System button . The System page is displayed.

3. In the Log Information section, select a log file from the Choose drop-down box. 

4. Do one of the following: 

a. To view DX8100 logs, click View. The Log View dialog box opens.

Figure 170 shows the Log View dialog box.

Figure 170. Log View Dialog Box

or

b. To view OS log information, do the following:

Table BE.  DX8100 Activities and Windows OS Log Files

DX8100 Log View Windows OS Log View

System On/Off Success

System Failure Error

Export Warning

Backup Information

Network Connection Audit_Sucess

Login ID List with Time Audit_Failure

Video Loss Audit_Failure
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(1) Click OS Log View. The Window Log Viewer opens.

(2) Click a button to select a category

Figure 171. Window Log Viewer Dialog Box

5. Do one of the following:

• Click OK to close the log dialog box. 
• Click Clear to erase the log.
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Exporting Log Information
To export a system log file:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click System button . The System page is displayed.

3. In the Choose drop-down box, select a log file. 

4. Click Save As.

5. Select the drive and folder in which you want to store the log file.

6. Enter a filename for the log information in the space provided.

Log file names follow standard Windows file-naming conventions. Alternately, you can view log files by clicking View > Log and then 
selecting the desired log file. Log files can be opened and printed using a text editing program, such as Windows Notepad.

7. Click Save.

SELECTING THE LANGUAGE
English is the default language for the DX8100 interface; although the system supports multiple languages, language changes must be 
configured from both the HVR’s operating system and within the DX8100 application.

To select the appropriate language for your location:

1. On the DX8100 toolbar, click Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. Make sure the HVR operating system's regional and language settings have been properly set up. Refer to the installation manual for 
information about regional setup.

4. In the Language section, select the following appropriate language from the Select Language drop-down box.

• English
• French
• German
• Italian
• Polish
• Portuguese
• Russian
• Spanish

5. Click Update. The Restart dialog box opens.

6. Click Yes. The changes are applied and the DX8100 restarts.

SETTING THE SYSTEM TIME
Be sure to set the system time before using the DX8100; setting the internal clock for each HVR on the network ensures that each unit accurately 
reflects the local time.

This section describes how to set the DX8100 system time and includes the following topics:

• Setting System Time 

• Working with Standard and Daylight Saving Time on page 225 
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Setting System Time
Pelco recommends that the system time be configured only at the DX8100 server System page. Only Administrator access or higher can change 
the system time. If a subsequent attempt is made to set the system clock to a time earlier than the current time, the DX8100 server will display 
the Confirm dialog box, to alert the user. The user will then be prompted to do one of the following:

• Accept the new system time and delete data recorded between the current time and the newly set time. If this option is accepted, the data 
is deleted and the DX8100 automatically restarts.

• Accept the new system time, with the following conditions:
– Previously recorded data will not be deleted.
– The DX8100 will not record new data until the system time passes the time that data was previously recorded. For example, if data 

was recorded at 3:00 p.m. and at that time the system time was reset to 2:30 p.m., the DX8100 will not commence recording again 
until the system time passes 3:00 p.m.

If the user changes the system time from the Windows Control Panel, the data recording protection feature described above is defeated, 
resulting in impairment of the recording time line. Without notice, previously recorded data can be overwritten by new data. 

To set the system time:

1. On the DX8100 toolbar, click Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. In the Date/Time Setup section, do the following:

a. In the Date/Time drop-down box, select the current month, day, and year.

b. Select the current time. 

c. Click Update.

d. In the “Time zone” drop-down box, select the correct time zone.

e. Click Update.

4. Click Apply.

Figure 172. System Setup Time 

Working with Standard and Daylight Saving Time
The DX8100 ensures that no data is lost when the system clock is changed to reflect Daylight Saving Time or Standard Time. The DX8100 follows 
the Windows operating system clock changes and is configured (by default) to automatically recognize Daylight Saving and Standard Time 
changes. When the DX8100 encounters a time change it will record data for the transition time period twice. For example, when the system clock 
is set back one hour (from 2:00 AM to 1:00 AM), there will appear two periods on the playback time line that represent the transition hour.

WARNING: Attempting to set the system clock to a time earlier than the current system time will require that you either perform one of 
two options: delete all data recorded between the current time and the new time, or do not delete previously recorded data and begin 
recording only after the system time has passed the recorded time. One exception to this rule involves Daylight Saving Time. For more 
information, refer to the Working with Standard and Daylight Saving Time on page 225.
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SELECTING THE VIDEO FORMAT
To select the appropriate video signal format for your location:

1. On the DX8100 toolbar, click Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. In the Video Format section, click NTSC or PAL to select the format.

4. Click Apply.

WORKING WITH CTRL+ALT+DEL FUNCTION
This section describes how to use the DX8100 Ctrl+Alt+Del key combination and includes the following topics:

• Enabling Ctrl+Alt+Del 

• Using Ctrl+Alt+Del

Enabling Ctrl+Alt+Del
Enabling the Ctrl+Alt+Del key combination allows you to open the Windows Task Manager dialog box to perform system administration tasks. To 
complete the procedure, you must be logged on to the DX8100 as an administrator or power user.

The DX8100 keyboard is remapped. To see which keys replace the Ctrl and Alt keys, refer to the Important Security Information for System 
Administrators guide.

To enable the Ctrl+Alt+Del key combination:

1. On the DX8100 toolbar, click Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. In the “Setup Ctrl + Alt + Del key combination” section, click the Enable Ctrl+Alt+Del key combination selection check box.

4. Click Apply.

5. Reboot the DX8100. 

Using Ctrl+Alt+Del
You must enable the Ctrl+Alt+Del key combination and verify your actual keyboard mapping. In some cases, the DX8100 keyboard is remapped 
and the actual Ctrl, Alt, and Delete key function is assigned to other keys.

Ctrl+Alt+Del allows you to access the Windows Task Manager dialog box from within the DX8100 shell. When you exit the Windows 
environment, you are returned to the DX8100 shell. In this case, you do not have to log back into the DX8100.

To access the Windows Task Manager dialog box:

1. Press the assigned keys that implement the Ctrl+Alt+Del function. The Windows Security dialog box opens.

2. In the Windows Security dialog box, click Task Manager. The Windows Task Manager window opens.

To return to the DX8100 shell without rebooting the DX8100, exit the Windows Task Manager dialog box.
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SETTING UP AUTO REBOOT
The DX8100 allows you to select the day and time for the server to perform an automatic reboot. If there are mapped network drives, the 
Windows feature requires that the password be entered at the Enter Network Password dialog box. In this case, the DX8100 application will not 
start until the password is manually entered.

NOTE: The DX8100 will not automatically reboot if there are mapped network drives. 

To enable the Auto Reboot feature:

1. On the DX8100 toolbar, click Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. In the Auto Reboot section, click the Enable check box.

4. In the Auto Reboot section, do the following to specify the day and time to automatically reboot the system:

a. Select the day of the week in the drop-down box.

b. In the Hour drop-down box, select the hour. Time is displayed in 24-hour clock format.

c. In the Minute drop-down box, select the minutes.

5. Click Apply.

SPECIFYING THE DATA RETENTION TIME LIMIT
The DX8100 data retention time setting allows the Administrator user to configure a time limit for viewable recorded video. The time limit can be 
entered manually or selected from the drop-down menu lists. The data retention time is set in increments of one or more days. The viewing time 
limit window starts from the date of recording to the configured time limit. For example, if the time limit is set for 11 days, all video recorded on 
Aug. 24, 2006 can be viewed up to and including September 4, 2006. The data recorded on Aug. 24 cannot be viewed on Sept. 5. The video data 
recorded on Aug. 24 is not be deleted; it is just not available for viewing.

If the Administrator sets the retention time to unlimited or to a time later than the current retention time limit, all video data (if the retention time 
is set to Unlimited) or data within the newly set retention time limit can be viewed.

To set the data retention time limit:

1. On the DX8100 toolbar, click Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. In the Data Retention Time Limit area, select a retention time limit from the drop-down list.

Figure 173. Data Retention Time Limit Entered Manually

4. Click Apply. The Shut Down dialog box opens, prompting you to restart the DX8100.

5. Do one of the following:

• To restart the DX8100 to use the new settings, click Yes. The DX8100 restarts.
• To cancel the new settings, click No. The current time limit setting is restored and the system does not restart.
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WORKING WITH ONLINE HELP
The DX8100 server includes an online Help system. By default, the Help system is disabled and not available for viewing. The Admin user has 
authority to configure the DX8100 to display or not display online Help. When Help is enabled, all user groups can open and view the Help 
system.

NOTE: There is a security risk when Help is enabled. A guest user can gain access to the Windows file manager through the online Help system. 

To enable/disable Help for viewing:

1. On the DX8100 toolbar, click Setup button . The Setup dialog box opens to the Camera page.

2. Click the System button . The System page is displayed.

3. In the DX8100 Help section, do one of the following:

• Click the Enable DX8100 Help to select Help for viewing,
• Click the Enable DX8100 Help to deselect Help for viewing,

4. Click Apply.

EXTERNAL MONITOR SETUP
The DX8100 includes one capture card, which provides a BNC analog monitor output. A second optional capture card can be installed to provide 
two analog monitor outputs. The first capture card nearest to the PTZ card is user definable. Users with Power User access or higher can assign 
cameras and configure the capture card analog output options. 

NOTE: An external monitor must be connected to the capture card to make use of the analog monitor outputs. Refer to the installation manual 
for instructions on how to connect analog monitors to the capture card.

This section describes how to setup an external monitor and includes the following topics:

• Accessing the External Monitor Setup 

• Setting Up Camera Mapping 

• Configuring Display Override on page 235 

• Using the External Monitor Option on page 235

ACCESSING THE EXTERNAL MONITOR SETUP
To access the monitor configuration screen:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

The Ext. Monitor page is displayed.
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SETTING UP CAMERA MAPPING
The DX8100 allows you to set up automatic or manual camera mapping. This sections describes how to set up camera mapping and includes the 
following topics:

• Setting Up Automatic Camera Mapping 

• Setting Up Manual Camera Mapping on page 230

Setting Up Automatic Camera Mapping
Automatic camera mapping offers a simplified method for configuring the capture card analog output. Video from each camera source will be 
automatically cycled across the monitor’s view panels. In the automatic mode, all cameras will be displayed sequentially, starting with Camera 1 
and continuing through Camera 32 (depending on your system configuration).

The following information should be noted when using the automatic camera mapping feature:

• The automated sequence is interrupted each time a motion or alarm event is detected. 

• When the HVR detects an event (either motion or alarm), the monitor output displays the camera source that detected the event. The 
amount of time that an event channel is permitted to override the automated sequence can be set from 1 to 60 seconds.

• Eight-channel HVRs offer only the 1 x 1, 2 x 2, and 3 x 3 view panel options. If you select more than one screen division, each camera 
channel will cycle through each screen before the next panel division is presented.

To configure automatic camera mapping:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

3. In the Auto Camera Mapping Mode section, do the following:

a. Select the Auto Camera Mapping Mode button.

b. Select from the screen division options. 

c. Select dwell time (1-60 seconds) from the drop-down box. This is the amount of time each window will remain on the monitor.

d. Select the type of event that will be allowed to override the monitor output:

• Alarm input
• Motion detection

e. Set the dwell time an event will be allowed to override the screen (1-60 seconds).

4. Click the Apply button at the bottom of the page.

Figure 174. External Monitor: Automatic Mapping
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Setting Up Manual Camera Mapping
Manual camera mapping allows a user to customize the capture card analog output. Individual cameras can be assigned to view panels in any 
combination. Each customized screen can be added to a sequence list and assigned a specific amount of dwell time. These combinations of 
customized screens and corresponding dwell times make up sequence instances: multiple sequence instances can be combined into a sequence 
list. The resulting list will sequentially display each instance on an external monitor in a continuous loop. The sequence will continue 
uninterrupted until an alarm or motion event overrides the cycle.

The following information should be noted when using the manual camera mapping feature:

• Eight-channel HVRs offer only the 1 x 1, 2 x 2, and 3 x 3 view panel options.

• If you select more than one screen division, each camera channel will cycle through each screen before the next panel division is presented.

This section describes how to set up manual camera mapping and includes the following topics:

• Creating Monitor Sequence Instances 

• Loading an Existing Sequence List on page 231 

• Modifying a Sequence Instance in the List on page 232

• Deleting a Sequence Instance from the List on page 233 

• Appending an Existing Sequence List on page 234 

Creating Monitor Sequence Instances

To add a sequence instance to the sequence list:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

3. In the Manual Camera Mapping Mode section, do the following:

a. Select the Manual Camera Mapping Mode button (if it is not already selected).

b. Select one of the screen division options. 

c. Drag cameras from the Site Tree onto each view panel until cameras have been assigned to all panels.

d. From the Min and Sec drop-down boxes, select the amount of time the sequence instance will remain on the monitor.

e. Click Add. 

The instance is added to the Sequence Table.

4. Do one of the following:

• Repeat step 3 for each additional sequence instance you want to add to the sequence list.
• If you want to apply the custom setting without saving, click Apply and skip steps 5-9.

5. Click Save. The Save Profile dialog box opens.

6. Select an existing profile or enter a new profile name under which to save the sequence.

7. Click OK.

8. In the Sequence Table, click Apply.
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9. Click Apply in the External Output page.

Figure 175. External Monitor: Manual Mapping

Loading an Existing Sequence List

To load an existing sequence list: 

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

3. In the Manual Camera Mapping Mode section, do the following:

a. Click the button to select the Manual Camera Mapping mode.

b. Click Load to load or modify an existing sequence.

The “Load profile” dialog box opens.

c. Select a profile.

d. Click OK.

The DX8100 dialog box opens, prompting you to append the sequence to the list.
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e. Click No to the Append option.

Figure 176. Loading a Mapping Sequence

Modifying a Sequence Instance in the List

To modify a sequence instance in the list:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

3. In the Manual Camera Mapping Mode section, do the following:

a. Click the button (if it is not selected) to select the Manual Camera Mapping mode.

b. Click one of the sequence instances from the list.

c. Select a screen division. 

d. Drag cameras from the Site Tree onto each view panel until cameras have been assigned to all panels.

e. From the Min and Sec drop-down boxes, select the amount of time the sequence instance will remain on the monitor.

f. Click Modify.

g. Click Save.

The Save dialog box open.

4. Select an existing profile or enter a new profile name under which to save the sequence list.

5. Click OK.

6. Click Apply.
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7. Click Apply in the External Monitor page.

Figure 177. Modify a Mapping Sequence

Deleting a Sequence Instance from the List

To delete a sequence instance from the list:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

3. In the Manual Camera Mapping Mode section, do the following:

a. In the Sequence Table, click the check box next to the sequence instance you want to delete.

b. Click Delete.

c. Click Save.

The Save profile dialog box opens.

4. Select an existing profile or enter a new profile name under which to save the sequence list.

5. Click OK.

6. Click Apply.

3e3e

3a3a

�

3d

3c

3f3f 3g

3b
C2630M-C (7/09) 233



7. Click Apply at the bottom of the External Monitor page.

Figure 178. Delete a Mapping Sequence

Appending an Existing Sequence List

To append an existing sequence list to the current list:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

3. Click Load. The “Load profile” dialog box opens.

4. Select a profile.

5. Click OK. 

The “Append to list” dialog box opens.

6. Click Yes to add the new sequences to the existing list.

7. To add, delete, or modify sequence instances, follow the directions in the sections above.

8. Click Save.

9. Select an existing profile or enter a new profile name to save the sequence list.

10. Click OK.

11. Click Apply in the Sequence Table section.

12. Click Apply.
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CONFIGURING DISPLAY OVERRIDE
The capture card can be configured to interrupt normal output when a motion or alarm event is detected. Each event instance causes live video 
from the sensing camera to be displayed for up to 60 seconds after event detection.

To set up event monitor override options:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

3. Select the type of event that will be allowed to override the monitor output:

• Alarm input 
• Motion detection

4. Set the dwell time an event will be allowed to override the screen (1-60 seconds).

5. Click Apply.

USING THE EXTERNAL MONITOR OPTION
To assign a sequence profile to an external analog monitor:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Ext. Monitor button . The External Output page is displayed.

The External Monitor drop-down menu is displayed.

3. Select a profile from the External Monitor drop-down menu.

EMERGENCY NOTIFICATION SETUP
The Emergency Agent Notification alerts selected clients to motion, alarm, and video loss events detected by DX8100 server sites. When a 
motion, alarm, or video loss event is triggered, a pop-up window opens on the monitor of the remote site client. The window displays one or 
more still images taken during the event. 

Users with Power User access and higher can configure the emergency agent notification system. The first step in the setup process requires 
that clients be added to the emergency agent notification list. To complete this step, you must provide a valid name and the IP address of each 
client computer. After clients have been added they can be linked to one or more cameras. Finally, the amount of time a server sends images 
after an event occurs and the interval between sending each image must be set. 

NOTE: Before configuring the Emergency Agent Notification, make sure the Emergency Agent Client utility is installed on one or more client 
computers. For information about installing the Emergency Agent Client utility, refer to Installing the Client Emergency Agent Application in the 
DX8100 Client Application manual. 

This section describes how to setup emergency notification and includes the following topics:

• Accessing the Emergency Agent Notification Setup 

• Adding Client Emergency Agents to be Notified

• Changing Client Emergency Agent Properties on page 236

• Deleting Clients from the Notification List on page 237

• Linking Cameras to Client Emergency Agents on page 237 

• Setting Server Event Transmission Time on page 237

ACCESSING THE EMERGENCY AGENT NOTIFICATION SETUP
To access the Emergency Agent Notification setup:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.
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ADDING CLIENT EMERGENCY AGENTS TO BE NOTIFIED
After clients have been added, cameras must be configured to notify individual clients of an event. A single camera can be linked to one or more 
client emergency agents. For information about linking cameras to client emergency agents, refer to Linking Cameras to Client Emergency Agents 
on page 237.

To add clients to the Emergency Agent Notification list:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click Add. The Agent Setup dialog box opens.

4. Do the following:

a. Enter a name for the client. (Client names can be up to 63 characters and can include spaces, but not special characters.

b. Enter the client’s IP address.

c. If necessary, enter a port number in the Agent Port box. (The default port number is 9004.)

Unless there is a conflict on your network, you should not change the Emergency Agent port number from its default of 9004. Make 
sure any changes to port numbers are made consistently across all DX8100 servers and clients on a network. Client and server ports 
must be identical.

5. Click OK.

6. Click the Apply button at the bottom of the screen.

CHANGING CLIENT EMERGENCY AGENT PROPERTIES
To change an existing client’s information in the emergency notification list:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Do the following:

a. In the Emergency Agent Setup section, select a client from the list.

b. Click Edit. The Agent Setup dialog box opens.

c. Enter a new name for the client. (Client names can be up to 63 characters long and can include spaces, but not special characters.)

d. Enter a new IP address for the client.

e. If necessary, enter a port number in the Agent Port box. (The default port number is 9004.)

Unless there is a conflict on your network, you should not change the Emergency Agent port number from its default of 9004. Make 
sure any changes to port numbers are made consistently across all DX8100 servers and clients on a network. Client and server ports 
must be identical.

4. Click OK.

5. Click the Apply button at the bottom of the screen.
236 C2630M-C (7/09)



DELETING CLIENTS FROM THE NOTIFICATION LIST
To delete a client from the emergency notification list:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Do the following:

a. In the Emergency Agent Setup section, select a client from the list.

b. Click Delete. The selected client is deleted.

4. Click Apply.

LINKING CAMERAS TO CLIENT EMERGENCY AGENTS
After clients have been added, cameras must be configured to notify individual clients about an event. A single camera can be linked to one or 
more client emergency agents.

Up to 32 IP addresses can be assigned to each camera. The DX8100 can transmit up to 10 IP addresses simultaneously. 

To link a camera to one or more clients:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. In the Camera Setup section, click a camera button (Camera 1-32). The Emergency Agent Selection dialog box opens.

4. Click the check box to select the name of the client site you want to notify when a motion, alarm, or video loss event is detected by this 
camera.

5. Repeat steps 1 and 2, for up to 32 cameras on the current site.

6. Click the Apply button at the bottom of the screen.

7. Configure the server event transmission time. For information about setting the duration and transmission interval, refer to Setting Server 
Event Transmission Time on page 237.

SETTING SERVER EVENT TRANSMISSION TIME
After clients have been added and linked to cameras, you must set the amount of time a server sends images after an event occurs and the 
interval between sending each image (for one of more clients). For information about adding clients, refer to Adding Client Emergency Agents to 
be Notified on page 236. For information about linking cameras, refer to Linking Cameras to Client Emergency Agents on page 237.

To set the duration for sending images and the transmission interval:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. In the Option section of the Emergency Agent page, enter the amount of time (in seconds) that you want the DX8100 to continue sending 
still images after an alarm, motion, or video loss event has been detected.

4. Enter the time interval (in seconds) that you want the DX8100 to wait between sending each still image.

5. Click Apply.
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EMERGENCY E-MAIL NOTIFICATION SETUP
The DX8100 can be configured to send e-mail notifications alerting users of motion, alarm, and video loss events. Users with Power User access 
and higher can configure the notification function. Notifications can be sent to a single e-mail address or a group of addresses, either 
immediately after an event occurs or periodically according to a predefined schedule. You can configure up to 32 e-mail groups, and up to 32 
members can be assigned to each e-mail group. 

Before sending notifications, you must provide information about your e-mail server and establish the events (motion, alarm, and video loss) that 
you want to include in the e-mail message. Timing and frequency of the e-mail notifications must also be set. You should test the e-mail 
notification function immediately after configuration to ensure your system is set up correctly.

NOTES: 

• To use emergency e-mail notification, the DX8100 Series HVR must be connected to a LAN that maintains an SMTP mail server. The 
network must also be connected to either an intranet or the Internet depending on the location of the e-mail accounts to which you want to 
send notifications. Consult your network administrator for information about configuring e-mail notification on your local network.

• The DX8100 does not support the Secure Sockets Layer (SSL) protocol required by Simple Mail Transfer Protocol (SMTP) servers.

• The DX8100 does not support Google™ Gmail. 

This section describes how to set up emergency e-mail notification and includes the following topics:

• Accessing the Emergency E-mail Notification Setup on page 238

• Configuring Emergency E-mail Notification on page 238 

• Setting Up the Time Period on page 241

• Sending E-mail Notifications on page 248 

ACCESSING THE EMERGENCY E-MAIL NOTIFICATION SETUP
To access the emergency e-mail notification setup:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

CONFIGURING EMERGENCY E-MAIL NOTIFICATION
This section describes how to set up emergency e-mail notification and includes the following topics:

• Enabling or Disabling E-mail Notification

• Setting Up the E-mail Server 

• Testing E-mail Notification on page 240

Enabling or Disabling E-mail Notification
To enable or disable emergency e-mail notification:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. In the Emergency E-mail Notification page, do one of the following:

• Click the Enable Notification button to enable e-mail notification.
• Click the Disable Notification button to disable e-mail notification.
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Setting Up the E-mail Server
Set up the e-mail server in the Emergency E-Mail Notification page. For information about accessing the Emergency E-Mail Notification page, 
refer Accessing the Emergency E-mail Notification Setup on page 238.

To set up the e-mail server:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. Enter a name in the Full Name box. You should enter a name that reflects the DX8100 server sending the notification (for example, DX8100 
First Floor Lobby). Names can be up to 31 characters long and can include spaces. but not special characters.

5. Enter your e-mail address in the E-mail Address box.

6. Enter the address of your local SMTP mail server. Obtain this information from your network administrator.

7. If your e-mail server requires you to log in, do the following:

a. Select the check box labeled My E-mail Server Requires Authentication.

b. Enter your e-mail server address.

c. Enter your user name. (User names can be up to 31 characters in length and cannot include spaces or special characters.)

d. Enter your password. (Passwords can be up to 19 characters in length and cannot include spaces or special characters.)

8. Click Apply. 

Figure 179. Basic E-mail Notification Setup
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Testing E-mail Notification
You test the e-mail notification configuration in the Emergency E-mail Notification page. For information about accessing the Emergency E-mail 
Notification page, refer Accessing the Emergency E-mail Notification Setup on page 238.

To test e-mail notification:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. Select the My E-mail Server Requires Authentication check box (if it is not already selected).

5. Enter your personal e-mail address or the address of someone who can verify the receipt of the test e-mail in the To box.

6. Type DX8100 E-mail Notification Test in the Subject box.

7. Enter the following server settings if necessary: 

• Server address (This address should be the same as the SMTP server address you entered above.)
• User name
• Password

8. Click Test E-mail Notification.

Figure 180. E-Mail Test
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SETTING UP THE TIME PERIOD
The DX8100 can be configured to send e-mail notifications on a periodic basis, such as once every ten minutes. This sections describes how to 
set up the time period and includes the following topics:

• Configuring E-Mail Notification Frequency 

• Setting the Time of Day 

• Sending E-mail Notifications in Response to Motion Events on page 242 

• Sending E-mail Notifications in Response to Alarm Events on page 242 

• Sending E-mail Notifications in Response to Video Loss Events on page 243

Configuring E-Mail Notification Frequency
Depending on the volume of motion, alarm, or video loss events detected by the DX8100, the number of e-mail notifications can be far too many 
to manage effectively. To keep the number of e-mails sent by the DX8100 at a manageable level, the e-mail notification frequency can be 
adjusted. When events have been detected, e-mail notifications can be sent out in intervals from once per minute up to once every six hours. If 
no events have been detected during the specified frequency interval, no notification will be sent. Each e-mail notification will include 
information about the first event detected during the interval, the last event detected during the interval, and a still image (in JPEG format) of the 
last event.

To configure notification frequency:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Frequency section, select the frequency interval from the drop-down box. Options for sending an e-mail notification include once 
every

• 1 minute
• 10 minutes
• 30 minutes
• 1 hour
• 3 hours
• 6 hours

Setting the Time of Day
To set the time of day during which e-mail notifications will be sent:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Frequency section, do the following:

a. Click the Start check box to use the spinner buttons, or type the earliest time of day you want e-mail notifications to be sent (for 
example, 7:30 a.m.). 

b. Click the End check box to use the spinner buttons, or type the latest time of day you want e-mail notifications to be sent (for example, 
6:00 p.m.). 

5. Click Apply.
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Sending E-mail Notifications in Response to Motion Events
E-mail notifications can be sent whenever a camera attached to a DX8100 detects motion.

To cause e-mail notifications to be sent in response to motion events:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Motion check box.

b. In the Selected Channels field, click once to the right of the word Motion. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box for each channel you want to monitor for motion detection events.
• Click Select All to monitor all channels for motion detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.

Sending E-mail Notifications in Response to Alarm Events
E-mail notifications can be sent whenever an alarm input is activated. 

To initiate e-mail notifications to be sent in response activated alarm inputs:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Alarm check box.

b. In the Selected Channels field, click once to the right of the word Alarm. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box for each channel you want to monitor for alarm detection events.
• Click Select All to monitor all channels for alarm detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.
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Sending E-mail Notifications in Response to Video Loss Events
E-mail notifications can be sent whenever a camera attached to a DX8100 experiences a video loss event.

To cause e-mail notifications to be sent in response to video loss events:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Video Loss check box.

b. In the Selected Channels field, click once to the right of the words Video Loss. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box for each channel you want to monitor for video loss detection events.
• Click Select All to monitor all channels for video loss detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.

SETTING UP E-MAIL NOTIFICATION GROUPS
The DX8100 allows you to set up groups to send an emergency notification to multiple users. The DX8100 supports the following:

• You can create up to 32 e-mail notification groups. 

• Up to 32 members can be assigned to each e-mail group. 

• A group can be notified in response to an alarm or motion detection event.

This section describes how to set up e-mail notification groups and includes the following topics:

• Adding an E-mail Notification Group 

• Modifying an E-mail Group Name 

• Deleting an E-mail Group on page 244 

• Adding Members to an E-mail Group on page 245 

• Deleting Members from an E-mail Group on page 246

• Modifying E-mail Group Member Attributes on page 247 

Adding an E-mail Notification Group
To add an e-mail notification group:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. Click Add Group. The Manage Groups dialog box opens.

c. Enter the name of the group. (Group names can be up to 32 characters in length and can include spaces, but not special characters.)

5. Click OK.

6. Click Close.

7. Click Apply.
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Modifying an E-mail Group Name
To modify a group name:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. In the Group Name table, select a group.

c. Click Edit Group. The Manage Groups dialog box opens.

d. Edit the existing name or enter a new name for the group.

5. Click OK.

6. Click Close.

7. Click Apply.

Deleting an E-mail Group
To delete a group:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. In the Group Name table, select a group.

c. Click Delete. 

5. Click Close.

6. Click Apply.
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Adding Members to an E-mail Group
Up to 32 members can be assigned to each e-mail group. 

To add e-mail addresses to a group:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Ensure that the group check boxes under To and CC are deselected.

c. Enter an e-mail address in the To or CC boxes.

d. Click Add to Group.

5. Click Apply.

Figure 181. Add User to E-mail Group

4c4c 4d

4a4a

4b
C2630M-C (7/09) 245



Deleting Members from an E-mail Group
To delete a user from a group:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Select the user you want to delete from the list.

c. Click Delete.

5. Click Apply.

Figure 182. Remove User from E-mail Group
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Modifying E-mail Group Member Attributes
To modify a user’s e-mail address or group affiliation:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Click the e-mail address of the user you want to edit. 

c. Click Edit. The E-mail Settings dialog box opens.

d. In the Group drop-down box, select a different group for the user.

e. If necessary, enter a new e-mail address for the user in the E-mail Address box.

5. Click OK.

6. Click Apply.

Figure 183. Modify Member Attributes
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SENDING E-MAIL NOTIFICATIONS
This section describes how to send e-mail notifications and includes the following topics:

• Sending E-mail Notifications to Individuals on page 248 

• Sending E-mail Notifications to Groups on page 249 

Sending E-mail Notifications to Individuals
To configure e-mail notifications to send alerts to an individual:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the To box, enter the e-mail address of the individual to whom you would like to send e-mail notifications.

b. (Optional) In the CC box, enter a second e-mail address of a person to whom you would like to send a copy of the notification.

c. In the Subject box, enter text in the subject line as you would like it to appear in e-mail notifications. (The default subject line is 
DX8100 Emergency E-mail Notification.)

5. Click Apply.

Figure 184. Sending E-mails to Individuals
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Sending E-mail Notifications to Groups
To configure e-mail notification to send e-mail alerts to a group of individuals:

1. On the DX8100 toolbar, click the Setup button . The Setup dialog box opens to the Camera page.

2. Click the Notification button . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. Click the To check box.

b. In the drop-down box, select the group to which you want to send event notifications. 

c. (Optional) If you want to e-mail a copy of the event notification to another group of users, click the CC: check box.

d. In the drop-down box, select the group you want to copy. 

5. Click Apply.

Figure 185. Sending E-mails to Groups
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Administering and Maintaining the DX8100
This section describes how to perform DX8100 system administration and periodic maintenance, including the following topics:

• Updating the DX8100 Server and Client Applications 

• Recovering a Password on page 252

UPDATING THE DX8100 SERVER AND CLIENT APPLICATIONS
Software updates are available for both the DX8100 Series HVR server and client applications. These updates are free and are available on the 
product resource disc or online at pelco.com/software/downloads/dvr. Contact Pelco Product Support for more information. 

When an update is issued, it must be loaded onto a single DX8100 HVR server. Once installed on a server, updates are automatically distributed 
to clients on the same network when the client applications are started. Remote DX8100 servers can be updated from a local HVR using the 
DX8100 Software Upgrade utility.

To start the update process:

1. From the DX8100 menu bar, choose File > Software Upgrade.

Figure 186. Software Upgrade Server Console

2. The Select Upgrade Package dialog box opens.

3. Click Browse. The Open dialog box opens.

4. Select the update file.

5. Click Open. The Select Upgrade Package dialog box becomes active.

6. Click Next. 

The Select Server dialog box opens and displays a list of all connected DX8100s, including the local HVR. Updates to the local server and all 
connected remote servers can be initiated from this dialog box.

7. To update a local or remote HVR server:

• Local server: Select the site name of your system from the Select Server list. 
• Remote server: Select the remote server from the Select Server list, and then click Connect.

8. Click Next and wait for the DX8100 Upgrade utility to copy the necessary files to the selected HVR.

9. At the completion of the update process, a dialog box will appear prompting you to update another server (if desired). 

• Click Yes to select another server to update.
• Click No to finish the update process and reboot.

The local or remote server will reboot 30 seconds after the upgrade process has been completed. 
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UPDATING DX8100 CONFIGURATION FILE
The DX8100 HVR allows you to update the configuration file for multiple DX8100 servers and server groups simultaneously. The Multiple 
Configuration Upload command on the File menu opens a dialog box, which displays all of the DX8100 devices and groups listed in the Site Tree. 

To upload the resident DX8100 server configuration file to selected DX8100 devices:

1. In the System page, export the current HVR settings. For more information about exporting configuration settings, refer to Exporting the 
Current HVR Settings on page 219.

2. From the DX8100 menu bar, choose File > Multiple Configuration Upload. The Multiple Configuration Upload dialog box opens. The DX8100 
devices and groups listed in the Site Tree are listed in the Multiple Configuration dialog box Site List.

3. In the Site List in the Multiple Configuration Upload dialog box, click the check box for each DX8100 server and server group you want to 
update.

4. In the Multiple Configuration Upload dialog box, do the following:

a. Click Browse. The DX8100 Setup File Import dialog box opens.

b. Select the configuration file you want to use to update the DX8100 servers.

c. Click Open. The path to the configuration file is displayed in the Configuration File Path box.

d. Click Upload. The configuration file is uploaded to the selected device. If there is an issue, a message dialog box opens.

5. Click Close to exit the Multiple Configuration Upload dialog box.

Figure 187. Software Upgrade Server Console
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RECOVERING A PASSWORD
Upon request, Pelco can issue a password recovery code that is valid for 24 hours, on the machine for which it was issued only. To do so, the 
original buyer of the system (typically the dealer) must contact Pelco Technical Support. The serial number and order number (or invoice number) 
under which the unit was originally purchased, as well as the MAC address and exact date/time listed on the password recovery screen must be 
provided. This must be done in writing, by fax, and the request must be accompanied by a letter from the current owner of the system stating the 
following information under penalty of perjury:

• He/she is the legal owner of the system.

• The password for the system was lost.

• He/she is requesting a password reset.

Pelco will then issue a reset code that can be used for 24 hours, with the provided MAC address only.

(If possible) Use company letterhead to submit all information (the exact time, the mac address, and so forth) detailed on the “password 
recovery,” including the bulleted information above.

Fax to 1-888-294-3885, attention: DX8100 Password Recovery.

To recover a lost or forgotten Admin password:

1. From the DX8100 menu, choose File > Password Recovery. The Password Recovery dialog box appears.

Figure 188. Password Recovery Dialog Box

2. Contact Pelco Product Support with the following information:

a. MAC address as it appears in the Password Recovery dialog box.

b. Current date for your location as it appears in the Password Recovery dialog box.

c. Any additional information requested by Pelco Product Support.

3. Enter the new password you obtained from Pelco Product Support in the field provided.

4. Click OK.

PERFORMING PERIODIC MAINTENANCE
The DX8100 filter should be cleaned periodically, to ensure proper ventilation and cooling of the DX8100. The filter is easily accessible through 
DX8100 front panel.

To remove and cleanse the filter:

1. From the DX8100 menu bar, choose File > Exit. The Shut Down dialog box opens.

2. Select Shut down.

3. Click OK.

4. Open the DX8100 front panel.

5. Reach behind the front panel and pull out the filter assembly (5).
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6. Remove the filter (6).

Figure 189. Removing the Filter

7. Do the following:

a. Using a can of compressed air, blow air from the back side of the filter through the front.

b. Verify that the filter is clean.

c. Use a cloth to remove dust from the filter bracket.

d. Insert the filter into the filter bracket.

e. Re-install the filter assembly.

8. Close the front panel door.

9. Start the DX8100 and resume operation.
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ATM/POS event, linking multiple cameras to record 137
motion event, linking multiple cameras to record 136
video loss event, linking multiple cameras to record 138

IP camera, setting up 122, 123
lens, adjusting 51
mapping 229
motion detection zones 118
PC keyboard, using shortcuts to operate PTZ and lens functions 52
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scheduled recording mode, setting up 145
security levels 116

high
low
medium
none
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customizing 144, 154
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settings, customizing 154
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overview 139
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channel mapping 34
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Coaxitron protocol 53
COM1communications properties 179
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compression, video 156
connecting DX8100 HVRs 114

D
D protocol 53
data bits 180, 181
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designators
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site 46

digital zoom control 24
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documentation
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setting up 180
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command descriptions 25
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logging in to 18
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panes 30

DX8100, setting up 114
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overview 248
sending to groups 249
sending to individuals 248
video loss event, sending in response to 121
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e-mail server 238
emergency agent notification 121

accessing Emergency Agent Setup page 235
camera, linking to client emergency agents 237
clients

adding 236
changing emergency agent properties 236
deleting from notification list 237

Emergency Agent Client utility, required 235
overview 235
port 170
server event transmission time, setting 237

emergency e-mail notification
accessing Emergency E-mail Notification page 238
alarm 238
alarm events, sent in response to 242
e-mail groups 238
e-mail server, configuring 239
enabling/disabling 238
group

adding 243
adding members 245
deleting 244
deleting members from group 246
modifying 244
modifying member attributes 247
overview 243

local area network (LAN), 238
motion events, sent in response to 242
overview 238
setting up 238
testing configuration 240
time period

notification frequency, setting up 241
overview 241
setting the time of day 241

video loss events, sent in response to 243
event, jump to 69
events

alarm 132
ATM/POS 134
motion detection 118
recording modes 145
video loss detection 121

exception 191
Expansion Unit 28
export setup 25
Ext. monitor

camera mapping
automatic camera mapping, setting up 229
manual camera mapping, setting up 230
overview 229

Capture Card, configuring interrupt override 235
external monitor option 235
overview 228
sequence instance

appending to an existing sequence list 234
creating 230
deleting 233
loading an existing list 231

modifying in the list 232
extended monitor 34
extended view mode 51
external events 134
external storage 13, 14, 20

F
file size

video image 156
frame rate

about calculating 163
advanced, configuring 158
overview 144, 156
range of 156
resolution value 159

frame rate, setting 157
full-screen view

video, displaying 29
full-window view 29

index video, displaying 30
live video, displaying 29
playback video, displaying 30
selecting 29

G
getting started

exiting the DX8100 19
first-time login 18
powering on the DX8100 16
shutting down the DX8100 16
starting the DX8100 16
user security levels 16

H
hard disk 16
hardware

capture card 230
DX8100-AUD audio card 119
external equipment 61
upgrading 16

Help
enabling/disabling 228
online, viewing 228

I
import setup 25
index view panel 24
indicators

audio 46
camera 46
instant recording 46
on-screen PTZ control 46
pan, tilt, and zoom 46
record 46
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site 46
information port 170
instant recording indicator 46
instant recording mode 47
interface mode 180, 181
IP camera

analog camera, disabling 123, 130
assigning to a camera channel 123
camera channels, supported 123
configuring IP camera settings 126
deleting 131
disabling 130
DX8100 network, searching for IP camera 124
IP address, assigning 124
restoring a disabled camera 131
setting up 122
site, assigning to 127
user name and password, configuring 124

J
JBOD external storage 13, 14, 20

K
keypad 51

L
language

selecting 15, 16
linking

alarm input, removing from camera 40
alarm inputs, linking to cameras 39
link setup options 132

event-PTZ link settings
event-recording link settings
event-relay link settings
relay and alarm settings

relays, linking to cameras 40
removing 40
setting up 39

linking and event recording setup 132
live audio 26, 46, 119
live audio, listening to 121
Live View mode 58
local area network (LAN) 238
logical network ports 170
logs

files 26
Backup
Export
Login ID list with time
Network Connections
System Failure
System On/Off
Video Loss

M
mapping, camera 229
maximum record rate 160, 161
menu bar 24
menus

Edit 25
File 25
file 24
Help 28

menus, shortcut
local site 38
relay 38
remote site 38

mode
extended view mode

standard view 51
instant record, starting 49
instant record, starting and stopping 48
instant record, stopping 49
instant recording 47
interface 180, 181
live recording 50
Live View mode, working in 58
live view, working in 42
normal recording 47
recording modes, scheduled 144

See recording mode
monitor, extended 34
monitor, external 228
motion

detection of 134, 145
See also relays

detection zones 118
emergency e-mail notification 238
emergency notification 235
motion event recording mode, setting up 145
sensitivity, setting 118

multicast, enabling 170
multi-event recording 145
multiple event recording 145
multiplexed analog output 228
MUX card

displaying real-time video 42

N
National Television System Committee (NTSC) 156
network camera 122, 123
network drive

disconnecting from 206
network ports, logical 170
network requirements

connecting DX8100 HVRs 19
DX8100 network properties 15

normal recording mode 47
notification

e-mail 121
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emergency agent 121
Notification page 235

O
online Help 228
on-screen display

add instant record icon to OSD 48
customizing 47
overview 26, 46
selections 47

Audio Recording
Background Color
Camera Name
Instant Recording
POS
PTZ
Select All
Site Name
Video Recording

operating modes
function 29

Display
Search
Setup

instant record, starting and stopping 48
instant recording 47
live recording 50

operation and configuration
user access level 18

overriding other users 114

P
P protocol 53
pan, tilt, and zoom (PTZ) control panel 24
pan, tilt, and zoom control

enabling 46
focus command, using 53
operating 50
preset, programming 53
programming guidelines 53
protocols, camera support 50

pan, tilt, and zoom indicator 46
pane/panel

background color 26
channel/camera assignment to 32
configuring 31
division display format 32
division, selection of 31
hidden panels, automatically cycling through 33
hidden panels, manually cycling through 33
live/playback video, display of 24
navigating between 31, 32
overview 30
pane, expanding and collapsing 33
site name displayed in 26
video, viewing 115

parity 180, 181

password
recovery 25

pattern
activating 53, 55, 57
clearing 53, 57
overview 55
programming 53, 56
programming, starting 56
programming, stopping 56
protocols, PTZ-enabled cameras 55

PC client application
server connections, number of 217

Phase Alternating Line (PAL) 156
ping port 170
playback control panel 24
playback timeline 24
port and device communications properties

ATM/POS device
data format 186
mode, selecting 181

COM1 port 178
COM1, setting up 179
overview 177
RS-232 178
RS-422/RS-485 178

port numbers, changing 170
pre-alarm recording rate 145
preset

activating 53, 54
clearing 53, 55
guidelines 53
Preset 95 53
Preset 99 53
programming 53

preset tour
accessing a preset tour group 62
adding presets to a tour 62, 63
configuring 62
delete presets from a tour 62
deleting presets from a tour 64
programming 62

printing 15
protocols

D, P, Coaxitron 53
device, installing/updating 200

PTZ OSD menu control 58
PTZ presets and patterns

alarm events, linking to 140
ATM/POS events, linking to 141
motion events, linking to 139
video loss events, linking to 142

PTZ protocols
testing PTZ functionality 117

R
reboot, automatic

automatic reboot 227
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record indicator 46
record rate, maximum 160, 161
recording mode

alarm, camera settings supported
alarm image quality 156
frame rate during alarm 156
image resolution 156
post-motion 156
pre-alarm 156
pre-alarm frame rate 156
pre-alarm image quality 156

ATM/POS, camera settings supported
ATM/POS image quality 156
frame rate during ATM/POS 156
image resolution 156
post-ATM/POS 156
pre-ATM/POS 156
pre-ATM/POS frame rate 156
pre-ATM/POS image quality 156

instant 47
instant, disabling 48
instant, enabling 48
motion, camera settings supported

frame rate during motion 156
image resolution 156
motion image quality 156
post-motion 156
pre-motion 156
pre-motion frame rate 156
pre-motion image quality 156

normal 47
normal, camera settings supported

frame rate 156
image quality 156
image resolution 156

recording schedule profile 144
scheduled modes 144, 145

alarm
ATM/POS
motion
normal

recording modes 145
recording schedule 143
relays

Event-Relay Link Settings page, accessing 134
linked relay output

removing from a camera 40
removing from an alarm input 41

manually turning On and Off 38
multiple relays, linking to one camera 40
relay output

alarm event, linking to 40, 135
ATM/POS event, linking to 135
motion event, linking to 134
number supported 132
video loss event, linking to 136

setting up
advanced relay output 163
basic operating properties 133
creating custom name for 133
relay output type, selecting 133

relay, selecting 133
single relay, linking to multiple cameras 40

remote camera
menu system, navigating using

Keypad controls 58, 59
PC keyboard keys 58, 59
PTZ OSD menu control 58
PTZ OSD menu controls 58, 59

programming features, accessing 58
protocol support 58

remote site
accessing features of 19
activating 217
active remote cameras, finding 217
connecting to 19
deleting 218
DHCP IP addressed, adding 216
disconnecting from 19
editing 218
logging into 19
logging out of 20
modifying 218
overview 214
static IP addressed, adding 214

remote sites
overview 214

resolution
resolution value, setting for recording 159
screen 26

Resource Meter 129
RS-232 178
RS-422/RS-485 178, 180

S
schedule

accessing 143
all record modes, clearing schedule 147
clearing a recording schedule 146
copying attributes 148, 152
custom settings 144
deleting a schedule 153
editing a profile 152
individual days, scheduling 148
multi-day schedule, creating 149
record mode 143
setting up 145
single day, creating 150
types of 144
yearly recording schedule, creating 147

screen resolution 26
search

mode 29
sharing of time range search 78

sensitivity, motion 118
server sites

connecting to DX8100 server sites 214
server, e-mail 238
Setup dialog box 114
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setup mode
accessing 114
alarm properties, setting up 133

See also alarm inputs
camera setup 116, 154

See also camera
commands, listing of 115

Backup
Camera
Ext. Monitor
Linking
Network
Notification
Schedule
Site
System
User

data backup 201
Ext. monitor setup 228
how to open Setup dialog box 29
motion sensitivity, setting 118
multiple cameras

alarm events, linking cameras to record 137
ATM/POS events, linking cameras to record 137
motion events, linking cameras to record 136
video loss events, linking cameras to record 138

network properties
accessing DX8100 network configuration details 171
base port, setting up 170
DHCP, setting up 169
DNS or WINS services, setting up 172
overview 168
port and device communications properties 177
site name, assigning 168
TCP/IP and bandwidth throttle, setting up 170

network setup
static IP address, entering 170

overview 114
PTZ presets and patterns

alarm events, linking to 140
ATM/POS events, linking to 141
linking to external events 139
motion events, linking to 139
PTZ test 117
video loss events, linking to 142

relay output
advanced alarm-activated, configuring 165
advanced ATM/POS-activated, configuring 166
advanced motion-activated, configuring 163
advanced video loss-activated, configuring 167
alarm event (external), linking to 135
ATM/POS event (external), linking to 135
motion event (external), linking to 134
See also relays
video loss event (external), linking to 136

relay properties, setting up 133
See also relays

schedule setup
frame rate, basic, configuring 157
frame rate, configuring 156
record mode 143, 145

system setup 218

user access 208
setup pages

Backup page 201
Camera page 115
Ext. Monitor page 228
Linking page 132
Network page

default, Network page 168
DNS/WINS page 172

Schedule page 143
Site page 214
System page 218
User page 208

shortcut keys
PC keyboard 52

Home and End
Insert and Delete
Left and Right Arrow
Page Up and Page Down
Plus (+) and Minus (-)
Up and Down arrow

using to operate PTZ and lens functions 51, 52
shortcut menus

local site shortcut menu 38
relay shortcut menu 38
remote site shortcut menu 38

site designator 46
site name 168
site tree

all cameras, assigning from 39
how organized 24
local, expanding and collapsing 38
overview 37
remote, expanding and collapsing 38
single camera, assigning from 39

software
DX8100 HVR server, using 15
upgrading 15

software upgrade port 170
standard audio

inputs 119
standard view mode 51
static IP address

adding remote site with static IP address 214
assigning 169, 170
remote site 214

status bar 24
stop bits 180, 181
synchronization, loss of 121
system administration 250
system administrator

obtaining user account 18
system configuration

language 16
language, setting 15
printer, adding 15
time, setting 15

system ID 168
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system setup
accessing the System page 219
Ctrl+Alt+Del key

enabling 226
using 226

Edit menu
exporting from 220
importing from 221

export feature 219
HVR settings

exporting 219
importing 220

import feature 220
language 224

selecting 224
supported languages 224

log files
exporting 224
overview 222
viewing a log file 222

overview 218
system time

standard and daylight saving time 225
video format

selecting 226
system time 15

T
TCP/IP ports (default), 170
third-party

domes 50, 180
protocols, supported 53, 55, 58, 116

title bar 24
toolbar 24, 28
tour, preset 53, 62
transaction

format 188
parameters 188

transaction filter, predefined 84, 89, 191

U
upgrade policy

hardware 15
software 15

user security level 208
accessing user setup page 208
Administrator 16, 114, 210
dwell time, changing 33
DX8100, accessing 114
Guest user account 18
pan, tilt, and zoom control, operating 50
Power User 16, 47, 114, 210
Restricted User 26, 33, 209, 210
Standard User account 24, 26, 210
user access levels 210
user accounts

adding new users 211
existing users, deleting 213

log-in timeout, setting 213
modifying 212
password, changing 213
user’s group affiliation, changing 213

user accounts, default 209
user name and password 18

V
video

full-window view, displaying 29
images, printing 15
live, viewing 19, 22
playback, viewing 19

video compression 156
video loss

detection of 121
emergency notification 235
relay output, linking to 136
synchronization, loss of 121
video level, low 121

video, low level 121
view

cycle view setup 26
dwell time 26
extended 30
pane/panel. See pane/panel
standard 30
viewing area. See pane/panel

W
warranty period 15
wildcard character 90
wildcard, character 90
wiper, operating 61

Z
zones, motion detection 118
zoom, adjusting camera 51
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PRODUCT WARRANTY AND RETURN INFORMATION

WARRANTY
Pelco will repair or replace, without charge, any merchandise proved defective in
material or workmanship for a period of one year after the date of shipment.

Exceptions to this warranty are as noted below:
• Five years:

– Fiber optic products
– TW3000 Series unshielded twisted pair (UTP) transmission products
– CC3701H-2, CC3701H-2X, CC3751H-2, CC3651H-2X, MC3651H-2, and

MC3651H-2X camera models
• Three years:

– Pelco-branded fixed camera models (CCC1390H Series, C10DN Series,
C10CH Series, IP3701H Series, and IX Series)

– EH1500 Series enclosures
– Spectra® IV products (including Spectra IV IP)
– Camclosure® Series (IS, ICS, IP) integrated camera systems
– DX Series digital video recorders, DVR5100 Series digital video recorders,

Digital Sentry® Series hardware products, DVX Series digital video
recorders, and NVR300 Series network video recorders

– Endura® Series distributed network-based video products
– Genex® Series products (multiplexers, server, and keyboard)
– PMCL200/300/400 Series LCD monitors

• Two years:
– Standard varifocal, fixed focal, and motorized zoom lenses
– DF5/DF8 Series fixed dome products
– Legacy® Series integrated positioning systems
– Spectra III™, Spectra Mini, Spectra Mini IP, Esprit®, ExSite®, and PS20

scanners, including when used in continuous motion applications.
– Esprit Ti and TI2500 Series thermal imaging products
– Esprit and WW5700 Series window wiper (excluding wiper blades).
– CM6700/CM6800/CM9700 Series matrix
– Digital Light Processing (DLP®) displays (except lamp and color wheel). The

lamp and color wheel will be covered for a period of 90 days. The air filter is
not covered under warranty.

– Intelli-M® eIDC controllers
• One year:

– Video cassette recorders (VCRs), except video heads. Video heads will be
covered for a period of six months.

• Six months:
– All pan and tilts, scanners, or preset lenses used in continuous motion

applications (preset scan, tour, and auto scan modes).

Pelco will warrant all replacement parts and repairs for 90 days from the date of
Pelco shipment. All goods requiring warranty repair shall be sent freight prepaid
to a Pelco designated location. Repairs made necessary by reason of misuse,
alteration, normal wear, or accident are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss
resulting from the specific use or application made of the Products. Pelco’s liability
for any claim, whether based on breach of contract, negligence, infringement of
any rights of any party or product liability, relating to the Products shall not exceed
the price paid by the Dealer to Pelco for such Products. In no event will Pelco be
liable for any special, incidental, or consequential damages (including loss of use,
loss of profit, and claims of third parties) however caused, whether by the
negligence of Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may
also have additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800) 289-9100 or
(559) 292-1981 to obtain a Repair Authorization number (RA), and provide the
following information:

1. Model and serial number
2. Date of shipment, P.O. number, sales order number, or Pelco invoice number
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product that does not fall under
the warranty conditions stated above, please include a written explanation with
the product when returned.

Method of return shipment shall be the same or equal to the method by which the
item was received by Pelco.

RETURNS
To expedite parts returned for repair or credit, please call Pelco at (800) 289-9100
or (559) 292-1981 to obtain an authorization number (CA number if returned for
credit, and RA number if returned for repair) and designated return location.

All merchandise returned for credit may be subject to a 20 percent restocking and
refurbishing charge.

Goods returned for repair or credit should be clearly identified with the assigned
CA or RA number and freight should be prepaid.

The materials used in the manufacture of this document and its components are compliant to the requirements of Directive 2002/95/EC.

This equipment contains electrical or electronic components that must be recycled properly to comply with Directive 2002/96/EC of the European Union 
regarding the disposal of waste electrical and electronic equipment (WEEE). Contact your local dealer for procedures for recycling this equipment.

12-23-08

REVISION HISTORY

Manual # Date Comments
C2630M 9/06 Original version.
C2630M-A 6/07 Added new features: data retention custom setting, full screen button, multicasting, export and printing of backed up video, and MUX analog video output.
C2630M-B 4/08 Added new features: dual display, expanded ATM/POS, and system health check.
C2630M-C 7/09 Added new features: External JBOD storage and IP camera support. 

Pelco, the Pelco logo, Camclosure, Digital Sentry, Endura, Esprit, ExSite, Genex, Intelli-M, Legacy, and Spectra are registered trademarks of Pelco, Inc. © Copyright 2009, Pelco, Inc. All rights reserved.
Sarix and Spectra III are trademarks of Pelco, Inc.
DLP is a registered trademark of Texas Instruments Incorporated.
All product names and services identified throughout this document are trademarks or registered trademarks of their respective companies. 
The absence of a trademark or registered trademark from this document does not constitute a waiver of intellectual property rights.
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